Oracle Field Service Cloud
Administering Oracle Field Service Cloud
# Contents

## Preface

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Configure Oracle Field Service Cloud</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Your Company's Configuration</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Activity Types</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Configure Business Rules</td>
<td>18</td>
</tr>
<tr>
<td></td>
<td>Capacity Categories</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>Create a Group or Help Desk</td>
<td>33</td>
</tr>
<tr>
<td></td>
<td>Configure the Display Screen</td>
<td>34</td>
</tr>
<tr>
<td></td>
<td>Set Your Language</td>
<td>37</td>
</tr>
<tr>
<td></td>
<td>Create a Filter</td>
<td>38</td>
</tr>
<tr>
<td></td>
<td>Glossary Entries</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Holidays</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td>Inventory Types</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>Link Templates</td>
<td>46</td>
</tr>
<tr>
<td></td>
<td>Login Policies</td>
<td>47</td>
</tr>
<tr>
<td></td>
<td>Organizations</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>Message Scenarios</td>
<td>53</td>
</tr>
<tr>
<td></td>
<td>Add a Non-Working Reason</td>
<td>61</td>
</tr>
<tr>
<td></td>
<td>Properties</td>
<td>61</td>
</tr>
<tr>
<td></td>
<td>Resource Types</td>
<td>68</td>
</tr>
<tr>
<td></td>
<td>Shifts</td>
<td>74</td>
</tr>
<tr>
<td></td>
<td>View Statistical Parameters</td>
<td>76</td>
</tr>
<tr>
<td></td>
<td>Update Travel Statistics</td>
<td>78</td>
</tr>
<tr>
<td></td>
<td>Themes</td>
<td>78</td>
</tr>
<tr>
<td></td>
<td>Add a Travel Area</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>Custom Forms</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>Integrate with Other Applications</td>
<td>86</td>
</tr>
<tr>
<td></td>
<td>Activity Booking</td>
<td>91</td>
</tr>
<tr>
<td></td>
<td>User Types</td>
<td>94</td>
</tr>
</tbody>
</table>

---
# Integrate with Oracle Knowledge Cloud

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About the Integration</td>
<td>139</td>
</tr>
<tr>
<td>Configure Access Settings</td>
<td>139</td>
</tr>
<tr>
<td>Access Oracle Knowledge Service Cloud in Mobility Cloud Service</td>
<td>141</td>
</tr>
<tr>
<td>Access Oracle Knowledge Service Cloud in Core Manage Cloud Service</td>
<td>142</td>
</tr>
<tr>
<td>Enable Access</td>
<td>143</td>
</tr>
</tbody>
</table>

# Integration Channels

<table>
<thead>
<tr>
<th>Channel</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily Extract</td>
<td>145</td>
</tr>
<tr>
<td>Configure a DBaaS Integration</td>
<td>148</td>
</tr>
</tbody>
</table>

# Administer Oracle Field Service Cloud

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Administrator Role</td>
<td>153</td>
</tr>
<tr>
<td>Managing Users</td>
<td>153</td>
</tr>
<tr>
<td>The Resource Tree</td>
<td>157</td>
</tr>
<tr>
<td>Add an Organization Unit or a Bucket</td>
<td>157</td>
</tr>
<tr>
<td>Designate Buckets for Capacity or Quota Management</td>
<td>159</td>
</tr>
<tr>
<td>Add Capacity Categories and Time Slots</td>
<td>159</td>
</tr>
<tr>
<td>Add a Resource</td>
<td>160</td>
</tr>
<tr>
<td>Rules for Removing Inactive Resources</td>
<td>161</td>
</tr>
<tr>
<td>Associate a Resource with a User Account</td>
<td>162</td>
</tr>
<tr>
<td>Configure Activity and Resource Hints</td>
<td>163</td>
</tr>
<tr>
<td>Configure Time and List Views</td>
<td>164</td>
</tr>
</tbody>
</table>

# Resources

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Entities</td>
<td>165</td>
</tr>
<tr>
<td>Time Zones</td>
<td>165</td>
</tr>
<tr>
<td>Change a Resource’s Organization</td>
<td>170</td>
</tr>
<tr>
<td>Calendars, Work Schedules, and Shifts</td>
<td>170</td>
</tr>
<tr>
<td>Add a Work Schedule or a Shift</td>
<td>171</td>
</tr>
<tr>
<td>Add a Shift to a Resource’s Calendar</td>
<td>171</td>
</tr>
<tr>
<td>Add Working Time to a Calendar</td>
<td>172</td>
</tr>
<tr>
<td>Add Non-Working Time to a Calendar</td>
<td>173</td>
</tr>
<tr>
<td>Delete Items from a Calendar</td>
<td>174</td>
</tr>
<tr>
<td>Use Filters in Daily View</td>
<td>174</td>
</tr>
<tr>
<td>Travel Time Prediction</td>
<td>175</td>
</tr>
</tbody>
</table>
Add the Find Nearby Inventory Action to Part Details Screen 178
Add a Plug-in to the Parts Details Screen 178
Resource Work Skills 179
Resource Work Zones 180

6 Internal Activities 183
View Internal Activity Types 183
Add a Mass Activity 183
Add Repeating Activities to a Resource's Route 183
Activity Alerts 184

7 Reports 185
View Scheduled Reports 185
Create a Scheduled Report 186
View the Messages Report 186
Preface

This preface introduces information sources that can help you use the application and this guide.

Using Oracle Applications

To find guides for Oracle Applications, go to the Oracle Help Center.

Documentation Accessibility

For information about Oracle’s commitment to accessibility, visit the Oracle Accessibility Program website. Videos included in this guide are provided as a media alternative for text-based topics also available in this guide.

Contacting Oracle

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions

Please give us feedback about Oracle Applications Help and guides. Please take one of the following surveys:

- For web-based user guide, Web-based User Guide Survey
- For tutorial feedback, Tutorial Survey
1 Configure Oracle Field Service Cloud

Your Company’s Configuration

Each company choosing Oracle Field Service Cloud can configure it according to its specific requirements, such as what type of work is performed, what kind of skills are available for assignment, how the working calendars are organized, and so on. All such settings are gathered in the new **Company Configuration** screen designed in a transparent and logical manner.

Previously, the settings defining the company business flow were made on different screens which could be located in various places depending on the particular system configuration. By default, most configuration settings could be found under the **Company Settings** main menu item. However, during the system configuration some of them could be turned into individual menu items or grouped under different menu items. As of version 16.2, all company settings have been gathered on a single menu, **Configuration**, which is a starting point for all configuration processes. They are grouped according to their purpose and can only be found on the **Configuration** screen. The **Configuration** menu contains the configuration settings and parameters, which can be configured to meet your company’s business requirements.

>Note: The options displayed on the menu depend on your user type configuration. The settings are listed in alphabetical order, but may appear in a different order in the menu based on your configuration.

The configuration elements are grouped as follows on the **Configuration** screen:

- **General** (the settings related to the general principles of the company operation):
  - About
  - Business Rules
  - Link Templates
  - Work Schedules
  - Work Zones
  - Work skills

- **Resources, Activities, Inventories** (the settings related to the resources the company employs, the activities it performs and the inventory used in the course of their performance):
  - Properties
  - Capacity Categories
  - Time Slots
  - Resource Types
  - Activity Types
  - Inventory Types

- **Displays** (the settings related to the general appearance of the application, screen layouts, languages and translations):
  - Glossary
  - Display
• Themes
• Filters
• Forms & Plugins

• Users, Security, Integrations (the settings related to user management and system access):
  o Organizations
  o Login Policies
  o User Types
  o Applications
  o Oracle Knowledge
  o Integration Cloud Service

• Subsystems (the settings related to Oracle Field Service Cloud modules):
  o Statistics
  o Outbound Integration
  o Collaboration
  o Message Scenarios
  o Holidays
  o Surveys

Items are added only to the groups listed above. Each item, when clicked, leads to the corresponding configuration screen.

Configuration Screen Access and Visibility Settings

Access to the Configuration screen can be allowed or denied per user type, which means that all users of that type will either have the Configuration item in their menu or not. The visibilities that set the user access to this screen are hidden, read-write, and read-only.

The items on the Configuration screen and their visibilities are configured in a dedicated context layout, Configuration. Similar to other context layouts, the Configuration screen is configured per user type, which means that all users of the selected type will see the same items on the screen with the same level of visibility. The Company Configuration context layout can include only the company configuration items. Therefore, the Add action window contains only the list of items related to company configuration. The reverse is also true—the company configuration items are not included in the action list of any other context layout.

How Plug-ins are Configured

This topic describes the high-level steps to configure and use a plug-in in Oracle Field Service Cloud.

1. Determine whether you want to host the plug-in in Oracle Field Service Cloud. If yes, prepare your plug-in for upload.
2. Configure the plug-in.
   a. Upload the hosted plug-in.
   b. Add the available properties.
3. Add the plug-in to the required screen.
Configure a Plug-in

To use a plug-in in Oracle Field Service Cloud, you must configure it first.

1. Click **Configuration > Forms & Plugins**.
   - The **Forms & Plugins** screen appears and displays the existing forms and plug-ins.
2. Click **Add Plugin**.
   - The **Add Plugin** screen appears.
3. Complete the following fields:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Information section</td>
<td>A mandatory field defining the plug-in name in the English language. The action or plug-in appears under this name in the actual context.</td>
</tr>
<tr>
<td>Name (English)</td>
<td>A mandatory field defining the plug-in name in the English language. The action or plug-in appears under this name in the actual context.</td>
</tr>
<tr>
<td>Name (other languages)</td>
<td>Plug-in name translations to other languages, if used.</td>
</tr>
<tr>
<td>Label</td>
<td>A mandatory field defining a unique action or plug-in label.</td>
</tr>
<tr>
<td>Entity</td>
<td>Entity (activity, inventory, required inventory, resource, service request, user) to which the action or plug-in is to be related. For example, if you select Inventory, the action will appear only in the contexts related to inventory. Leave the field blank for the action to be available in all contexts of all the entities.</td>
</tr>
<tr>
<td>Visibility rules similar to</td>
<td>The base action from which the plug-in is to be derived, if needed. When a base action is selected, the resulting plug-in functions per the same rules as the base action. It appears only in the contexts in which the base action appears and is shown or hidden according to the same visibility conditions. For example, if start_activity is selected as the base action for a plug-in, the plug-in is only be shown in the context of a pending activity when there is no started activity in the same route, similar to the Start action. The list of available base actions is filtered according to the Entity that is selected.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of plug-in you want to use. Here are the options:</td>
</tr>
<tr>
<td></td>
<td>◦ Native application: This means, the plug-in opens another application on the same device.</td>
</tr>
<tr>
<td></td>
<td>◦ HTML5 application: This means, the plug-in uses an external application to extend the functionality. An HTML5 application plug-in can be used in one of the following Mobility contexts - Activity List, Edit., View Activity, Inventory Grid or Add/Details Inventory.</td>
</tr>
<tr>
<td>Fields for the HTML 5 Application Option</td>
<td>Determines whether the plug-in works through a third-party Plug-in API or as a regular external plug-in.</td>
</tr>
<tr>
<td>Use Plug-in API</td>
<td>The path to a URL (for external plug-ins). This URL executes the HTML5 application and it executes the plug-in in the entire browser window. The URL must start with the protocol (https). This field is hidden, if Hosted plugin is selected.</td>
</tr>
<tr>
<td>URL</td>
<td>The data that you want to be sent by the external plug-in. This field is hidden, if Use plugin API is selected.</td>
</tr>
<tr>
<td>POST Data</td>
<td>Determines whether you want to disable the plug-in when Oracle Field Service Cloud is offline. Clear this check box for the plug-in to work in offline mode with cloudfieldservmobility. This field is hidden, if Hosted plugin is selected.</td>
</tr>
<tr>
<td>Main menu items</td>
<td>Determines whether the plug-in can be set as a Main Menu item through the Main menu context layout. This field is hidden, if Use plugin API is selected.</td>
</tr>
<tr>
<td>Tab or iframe layout</td>
<td>Determines whether the plug-in uses the iframe layout. This field is hidden, if Use plugin API is selected.</td>
</tr>
</tbody>
</table>
Configure Oracle Field Service Cloud

Field Name | Description
--- | ---
Show scrollbars | Determines whether the window in which the plug-in runs has scroll bars. This field is hidden, if Use plugin API is selected.

Width in pixels/Height in pixels | The width and height of the plug-in window in pixels. This field is hidden, if Use plugin API is selected.

The following fields are displayed when you select the Use Plug-in API check box.

Hosted plugin | Determines whether you want to use a hosted plug-in. The fields that are displayed when you select this check box are displayed in the Host a Plug-in topic.

URL | The path to a URL (for external plug-ins). This URL executes the HTML5 application and it executes the plug-in in the entire browser window. The URL must start with the protocol (https).

Disable plug-in in offline | Determines whether you want to disable the plug-in when Oracle Field Service Cloud is offline. Clear this check box for the plug-in to work in offline mode with Mobility Cloud Service.

Authentication | The type of authentication used by the external server hosting the plug-in source to verify access to the plug-in. This field is hidden when Native application is selected as the plug-in type. The following choices are available:
- Basic HTTP: The Basic Access Authentication method working over HTTP or HTTPS. The Basic HTTP authentication method requires a valid login and password. When the entered login and password are verified by the server, the server returns the plug-in content.
- HMAC: Hash-based message authentication code verifying that the data is received from an authorized source. HMAC authentication method requires a secret key configured for each plug-in. This field is hidden, if Hosted plugin is selected.

Login/Password | The user name and password to log in to the plug-in. These fields are displayed only when Basic HTTP is selected for Authentication.

Secret key | Displayed when HMAC authentication is selected. All parameters of the plug-in URL with replaced placeholders will be encrypted on the basis of the SHA-256 hash of the Secret Key value using the HMAC algorithm. The resulting string will be appended to the URL as the HMAC parameter.

Secure parameters | The section where secure information such as user name and password used to access external sites is entered. This section is available only when Use Plugin API is selected. The data entered here is encrypted and stored. Use the plus icon to add a new key-value pair. You can add a maximum of 20 key-value textbox pairs, after which the icon is hidden. The maximum size of the parameters allowed is 5 KB. This size includes the data structure overhead and doesn’t correspond to the length of keys and values of strings. Changes to the secure data are sent to cloudfieldservmobility during the next synchronization. The data is sent to the plug-in when the next message is sent.

Fields for the Native Application Option

Native application name | The name of the application to be launched by the plug-in.

Browser user agents mask | The browser in which the application is to be launched. The Native application link will be available in GUI, if the browser user agent matches the specified mask. For example, Safari, Android, iPad, iPhone.

URL template | The template for building the external application URL from properties. The URL template contains parameters key and placeholders for parameters value. Properties are interpolated with placeholders, surrounded with braces "{}" and "". For example: http://www.example.com/android? type=LOCATION'&'action=View'&'all=\{acoodr_x\}'&'long=\{acoodr_x\}'&'address=\{caddress[url]\}'&'city=\{ccity[url]\}'&'state=\{cstate\}'&'zip=\{czip\}"

The following screen shot shows the Add plugin screen:
4. To add the details for another native application, click Add.
5. To reorder the applications, click the stack icon and move the application up or down.
6. To add the properties that are available to the plug-in through the plug-in API, click the pencil icon in the Available properties section.
   The Select properties screen appears.
7. Select the check boxes for all the properties that you want to be passed in the plug-in. Click OK.
   The properties are saved. Unlike earlier, now you don’t have to define the visibility for the properties explicitly.
8. Click Save on the Add plugin screen.

How Plug-Ins are Hosted

If your plug-in consists only of HTML, CSS, and JavaScript files and doesn’t contain server-side files, then you can upload it in Oracle Field Service Cloud. No additional hosting is required. The plug-in framework handles the communication between the hosted plug-in and Oracle Field Service Cloud. You can host a maximum of 10 plug-ins per instance.

The steps to host a plug-in are:

- Prepare the plug-in for upload.
- Upload the plug-in.

After hosting a plug-in, you can:

- Use it on a screen
- Move between instances
- Modify
- Rollback to a previous version
Prerequisites to Upload a Plug-In

The plug-in must be in a specific format to be uploaded. If not, you cannot upload it, you must host it elsewhere.

The plug-in files must meet the following requirements:

- You must upload a ZIP archive of the plug-in files.
- You can upload only the files of following types:
  - .html
  - .css
  - .js
  - .jpg
  - .jpeg
  - .png
  - .gif
  - .svg
  - .appcache
- You can organize files in sub-directories, but you must have the "index.html" file in the root folder.
- Each file can be a maximum of 1 MB and the total size of the compressed archive must be less than 500 KB.
- You can have a maximum of 10 files or directories in the archive.

**Note:** The plug-in files uploaded in Oracle Field Service Cloud are available by unique URLs on the Internet. The URLs are generated automatically and contain a long string. There is no authentication to access these files, so anyone who has the direct link to the file can download the file. Therefore, do not store any sensitive information such as passwords or login names in the plug-in archive. If you do not want your code to be available without authentication, we recommend that you do not use the hosted plug-in functionality. Be aware that the communication between the plug-in and Oracle Field Service Cloud starts only when a user successfully logs in to Oracle Field Service Cloud.

Work Offline

You can create the plug-in to work offline using the Application Cache functionality, which is specified in HTML5 specification (section "5.7 Offline Web Applications").

You can include the manifest file in the archive and associate your index.html file with it. For example, if the name of the manifest file is "manifest.appcache" then include the following code in the html file:

```html
<html manifest="manifest.appcache">
```

Do not add this line if your plug-in is intended to work only online. Each version of the uploaded plug-in is hosted in a separate directory. If you use the application cache functionality, the browser considers each new version of the plug-in as a separate offline application. Further, by default the browser doesn’t clean up the application cache of the previous versions of the plug-in. So, do not create too many versions of the plug-ins on the production instance.
Tip: If you experience an overflow of the application cache in the browser, clean up the offline cache of the browser.

Upload a Plug-In

You must upload the plug-in archive to use it as a hosted plug-in.

1. Click **Configuration > Forms & Plugins**.
2. Locate the plug-in for which you want to upload the archive. Click the stack icon and then click **Modify**. The Modify plugin screen appears.
3. In the **Plugin settings** section, ensure that the **Hosted plugin** check box is selected.
4. Click **Browse** and select the ZIP archive that is ready for upload.

The archive is uploaded only if the following conditions are met:
- The archive is a ZIP archive and has the extension .zip.
- The size of the archive is less than 500 KB.
- The archive includes only directories and files of the following types:
  - .html files
  - .css files
  - .js files
  - .appcache files
  - .jpg, .jpeg, .png, .gif, .svg files
  - Directories
- Files are less than 1 MB.
- The "index.html" file is located in the root of the archive.
- The archive includes a maximum of 10 entries, including empty directories.

If any of these conditions is not met, an error message is displayed and the archive is not uploaded.
5. Click **Save**. The plug-in details are saved and the Version history section is populated with:
   - The user name of the user that uploaded the files.
   - The date on which the archive is uploaded.
   - A link to download the archive.

To be able to use the plug-in, you must add it to a button or a link. See the Add the Plug-in to a Screen topic.

Modify, Download, or Delete an Archive

After uploading a plug-in archive, you might want to modify it, download it, or delete it.

1. To modify a hosted plug-in, you upload a newer version. To upload a newer version of the archive, click **Browse** on the Modify plugin screen and upload it again.

You can have only two versions of the plug-in at any time. Whenever you upload a newer version of a plug-in, the following happens:
- The current version becomes a historical one.
- The newly uploaded version becomes the current one.
- The newly uploaded version is displayed in the first row of the Version history table.
- The previous version is moved to the second row of the Version history table.
2. To download a plug-in, click Download in the Version history section. Save it to the desired location.

3. To rollback to a previous version, download the version that you want to rollback to. Click Browse and upload it again.

4. To delete a plug-in, first unassign it from all the action links it is added to. Then, click Delete on the Forms & Plugins screen.
   The plug-in is deleted with all its historical versions.

5. To move all the uploaded plug-ins between instances, export from the required instance using the Export function on the Forms & Plugins screen. Import the exported files using the Import function in the target instance.

6. To move a single plug-in between instances, download it from the required instance. Upload it in the target instance.

Add the Plug-in to a Screen
You add a plug-in to a context layout screen, so that Field Resources can open it.

1. Click Configuration > User Types.
2. Select the type of user for which you want to add the plug-in.
3. Click Screen configuration.
4. Find and click the screen to which you want to add the plug-in.
   The Visual Form Editor screen appears. Plug-ins are available not only on the Visual Form Editor, but on old context layout screens such as Parts Details as well. On such screens, add an action and select a plug-in from the list.
5. Drag-and-drop the Button element to the section from where you want to invoke the plug-in.
6. Click the button.
7. In the Standard action screen field, click the pencil icon.
8. Select Plug-ins.
9. In the Screens list, select the name of the plug-in that you want to open and click OK.
   The label of the plug-in is displayed in the Plug-in field. By default all plug-ins have a visibility of Read-only.
10. In the Visibility section, add the conditions based on which the plug-in is visible.
11. In the Translations section, add a name for the plug-in.
   This name is displayed on the screen from which the plug-in will be invoked. The following screen shot shows the Visual Form Editor screen where a plug-in is added to the Button element:

12. Click Save on the Visual Form Editor screen.
   The plug-in is added to the selected screen.
The Navigate Action

The **Navigate** action is a pre-configured link used to open a native navigation app on mobile devices. The **Navigate** link appears only when the user is online or offline and when activities have resolved coordinates.

The following links are pre-configured:

- Android devices (browser user agent mask = "*Android*") open a navigation application by geo: protocol for Android browsers.
- iOS devices (browser user agent mask = "*(?:iPad|iPod|iPhone)*") open Apple Maps.
- All other devices (Browser user agent mask = ") open maps.google.com.

Modify the Navigate Action

You can modify the **Navigate** action, but note that changing this configuration could impact the users in the field. We recommend that you test the application properly before changing.

1. Click **Configuration > Action Management**.
2. In the **View** drop-down list, search for **Navigate**.
   The **Navigate** action appears.
3. Select the check box and click **Modify**.
   The **Edit action link** window appears.
4. Click the **Plugin details** tab.
5. Click **Add**. Enter the **Native application name**, **Browser user agents mask** and URL.
6. Click **OK**.
   The new **Navigate** action is saved.

Activity Types

An activity is any time-consuming task done by a resource (for example, installation, trouble call, lunch, team meeting, and so on). Each activity type includes a set of features, which are yes/no flags and define the way the activity type is processed. For example, whether activities of a specific type can be moved, created in bucket, rescheduled, and so on. Access to the **Activity Types** window is controlled by the **Activity Types visibility**. You must set this permission for each user type that you want to manage Activity Types. If the action is not configured for the user type or if no visibility is defined, **Activity Types** are not visible to the user. If you select **ReadOnly**, **Activity Types** is placed into a view only mode. If you select **Read/Write** for this setting, the user can manage Activity Types.

The following table provides a detailed description of the features that may influence the processing of **activity** from the back office applications through Oracle Field Service Cloud:

<table>
<thead>
<tr>
<th>Feature</th>
<th>If enabled, the activities of the type...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow to create from Incoming Interface</td>
<td>… can be created from external systems, including Oracle Field Service Cloud ETAWorkforce</td>
</tr>
<tr>
<td>Allow move between resources</td>
<td>… can be moved between resources</td>
</tr>
<tr>
<td>Allow creation in bucket</td>
<td>… can be created in bucket through routing plans and profiles</td>
</tr>
</tbody>
</table>
## Find Activity Types

Every activity has a type. The activity type defines specific parameters of the activity, such as which time slot the activity takes place.

1. Click **Configuration**.
2. In the **Resources, Activities, and Inventories** section, click **Activity types**.

   The **Activity types** screen appears and displays the following columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>System-generated number assigned to records in the database – not used by anyone except the Support team.</td>
</tr>
<tr>
<td>Activity Type Name</td>
<td>The user-friendly name the end user sees in the drop-down list of choices on the Activity screen.</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates if the activity type is being used.</td>
</tr>
<tr>
<td></td>
<td>- Green check mark = Active and in use</td>
</tr>
<tr>
<td></td>
<td>- Red X = Inactive and not used</td>
</tr>
<tr>
<td>Activity Type Label</td>
<td>A unique identifier for the activity type.</td>
</tr>
<tr>
<td>Actions</td>
<td>Links to the actions you can take on this activity.</td>
</tr>
</tbody>
</table>

3. Click **View**.
4. Type the activity type that you want to find in the **Find** field.
5. Click **Apply**.

   The results appear in the work area with the search criteria in bold.

## Activity Type Fields and Features

This topic describes the fields available on the Add Activity Type screen.

You can view the details of an activity type by clicking **Modify** in the **Actions** column of the **Activity Types** screen.
Note: Some features are available only during the initial configuration. This will vary based on the options selected during the configuration. Features that are not available for editing after the initial configuration will be greyed out.

The Add Activity Type screen displays the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Activity type info section</strong></td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td>Unique identifier.</td>
</tr>
<tr>
<td>Name</td>
<td>User-friendly name that appears in the interface. Enter the name in English and in all the languages that are active in the application.</td>
</tr>
<tr>
<td>Active</td>
<td>Defines if the activity is active.</td>
</tr>
<tr>
<td>Group</td>
<td>The activity type group this activity type belongs to, for example, Customer, Internal, Teamwork, or Task.</td>
</tr>
<tr>
<td>Default duration</td>
<td>The time taken to complete the activity. This is the default value and it will be used when no statistics are available for the activity.</td>
</tr>
</tbody>
</table>

**Color Scheme Section** - Color scheme allows defining colors for each of activity statuses and for warning with standard RGB color codes and palettes. Some of the colors are not available in the Mobility Supervisor Time View (Manage).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy from</td>
<td>The color palette to be copied from an existing Activity Type. The color scheme of the selected activity type is duplicated.</td>
</tr>
<tr>
<td>Pending through Cancelled</td>
<td>The color to show on the Time, List or Map views.</td>
</tr>
</tbody>
</table>

**Available Time Slots Section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Time Slots</td>
<td>The times slots for this activity type. Time slots are setup in Configuration &gt; Time Slots. Select the check box to activate the time slot.</td>
</tr>
</tbody>
</table>

**Features Section** - The features are yes/no flags, which define individual characteristics of the type processing. If the check box is selected then the feature is enabled.

<table>
<thead>
<tr>
<th>Teamwork</th>
<th>When selected, the Activity type is allowed for teamwork. This option can only be selected while creating the Activity Type. When the Teamwork activity feature is enabled, the following activity type features are disabled:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Multi-day activity</td>
</tr>
<tr>
<td></td>
<td>• Allow move between resources</td>
</tr>
<tr>
<td></td>
<td>• Allow creation in buckets</td>
</tr>
<tr>
<td></td>
<td>• Allow reschedule</td>
</tr>
<tr>
<td></td>
<td>• Allow non-scheduled</td>
</tr>
<tr>
<td></td>
<td>• Enable ‘day before’ trigger</td>
</tr>
<tr>
<td></td>
<td>• Enable ‘reminder’ and ‘change’ triggers</td>
</tr>
<tr>
<td></td>
<td>• Support of work zones</td>
</tr>
<tr>
<td></td>
<td>• Support of work skills</td>
</tr>
<tr>
<td></td>
<td>• Support of inventory</td>
</tr>
<tr>
<td></td>
<td>• Support of preferred resources</td>
</tr>
<tr>
<td></td>
<td>• Allow mass activities</td>
</tr>
</tbody>
</table>
### Multi-Day
When selected, the Activity type is allowed for multi-day. This option can only be selected while creating the Activity Type. When you select Multi-Day, a new section, **Multi-day activity**, appears in the Add activity type window where the multi-day activity duration settings can be made. The following fields are displayed in the **Multi-day activity** section:

- Minimal duration of a single segment: Defines the minimum length (in minutes) of each of the smaller tasks into which a multi-day activity is to be split.
- Maximal total duration of segments created for a particular day: Defines the maximum total duration (in minutes) of multi-day activity segments for any day.

When the Multi-day activity feature is enabled, the following activity type features are disabled:

- Teamwork
- Allow mass activities
- Allow repeating activities
- Enable ‘day before’ trigger
- Enable ‘reminder’ and ‘change’ triggers
- Enable ‘not started’ trigger
- Enable ‘SW warning’ trigger

### Allow move between resources
When selected, the activity type can be moved from one resource to another. This option cannot be enabled if **Teamwork** is selected.

### Allow creation in buckets
When selected the Activity type can be created in a bucket.

- This option cannot be enabled when **Teamwork** is selected.
- This option can only be enabled if **Allow move between resources** is selected.

### Allow reschedule
When selected allows the reschedule of an activity to another date.

### Support of not-ordered activities
When selected the activity type can be a not-ordered activity. Not-ordered activities are the ones for which the order of execution is not defined. Such activities do not have an estimated time of arrival. The resource, dispatcher or routing may define the order (for example, command change order in mobile interface or edit activity command in web interface).

### Allow non-scheduled activities
When selected this activity type can be a non-scheduled activity. This option cannot be enabled if **Teamwork** is selected.

Non-scheduled activities are the ones that do not have a specific day of completion assigned to them.

### Support of work zones
When selected, this defines if a resource work zone must be calculated. This option cannot be enabled if **Teamwork** is selected. If this option is selected and a work zone cannot be calculated, a warning is displayed when such an activity is moved; routing will not assign such activities. If using work zones, Business rules must be configured to allow support of work zones (Configuration > Business Rules > GUI features > Enable work zones support).

### Support of work skills
If selected, work skills will be calculated and assigned to the activity based on any conditions met. Subsequently, only resources with matching work skills will be considered for assignment of the activity. If cleared, work skills are not considered and the activity can be assigned to any available resource.

- This option cannot be enabled if **Teamwork** is selected.
- This option does not depend on the **Allow move between resources** feature (as work skills are used not only to move activities but to calculate capacity).

If using work skills, Business rules must be configured to allow support of work skills (Configuration > Business Rules > GUI features > Enable work skills support).
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support of time slots</td>
<td>When selected defines if time slots are required for activities of this type. This refers to pre-configured time slots within which the activity can be performed.</td>
</tr>
<tr>
<td>Support of inventory</td>
<td>When selected, this defines if inventory can be used for activities of this type (e.g., lunch breaks and meetings should not have inventory). This option cannot be enabled if Teamwork is selected.</td>
</tr>
<tr>
<td>Support of links</td>
<td>When selected, allows for the linking of predecessor/successor activity relationships.</td>
</tr>
<tr>
<td>Support of preferred resources</td>
<td>When selected, allows for resource preferences (Preferred Resource tab) to be defined for activities of this type. This option cannot be enabled if Teamwork is selected.</td>
</tr>
<tr>
<td>Allow mass activities</td>
<td>When selected defines if activities of this type can be Mass activities.</td>
</tr>
<tr>
<td></td>
<td>• This option cannot be enabled if Teamwork is selected.</td>
</tr>
<tr>
<td></td>
<td>• This option cannot be enabled if Allow move between resources is selected.</td>
</tr>
<tr>
<td></td>
<td>• This option cannot be enabled if Support of not-scheduled activities is selected.</td>
</tr>
<tr>
<td>Allow repeating activities</td>
<td>When selected defines if activities of this type can be recurrent.</td>
</tr>
<tr>
<td></td>
<td>• This option cannot be enabled if Allow move between resources is selected.</td>
</tr>
<tr>
<td></td>
<td>• This option cannot be enabled if Support of not-scheduled activities is selected.</td>
</tr>
<tr>
<td>Calculate travel</td>
<td>When selected, defines if the travel time to an activity must be calculated. If an activity has Calculate travel enabled and has neither travel key (i.e., zip code) nor coordinates, a company default value will be used as a value of travel to and from the activity.</td>
</tr>
<tr>
<td></td>
<td>• If the feature is enabled the algorithm implemented for activities is used for all activities of the type.</td>
</tr>
<tr>
<td></td>
<td>• If the feature is not enabled (not selected) the travel time to activities of the type will always be calculated as zero (0) (as if location of activities of the type is the same as location of previous activity) and travel to the next stop also starts from this previous location.</td>
</tr>
<tr>
<td>Calculate activity duration using statistics</td>
<td>When selected, specifies that the activities are estimated using the statistics that are gathered at the resource level and company level.</td>
</tr>
<tr>
<td>Allow to search</td>
<td>When selected, specifies that the Oracle Field Service Cloud Search Engine indexes activities of this type.</td>
</tr>
<tr>
<td>Allow to create from Incoming interface</td>
<td>When selected, specifies that activities of this type can be created from Inbound Interface. Activities may originate from either Oracle Field Service Cloud or external systems.</td>
</tr>
<tr>
<td>Enable ‘day before’ trigger</td>
<td>When selected defines if day before trigger is invoked for activities of this type. This option cannot be enabled if either Teamwork or Multi-day Activity is selected. This option can only be selected while creating the Activity Type.</td>
</tr>
<tr>
<td>Enable ‘reminder’ and ‘change’ triggers</td>
<td>When selected defines if ‘reminder’ and ‘change’ triggers are invoked for activities of this type. This option cannot be enabled if either Teamwork or Multi-day Activity is selected. This option can only be selected while creating the Activity Type.</td>
</tr>
<tr>
<td>Enable ‘not started’ trigger</td>
<td>When selected defines if ‘not started’ trigger is invoked for activities of this type. This option cannot be enabled if either Teamwork or Multi-day Activity is selected. This option can only be selected while creating the Activity Type.</td>
</tr>
<tr>
<td>Enable ‘SW warning’ trigger</td>
<td>When selected defines if ‘SW warning’ trigger (Service Window warning) is invoked for activities of this type. This option cannot be enabled if either Teamwork or Multi-day Activity is selected. This option can only be selected while creating the Activity Type.</td>
</tr>
<tr>
<td>Calculate delivery window</td>
<td>Defines if a delivery window can be calculated for activities of this type.</td>
</tr>
<tr>
<td>SLA and Service window use customer time zone (required for routing)</td>
<td>When selected, supports SLA/Service Window adjustment changes. This feature must be used if the Support of time slots feature is enabled.</td>
</tr>
<tr>
<td>Support of required inventory</td>
<td>When selected, this defines if required inventory is supported for activities of this type.</td>
</tr>
</tbody>
</table>
Configure Oracle Field Service Cloud

Field | Description
--- | ---
Disable resource tracking for this activity type | When selected, the resource’s geolocation will not be tracked, if the activity is status ‘Started’. The message, ‘Your location is not tracked for this activity.’ appears on the Landing page. Location tracking resumes after the activity status changes (that is, the status changes to ‘Completed/End’, ‘Suspend’, or ‘Not Done’) and, the route is still active. This functionality is supported in the Oracle Field Service Cloud Core Application (browser) and installed applications (Android and iOS) and requires Oracle Field Service Smart Location Cloud Service, Oracle Field Service Professional Cloud Service or Oracle Field Service Enterprise Cloud Service. This message is not displayed if you have not selected Enable GPS Telemetry under the Configuration > User Types > Permissions section.

Related Topics
• How Activity Duration Is Calculated

Activate, Deactivate, or Delete Activity Types
You can activate, deactivate, or delete activity types.

1. Select the check box next to an activity type.
   Action links appear at the top of the screen.
2. Click the appropriate link, based on the action you want to perform.

✏️ Note: Deactivate does not delete the activity type; it just makes it inactive.

How Activity Duration Is Calculated
Activity duration can be either defined manually or calculated using statistics that are obtained from learned durations.

✏️ Note: You can specify durations for specific activities and technicians through APIs. For more information, see the REST API for Oracle Field Service Cloud guide.

The manually-defined and statistical methods work as follows:

• Manually-defined: If the Calculate activity duration using statistics check box is not selected in the Add activity type or Modify activity type screen, the duration specified at the time of creating the activity is used. If the duration is not specified in the activity, the default duration for that activity type is used.

• Statistical: If the Calculate activity duration using statistics check box is selected in the Add activity type or Modify activity type screen, the duration of the activity is calculated based on statistical methods. If the history is not enough to calculate using statistics, the duration entered manually (if entered) at the time of creating the activity is used. If neither history nor a manually entered value is present, then the default duration for that activity type is used. The default duration is specified at the time of creating the activity type.

Calculation of activity duration using statistics
Activity duration estimations are calculated by the application based on the historical data of completed activities. The application analyses new data, compares it against previous estimations, and corrects the previous estimations, based on the
new data, to obtain updated estimations for future usage. For this, the application uses two main statistics: company profile and personal profile. The application learns how each technician performs tasks and updates these statistics daily.

- **Company profile**: The activity duration is calculated at the company level based on the *Activity duration stats fields* configured in the *Statistics* screen. All activities belonging to the same field value are grouped together for calculating the duration. The key is typically something that identifies similar activities as a single entity including fields such as *Activity Type*. When a technician performs tasks and reports the time against them, the company level estimate is derived for each task type based on the stats field values. The application gives more importance to more recent data for computation, rather than historic data. This increases the estimation accuracy and allows the application to respond to changes in trends in a timely manner. The default duration specified in the *Add activity type* screen is used as the starting point for estimating the duration. The application:
  - Refers to the previous experiences of similar tasks.
  - Calculates the estimate based on the summary of experiences.
  - Learns from new experiences.
  - Updates and remembers the updated experiences for future use.

Every day the estimate is modified by a small amount, based on the durations reported on the previous day for similar activities. The correction applied is controlled to ensure that there isn’t too much deviation from the previous estimation and the estimated durations do not keep fluctuating on a daily basis; but is significant enough to respond to any trend change within a few days.

The formula to calculate the new estimate is:

\[ \text{New estimate} = \text{Previous estimate} \pm \text{Correction} \]

where correction is based on previous estimates and the differences between the estimated and reported durations.

- **Personal profile**: Along with the company level estimate, the estimated time for the activity for the technician is computed in the form of a ratio. This ratio is calculated based on the company level estimate for the activity. The final estimate at the technician level is the product of the personal profile ratio and the company level estimate. Each technician may have different ratios for different types of activities, based on their performance. Similar to the correction applied to the Company level estimates, the Personal profile ratio is also updated by a small controlled amount every day, based on the durations reported by the particular technician on the previous day for similar activities. When a technician performs an activity for the first time, the default ratio is used.

Some more important points about activity durations:

- If the personal profile is not available for an activity key value, the default ratio for the technician is used.

- The default ratio has an initial value that is specified in the *Initial Ratio for Activity Duration* field. This value will be updated each time the technician performs a relatively new activity.

- You can specify which type of resources use personal profile. If this setting is not selected, such resource types will not use the personal profile and will use only the company wide estimations.

- You can specify whether a resource affects the company level estimates. If it does, you can also specify the number of days to be skipped. The duration reported by only those resources that satisfy these two conditions is used to modify the company level estimates.

- You can set upper and lower limits for activity durations. The values will always remain within the set limits.

The fields that affect activity duration are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum and maximum relevant duration time in minutes</td>
<td>Statistics</td>
</tr>
</tbody>
</table>
### Field Service Cloud

#### Administering Oracle Field Service Cloud

**Chapter 1**

**Configure Oracle Field Service Cloud**

<table>
<thead>
<tr>
<th>Field</th>
<th>Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lower/Upper limit for personal ratio for duration calculation</td>
<td>Add activity type and Modify activity type</td>
</tr>
<tr>
<td>Default duration</td>
<td>Add resource type</td>
</tr>
<tr>
<td>Calculate activity duration using statistics</td>
<td>Resource Info</td>
</tr>
<tr>
<td>Personalize the estimation of activity duration</td>
<td></td>
</tr>
<tr>
<td>Use durations reported to enhance company-wide estimations</td>
<td></td>
</tr>
<tr>
<td>Do not consider reported data of the first x working days</td>
<td></td>
</tr>
<tr>
<td>Initial ratio for Activity Duration</td>
<td></td>
</tr>
<tr>
<td>Working days left for reported data to start impacting duration estimations</td>
<td></td>
</tr>
</tbody>
</table>

### Configuration examples

**Example 1:** Application uses the duration that is provided at the time of creating the activity

- Activity Type screen:
  - Default duration = 30
  - Calculate activity duration using statistics = not selected

If the activity created has a duration of 50 minutes, that value (50) is used, if no value is provided at the time of creating the activity, 30 minutes is used.

**Example 2:** New resource in the application has no historic data. The administrator wants to provide 20% more time than the estimated duration at the company level.

- Resource Type screen: Personalize the estimation of activity duration = selected
- Resource Info screen: Initial Ratio for Activity Duration = 120%
- Activity Type screen: Calculate activity duration using statistics = selected
- Assume company-wide estimation for the activity to be 45 minutes

Since the resource does not have previous records for this kind of activity the initial (default) ratio is used for calculations. The estimated duration for the resource is: $45 \times 120\% = 54$ minutes

**Example 3:** Application uses technician’s learned duration with limits. Resource has performed activities of this type in the past and, hence, has a personal activity key ratio.

- Statistics screen:
  - Lower limit for personal ratio to calculate duration = 50%
  - Upper limit for personal ratio to calculate duration = 200%
• Resource Type screen: Personalize the estimation of activity duration = selected
• Activity Type screen: Calculate activity duration using statistics = selected
• Assume personal profile to be 90% and company-wide estimation for the activity to be 50 minutes.

Since the personal activity key ratio falls within the set limits, it is used for estimations. The estimated duration for the resource is $50 \times 90\% = 45$ minutes.

Example 4: Application uses company duration without using personal profile

• Statistics screen:
  o Minimum relevant duration time in minutes = 3
  o Maximum relevant duration time in minutes = 1440
• Resource Type screen: Personalize the estimation of activity duration = not selected
• Activity Type screen: Calculate activity duration using statistics = selected
• Assume company-wide estimation for the activity to be 45 minutes

Since the personal profile is not configured and the company-wide estimation is within the set limits, the estimated duration for the resource is same as the company wide estimation = 45 minutes.

Pre-Calculated Travel Statistics

Travel statistics are based on the actual durations reported by field resources. As such, new customers and existing customers expanding into new operating areas will not have actual durations in the application. With this release, the application will use pending activities to derive estimated durations. Using this method improves travel durations at the time of optimizing routes and moving activities.

Oracle Field Service Cloud performs this process once a day:

• Get the list of activities and their locations.
• Estimate the probability of travel in future between each pair of ‘Activity travel stats fields’ (Travel Keys). The travel probability is calculated for all Travel Key pairs within the same travel area.
• Calculate travel durations. The travel durations are calculated only between keys that share a common travel area.
• Sort Travel Key pairs in descending order.

> **Note:** Travel Keys that have existing learned travel are excluded from the estimation process.

• Estimate a maximum of 3,000 pairs based on the sorted list.

After performing the process, the application has additional travel duration data. The next time Routing runs or a user moves an activity, the system uses the pre-calculated travel values. Calculating probability and sorting Travel Key combinations:

• Only activities that have the address resolution to the level of ‘Address’ are considered for calculations.
• Activities that have valid coordinates with an accuracy value of either 8, 9, or 0 are considered. Travel coordinates with an accuracy value of ‘0’ are provided by customers.
• Travel Keys that have at least 4 pending activities or 12 regular activities (or their combination) are considered for estimation.
• All activities belonging to the same Travel Key are considered to be in similar locations.
In the first cycle, the average travel duration within each Travel Key is calculated. This is done by selecting the corner most activities (based on x and y co-ordinates) within the Travel Key and the average distance between the locations. The Travel Keys are sorted in descending order of the number of activities, while sending the coordinates for calculation.

In subsequent cycles, the average travel time between different Travel Keys is calculated. Here, the sorting of Travel Key pairs is based on the number of activities present in both the Travel Keys involved.

Example of sorting Travel Keys: Consider the following Travel Keys with the corresponding number of activities and travel areas:

<table>
<thead>
<tr>
<th>Travel Key</th>
<th>Travel Area</th>
<th>Number of Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>TK1</td>
<td>TA1</td>
<td>100</td>
</tr>
<tr>
<td>TK2</td>
<td>TA1</td>
<td>150</td>
</tr>
<tr>
<td>TK3</td>
<td>TA1</td>
<td>200</td>
</tr>
<tr>
<td>TK4</td>
<td>TA2</td>
<td>50</td>
</tr>
</tbody>
</table>

In this scenario, the Travel Keys are sorted as follows before being sent to the Location Service:

- TK3-TK3 (within the same Travel Key)
- TK2-TK2 (within the same Travel Key)
- TK1-TK1 (within the same Travel Key)
- TK4-TK4 (within the same Travel Key)
- TK2-TK3 (between Travel Keys that share the same Travel Area)
- TK1-TK3 (between Travel Keys that share the same Travel Area)
- TK1-TK2 (between Travel Keys that share the same Travel Area)

Configure Business Rules

Business Rules help you configure the application to suit your requirements. These rules are configured on the Configuration tab.

Business Rules includes items such as:

- General features - such as enabling work zones, work skills, activity priorities
- Maps and Gecoding - such as countries included in geocoding, zip/postal codes format
- Quota Management – how quota is measured (minutes, hours, man-days) and recalculated
- Search – identifying what fields are available in search

>Note: Search uses the first 40 characters of the search string.

Access to the Business Rules window is controlled by the Business Rules visibility profile permission. You must set this permission for each user type that you want to manage Business Rules. If the action is not configured for the user type or if no visibility is defined, Activity Types will not be visible to the user. If you select ReadOnly, Business Rules is placed into a
view only mode. If you select Read/Write for this setting, the user can manage Business Rules in Oracle Field Service Cloud.

To configure Business Rules:

1. Click **Configuration**.
2. In the **General** section, click **Business Rules**.

   The **Business Rules** screen appears.

3. Complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Work Skills Support    | If a feature is disabled (unselected) the settings defined for it are retained in the application, but no restrictions are applied. Work skills and work zones are critical settings greatly affecting performance, particularly, activity assignment to resources. When they are enabled, they impose the following constraints on the process of activities assignment and reassignment:  
   - Routing takes into account work skills and work zones and assigns activities only to resources matching the work skill and work zone requirements of the activities.  
   - All newly-created activities have work skills and work zones calculated for them and, therefore, will be correctly assigned afterwards  
   - Self-assignment, Quota management, manual activities move or assignment are subjected to work skills and work zones check  
   All these factors contribute to higher application performance and help improve the use of the workforce. Disabling work skills support and/or work zones support may result in Routing results below optimum and, therefore, must be used with care. |
| Work Zones support     |             |
| Service Window Support | If selected, by default the Service Window placeholder is selected when an activity or teamwork is created (must be defined). |
| Points Support         | Select the box if you use points. When points are used, each shift and corresponding work schedule is assigned a certain number of points, which are a relative expression of the required work to be performed within such work schedule. Similarly, each activity may be also assigned a certain number of points. As the resource completes activities in their route, their points are added and compared to the total number required for the work schedule. Points may be used by Routing in activities assignment. |
| Overnight Work         | The number of hours for overnight work since midnight. Used only if you have overnight work activities. Select the time zone used to define the work-day closure from the drop-down menu. If the value is greater than 0, it is possible to create activities for the previous day’s route and perform other route modifications based on the time zone setting value. Working time ____ hours since midnight <.....>  
   This setting affects the logic of data saving by the Daily Extract functionality. If the company does not support overnight shifts, the extraction period covers time since the previous extraction till the end of the previous day. If the company supports overnight shifts, the Daily Extract data for the previous day are available for extraction after the overnight expiration, i.e., at 00:00 AM + overnight. If the data is extracted before that time, the resulting files will contain data of 2 days before. It is recommended to schedule Daily Extraction several minutes after the overnight expiration to guarantee that only the relevant data is extracted. |
| Full-time Equivalent   | Used in the Planning section of Mobility Calendars. The value is a company wide setting. The value converts the calendar to a Full-time Equivalent resource. For example: If the resource works from 08:00-16:00 (8 hours) and the Full-time Equivalent value = 8 this resource will be shown as 1 Full-time Equivalent. |
| Activity Priority      | Activity priority is used by Routing to assign urgent activities, immediate activities, and to prioritize activities for self-assignment on the map in Mobility. You can use any custom |
Field Service Cloud
Administering Oracle Field Service Cloud

Chapter 1
Configure Oracle Field Service Cloud

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>property of activity with type string, enumeration, or integer, but not fields. The configuration consists of the following parameters:</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>Property to define priority</strong>: Defines the activity property that will be used to identify urgent, immediate, and self assignment activities.</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>Urgent activities have the following values of the property</strong>: Defines the specific values of the property, which make the activity urgent or immediate. Several values of the same property can be used as criteria. In this case the values must be separated by commas in the field. The order of property values defines the priority level. The value listed first will have the highest priority, with other values following in the descending order. For example, if you have a privileged customer, you may specify it as a specific value (such as “PC”) in an activity property, so it qualifies the activity as urgent. For enumeration properties, you must specify the enumeration values.</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>Normal activities have the following values of the property</strong>: Defines the specific values of the property, which make the activity normal. For example, in-house activity selected as “IN” in an activity property may qualify the activity as normal. When activities are routed using the immediate routing run option or the urgent routing option, the priority specified in the field that you select here are considered. For example, a company must always perform repairs as soon as possible to reduce service disruptions. In this case, the company may have a custom property which indicates that the activity is “Repair” to consider an activity as urgent.</td>
</tr>
</tbody>
</table>

Enable the Visit functionality

Visit Bundling Keys

Maps and Geocoding

Available Countries

Geocoding is the process of finding associated geographic coordinates (latitude and longitude) from other geographic data, such as street addresses, or zip codes (postal codes). Geocoding data is required for Routing and is critical for Map/driving directions. Proper geocoding information is necessary for every country that this instance of the application is operating within. The Available Countries field allows adding additional countries for geocoding purposes.

Select the + symbol to select an additional country form the drop-down menu. Select the pencil icon to edit the country name for localization purposes.

Default Country for Geocoding

Determines from which country the Available Country list above is used as the default country for geocoding.

Zip Code Format

Defines the format of ZIP (postal) code and state code values, when applicable. Both fields are used in the activity coordinates resolution from its geographic address. The ZIP value is validated by the Inbound API, therefore, its format is important. When the ZIP value sent by the Inbound API does not correspond to the format set in the Business Rule, the API returns an error. However, when the Free Post code option is selected, the ZIP value is not validated and will always be accepted.

State Format

The State format field includes Free format and US. Select US for addresses in the USA having a strict 2-letter state code format. For all other countries with different civil entity systems, select Free.

GPS

**Identify technician by** – Determines how a unique technician is identified within the context of GPS plotting.

The following items are applicable with Oracle Field Service Cloud Smart Location Cloud Service:

◦ **Resource is considered idle if moved less than ___ meters within ___ minutes**

◦ **Resource is considered to be at the activity location if the distance is less than ___ meters**
**Map Parameters**

Defines the items related to the Map screen:

- **Distance Measurement Units**: Specifies whether distance is measured in miles or kilometers.
- **Ignore coordinates with accuracy less than**: Sets the minimum sufficient accuracy level for geocoding. The minimum sufficient accuracy level is the coordinate’s accuracy which is considered acceptable for usage. The coordinates below the specified level will not be used as insufficiently accurate.
- **Baidu Maps and Geocoding parameters**: Indicates the server key and browser key for Baidu maps, which are used to authenticate the user or organization using the service.

**Note**: Driving directions for Oracle map and geocoding are only shown in the following languages: (English (default), French, German, Italian, and Spanish). The default maps and geocoding provider is Oracle. Google or Baidu can be used, if it is part of your subscription. To use Google or Baidu maps, contact Oracle Sales. Further, you can have only one provider (Oracle, Google, or Baidu) configured in the application. Information about the geocoding provider is displayed on the Configuration > About screen, Enabled Services section.

**Map Layers**

Lets you add two types of map layers: Work Zone layer (work zone shapes) and custom map layers (for example, places of interest such as gas stations or gas pipelines) on top of the map. You can add a Work Zone layer or a new map layer, modify or delete an existing layer, and change the permissions for an existing layer. When you click **Add new**, the **Add Map Layer** screen appears. You can either upload shape files through the interface or through an API, or you can provide the path to MapViewer from where the custom layer is obtained. You also see the following sections:

- **Status**: Indicates the status of the layer. If the shape file is uploaded successfully and is ready for use, the status displays a green check mark. If the shape file is not uploaded properly or has any errors, the status displays a red cross mark.
- **Map layers**: Provides the name of the map layer and the date on which it was last updated. If the map layer is not available, this column provides the reason such as: Shape loading failed.
- **Permissions**: User types to which the layer is assigned. If there are multiple user types, they are displayed as, ‘<user type> and <number> more’. For example, ‘Technician and 3 more’. This column is empty for the Work Zone layer.

**Note**: The **Permissions** option is not available for a Work Zone layer.

**Properties of Work Zone layers:**

- Each Work Zone can have only one map layer, and if it does not exist, the message, No configured layers appears.
- You can create only one Work Zone layer. After a Work Zone layer is created, the Create Work Zone layer option is grayed out on the Add map layer screen and the message “ Only one layer for work zone shapes can be created” is displayed.
- When you delete a Work Zone layer through the metadata API, only the layer is deleted. The shape files are not deleted from the database. However, when you delete a Work Zone layer from the Manage interface, by selecting the Delete associated shapes option, the layer and its associated shapes are deleted.

**Nearby Radius and Nearby SLA**

Defines the criteria of the nearby activities search in the Nearby screen of the Mobility application. It does not affect the Scheduling layer on the Map screen. The Scheduling layer shows all activities in the visible part of the map. The Nearby Radius value sets the radius of the circular area in which nearby activities is to be searched. The Nearby SLA parameter sets the SLA expiration period which activities must have to match the search criteria. The default values are 50 kilometers as the radius and 60 days as the SLA. The minimum values are 1 km and 1 day, respectively. The maximum values are 1000 km and 1000 days, respectively. As the result, the functionality searches a circular area with the center in the resource location and the radius equal to the
Nearby Radius value, selecting the activities with SLA expiring within the period defined as Nearby SLA. Any activities not conforming to these criteria will not be included in the search results.

Company Boundaries

The latitude and longitude coordinates of the company’s geographical work area. Activities can be performed only within these boundaries that are a set of squares. To identify a square, its top left and bottom right corners are defined. If no boundaries are defined the company can perform work anywhere. Additional boundaries can be added by clicking the + symbol.

Quota Management

The following items are applicable with Oracle Field Service Cloud Capacity Cloud Service:

- **Measurement units for Quota and Available Capacity**

  Defines the general settings affecting Quota Management functionality. Particularly, the user can choose the units of measurement to display Quota and Used values by setting the Quota and available capacity are defined in parameter. The available values are hours, man-days and minutes. Internally, all values are calculated in minutes anyway, and are converted to the selected unit when the corresponding value is displayed in the Quota View.

  When man-days is selected as the unit of measurement, the Number of hours per man day is field appears where the correlation between man-days and hours can be defined. Ultimately, this parameter is used to convert man-hours into minutes.

  When the Quota is defined as percentage of the capacity available by calendar, sometimes it requires adjustment. To adjust the value, the system estimates the capacity available by calendar, processes the already booked activities (to calculate the Other activities value), and, finally, recalculates the Quota in minutes using the defined percentage value.

- **Recalculation period**

  You can set a predefined time interval for Quota and Capacity recalculation using the every [ ] minutes field.

  Valid values: 1 to 1,440 minutes

  Default value: 10 minutes

  Also, you can recalculate quota and capacity for a predefined future period (defined as days or calendar weeks). For example, if you enter 10 minutes and set 3 calendar weeks for Quota and Capacity recalculation, then the recalculation occurs after every 10 minutes for 3 calendar weeks.

  The Calendar Week (during:drop-down list) option is processed based on the value selected from the First Day of the Week drop-down list in the Display screen.

  When you use the Calendar Week option, all remaining days of the current week (unless the start day is the week start day selected using the First Day of the Week drop-down list) plus all days of the following weeks are considered.

  However, if the recalculation period is set to 7 days, the recalculation is performed for 7 days only. The maximum value for the Calendar Week option is set to 99 days or 15 calendar weeks.

  You can select the recalculation start day (current day, tomorrow, or day after tomorrow) from the The Corresponding quota values are automatically adjusted starting from drop-down list.

  The Quota and Capacity is recalculated for the Available Capacity, Booking Status, and Quota screens.
Note: When an activity is booked during the predefined recalculation period, then irrespective of the routing schedule and the specified recalculation period, the values in the Available Capacity, Booking Status, and Quota screens are recalculated immediately.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity Intervals</td>
<td>See Define Time Intervals section in the Oracle Field Service Cloud Capacity Cloud Service Guide.</td>
</tr>
<tr>
<td>Search Fields</td>
<td>Define Search Fields for Core Manage and Define Search Fields for the Mobility Application</td>
</tr>
</tbody>
</table>

Related Topics

- Add a Map Layer

How Geocoding Works

Oracle Field Service Cloud attempts to geocode a location using the address data that is provided when the activity is created.

The application uses the following fields when attempting to geocode the location:

- Address (caddress)
- City (ccity)
- State (cstate)
- Zip/Postal Code (czip)
- Country (country_code)

Data provided in these fields are submitted to the geocoding service without any modification or manipulation. When the geocoding service resolves a location, it returns a response with an accuracy level. In understandable terms it is accurate up to the address, accurate up to the street, and accurate up to the city. The location is resolved based on the selection made in the Ignore coordinates with accuracy less than setting on the Business Rules screen. For example:

- If the value for Ignore coordinates with accuracy less than is Address, and the geocoding service returns Accurate up to the Intersection, the location is not resolved, because the lowest acceptable level based on the configuration is Address.
- If the value for Ignore coordinates with accuracy less than is Intersection and the geocoding service returns Accurate up to the Address, the location is resolved, as it exceeds the lowest acceptable level based on the configuration of Intersection.

Ignore coordinates with accuracy less than includes the following options in descending order:

- Address: Indicates an accuracy level of the exact premise. Usually requires an exact match of the address (including house number, street name, street type/suffix/prefix), city, state, zip, and country.
- Intersection: Indicates an accuracy level of a major intersection, usually of two major roads.
- Street: Indicates an accuracy level of a street.
- Route: Indicates a named route (such as US 101). This may not apply to all countries.
- Zip: Indicates an accuracy level of the zip/postal code. May also require a city name and country match.
City: Indicates an accuracy level of the city. May also require the country name to be matched.

County: Indicates an accuracy level at the county level. This type may indicate a minor civil administrative level. Not all countries have this type of administrative levels.

State: Indicates an accuracy level at the state level. Within the United States, these administrative levels are states. Not all countries have this type of administrative levels.

Country: Indicates an accuracy level of the country. If you update an existing activity (with resolved coordinates) with a new country_code, the coordinates for the activity are reset to zero (acoord_x=0, acoord_y=0).

The better the data quality, the more likely the location is resolved. For example - if you submit “10 Henr St Chartley, MA 02712”, the accuracy level will most likely result in something less than an accuracy level of Address, because Henry is misspelled. Other items to watch out for are extra characters or spaces in the fields, missing or wrong address prefix or suffix, abbreviations that do not match postal guidelines, a new address that is not in any geocoding service, wrong data (wrong zip/post code or street name), and partial data. Any of these items can cause challenges with resolving an address.

Best practices

- We recommend setting the ignore coordinates with accuracy less than to Zip. Any other settings may result in fewer locations being resolved or too many locations resolved with a low level of accuracy.

- Do not include additional address elements in the Address (caddress) field. The element includes but is not limited a business name, unit, flat, suite, floor number, and so on.

- Avoid uncommon abbreviations, or abbreviations that are part of a defined standard used by the postal authority. It is possible that “Ave”, “Ave.” and “Avenue” can lead to different accuracy resolutions.

- You may have to experiment to find the best way to send address data to Oracle Field Service Cloud.

- When available, we recommend that you send us the geo-coordinates when you create activities. Send the values using Coordinate X (acoord_x) and Coordinate Y (acoord_y).

Add a Map Layer

Map layers are layers that are added on top of a map. The layers may include the places of interest that are specific to your business. You can add layers through an external source or internally through APIs. Use APIs to upload shape files for each layer that you want to create and configure it in the Manage screen. You can also add a layer for your work zone, which is visible to all users.

If you are adding an internal map layer, you must upload a shape file through the metadata API.

Note: Work Zone layers are not displayed on the Map view in Oracle Field Service Mobility Cloud Service.

1. Click Configuration.
2. In the General section, click Business Rules.
3. In the Maps and Geocoding section, click Add new.
   - The Add Map Layer dialog appears.
4. Select whether you want to create a Work Zone layer or a map layer.
   - You can add only one Work Zone layer; after you add it, the Create work zone layer option is grayed out.
5. Enter the name of the layer in the preferred language.
The languages displayed here are the languages that you have selected for Company language in the Display screen. This option is not available for the Create work zone layer option. The application adds the name ‘Work Zone Layer’ automatically and translates into the required languages.

6. Add a label for the custom layer in the Label field.

   If you have added a custom layer through the metadata API, the name is suggested as you type it. If you have not added any layer through API and you do not add an external source, you cannot save the layer. This option is not available for the Create work zone layer option. The application adds the name ‘wz_layer’ automatically and translates into the required languages.

7. Select the status of the layer in the Status drop-down menu.

   A layer with the Active status is available in Oracle Field Service Mobility Cloud Service, and a layer with the Inactive status is not available. This option is not available for the Create work zone layer option.

8. Select the location from which you want to use the shape for the layer:
   - Upload shapefile later via API: Select this option to upload a shape file through API.
   - Upload shape now: Select this option to upload a shape file now. The following fields are displayed:
     - URL to shape file: Enter the URL to the location where the shape file is available. Use only a secure protocol, that is, a HTTPS URL.
     - Username and Password: Enter the username and password to access the shape file location.
     - SRID: Enter the shape identifier that was generated in the application in which the shape was created.
   - Use external data source: Select this option to use an external data source to display custom layers. This functionality requires Oracle MapViewer where the layers are created and stored. The following fields are displayed:
     - MapViewer URL: Path to MapViewer from where the layer data is obtained.
     - Data source: The source of the map layer data used by MapViewer.
     - Theme: Layer name in MapViewer.
   - Use already uploaded shape: Select this option to use a shape that is already uploaded. The list of available shapes is displayed and the following details are displayed:
     - Layer label: The label of the layer.
     - Last updated: The date on which the shape file was last updated.
     - Source URL: The URL in which the shape file is uploaded.

9. Click OK.

   By default, users of all user types have access to the new custom layer. If the status is Active, the application verifies if:
   - Data for this layer is present in the database.
   - Data is consistent and not corrupted.
   - There are no errors when displaying the layer on map.

   If these conditions are satisfied, the layer is saved and displayed on the following Oracle Field Service Mobility Cloud Service map screens:
   - Team map: Accessed from Mobility > Map
   - Activity List map: Accessed from Mobility > Activity List > Map
   - Activity Details map: Accessed from Mobility > Activity Details > Map

Review the following information before uploading shape files:
Requirements for the shape file:

- The shape file must be in a zip archive.
- The shape file must be in the root of the zip archive, not inside any folder of the zip archive.
- If more than one shape file is present in the root of the zip archive, the first shape file of the default zip archive reading sequence is processed and saved. The rest of the shape files are ignored.
- Column names in the shape file must contain only alphanumeric characters and underscore ("_").
- Column names must begin with an alphabet.

Shape file restrictions:

- When uploading a shape file using HTTPS, the following restrictions apply: WebLogic’s default certificate validator does not accept certificates with wildcards (including Google Drive certificate).
- SRID value should be a valid SRID.
- A maximum of 2 GB is available for extracted shape file data that is uploaded and hosted in Oracle Field Service Cloud.
- If a shape file contains a column with the name "SHAPE_AREA" (case insensitive), it is renamed as “SHAPE_AREA_”.
- If a column name is same as an Oracle Database reserved word, then an underscore ("_") is prefixed to the column name. The full list of Oracle Database reserved words is available at: Oracle Database Reserved Words.

Recommendations:

- It is recommended that you use shape files with compressed data size less then 50MB. The shape file data is extracted and stored in the browser memory (when showing to end user), so the size of the file may heavily influence the browser performance, including the inability to show the map layer.
- It is not recommended to use polylines for work zones.

Display a Work Zone Layer on a Map

After you add a Work Zone layer on the Business Rules screen, you can display it on the map. Before you display a layer on the map, you must select the shape identifier on the Edit Map Layer screen. The shape identifier helps you identify the shape when you are working on a different screen. For example, the shape identifier can be the internal serial number.

1. To select the shape identifier:
   a. Click Configuration > Business Rules.
   b. Go to the Map layers section.
   c. Click Modify against the layer for which you want to add the shape identifier.
   d. In the Edit Map Layer screen, select a value in the Shape Identifier drop-down list.

2. To display the Work Zone layer on the map:
   a. Click Configuration > Work Zones.
   b. Select or create the work zone for which you want add the shape identifier.
   c. Add the value of the shape identifier in the Work Zone Shapes field.
   d. Click Update or Add.

The work zone shape corresponding to the selected shape identifier is displayed on the map.

Update Shape Properties

After you upload a shape, you can modify its properties such as visibility on the Map hint.

1. Click Configuration.
2. In the **General** section, click **Business Rules**.
3. In the **Map layers** section, click the stack icon next to layer that you want to modify and click **Modify**.
   The **Edit map layer** dialog opens and displays the information in the **Layer info** and **Shapes** sections. The information in the **Shapes** section depends on the way in which you have uploaded the shape.
4. Select a title for the shape in the **Shape** title column drop-down menu.
   This title is displayed for the shape on the Map view in Oracle Field Service Mobility Cloud Service.
5. Fill up the following fields in the **Shape hint columns** section:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom name</td>
<td>Enter a meaningful name for the layer.</td>
</tr>
<tr>
<td>Visible on hint</td>
<td>Select whether you want to display the name in the hint on the Map view in Oracle Field Service Mobility Cloud Service.</td>
</tr>
</tbody>
</table>

6. Click **Save**.
   The changes are saved.

**Assign Permissions to a Map Layer**

When you upload a shape, by default it is available for all user types. You can change the permissions as to which users can see which shape.

1. Click **Configuration**.
2. In the **General** section, click **Business Rules**.
3. In the **Map layers** section, click the stack icon next to layer that you want to modify and click **Permissions**.
   The **Select user types** dialog appears. By default, all the user types are selected.
4. To remove access to the selected layer, click the minus icon next to the user type.
5. To provide access to a layer, click the plus icon. Select the check boxes next to the user types to whom you want to provide access.
6. Click **Save**.
   The changes are saved. The updated permissions come into effect the next time the user of the corresponding user type logs in.

**Delete a Map Layer**

You can delete just a map layer or a layer with its associated shape files as well. You can delete the layer either using the metadata API or through the **Business Rules** screen.

1. Click **Configuration > Business Rules**.
2. Go to the **Map layers** section.
3. Click the menu on the right against the layer that you want to delete and click **Delete**.
   The **Delete map layer** dialog appears.
4. To delete just the layer, click **Delete**.
   If you go to the Add map layer screen and select the **Use already uploaded shapefile** option, the shape file that was related to the deleted layer is displayed in the list.
5. To delete the layer and its associated shape files, select **Delete associated shapes** and then click **Delete**.
   If you go to the Add map layer screen, the **Use already uploaded shape file** option is not available. This is because, the shape file that was associated with deleted layer was removed from the Geospatial Database.
6. Click **Save** on the **Business Rules** screen.

**Note:** Deleting a layer and its associated shape file is possible only through the Core Manage interface. The metadata API DELETE method removes only the layers from the database.
Define Bundling Keys for a Visit

Oracle Field Service Cloud sends configured notifications for each activity separately. In cases, where there are several activities (appointments) scheduled on the same day for the customer and you want to send one notification of each kind (for example, day before, reminder, or change notifications) to the customer, then select the Enable Visit Functionality check box to activate the Visit functionality.

The Visit Bundling Key field defines the criterion being used to define a visit. The criterion can include an activity property field, where you can set the length of the property values and determine whether the property values are case sensitive. The system compares the values defined in the activity fields against the specified criterion. Activities are grouped together as a visit, only if the values of all visit bundling keys match the specified criterion. To ensure that external system messages are sent in the proper way, you must add a launch condition using visit triggers while configuring message scenarios.

When routing is run using Immediate Assignment and if the Bundling setting is used (only available in Immediate Assignment routing), then the Immediate Routing plan uses the Visit Bundling key for route optimization. For example, when you use activity address as a bundling key and run routing for urgent activities, then routing finds activities that are on the same address as the urgent activity to create visits. For more details, refer to the Immediate Activity Assignment section in the Oracle Field Service Cloud Using Routing Cloud Service Guide. After you define the visit bundling keys, click Save to recalculate the existing activities according to the new visit settings. To define bundling keys for a visit:

1. Click Configuration.
2. Click Business Rules in the General section.
   The Business Rules screen appears.
3. Select the Enable the Visit functionality check box.
4. Click the Modify icon.
5. Click the Plus icon.
6. Select the required keys.
7. Click Add.
8. Use the following filters to specify additional criterion for grouping activities:
   - **Length**: Enter an integer value between 0 to 99. For example, if you enter 5, then the first 5 values of the activity property are considered.
   - **Function parameter**: Select a parameter to determine whether the activity property values are case sensitive, case insensitive, first word case sensitive, first word case insensitive.
9. Click Save.

> Note: If there are already visits in the system, and if the visit bundling keys are changed, then after recalculation, the visits no longer matching the keys are split into individual activities.

Example of How to Define Bundling Keys for a Visit

Assume that an installation activity is scheduled for a customer on 21st June, 2016 and is the only notification you send to the customer. The installation activity involves the activities, installing the hardware and installing the software but you want the customer to receive only one notification.

Assume that installing the hardware is assigned to technician William and installing the software is assigned to technician Philip. Both activities are scheduled on the same day at 4 to 5 pm and 5 to 6 pm respectively. Assume the following details for the customer:

- Account number: 123456
- Address: 77 Discovery Drive, Bozeman, Montana 59718
Since both the activities are performed on the same day for the same customer and at the same location, and the goal is to notify the customer only once, it is necessary to bundle the activities together and schedule a visit. Let us select Account Number and Address properties as the bundling keys from the Configuration, Business Rules page and click Save. Since the values defined in the activity fields (that is, Account number and Address) match the selected criteria (that is, Account Number and Address properties selected as the bundling keys); the activities, installing the hardware and installing the software, are grouped together as a visit. To verify whether the activities are grouped as a visit:

1. Select Dispatch, Activities.
2. Select the technician William from the resource tree.
3. Select the **Installing the hardware activity** from the dashboard and view the activity details.
4. Select the **Links** tab.
   A Visit number is displayed with the Pending status.
5. Repeat steps 1 through 4 for the Installing the software activity.

### Define Search Fields for Core Manage

Oracle Field Service Core Manage Cloud Service uses the activity property fields defined in the Search section of the Configuration, Business Rules screen to search for Activities in the system.

You can also edit the activity property fields in the Search section of the Business Rules screen to define additional search fields to search for activities. For example, assume that the activities in the system are searched using Name and Account Number activity fields. Now, you want to search the activities using the Address activity field. You can specify an additional search field as follows:

1. Click **Configuration**.
2. Click **Business Rules** in the **General** section.
   The **Business Rules** screen displays.
3. Click the **Edit** icon for Activity Search fields in the **Search** section.
   The **Activity Search Fields** screen displays.
4. Click the **Plus** icon.
5. Select the **Address** field.
6. Click **Add**.
7. Click **OK**.
   The **Address** field displays in the **Activity Search Fields** section.
8. Click **Save**.
9. Click the **Core Manage Search icon** and click the gear icon.
   The **Search preferences** dialog displays the selected search categories.

10. Select the by **Address** check box.
11. Click the **Back to Search** button and enter an address, for example, **7700 Technology Way**, in the **Search** field.
    When a search is performed, the search fields are selected in the order defined in the **Search preferences** dialog.
    You can perform the following tasks in the Search Preferences dialog of the **Core Manage Search** option:
    - Click the reorder icon to drag and drop the required activity search fields in the list to rearrange the order.
    - Select or clear the required activity search fields to add or remove the activity search fields.
    - Select an option from the **Date** drop-down list to refine the activity search results.

> **Note:** Search uses the first 40 characters of the search string.
Define Search Fields for the Mobility Application

Mobility uses the inventory property fields defined in the Search section of the Configuration, Business Rules screen to search for inventories in Mobility.

You can also edit the inventory property fields in the Search section of the Business Rules screen and define additional search fields to search for inventories. For example, assume that the inventories in the application are searched using Model and Item Number inventory fields. Now, you want to search the inventories using the Serial Number field. You can specify an additional search field as follows:

1. Click Configuration.
2. Click Business Rules in the General section.
   The Business Rules screen displays.
3. Click the Edit icon for Inventory Search fields in the Inventory Search Fields section.
   The Inventory Search Fields screen displays.
4. Click the Plus icon.
5. Select the Serial Number field.
6. Click Add.
7. Click OK.
   The Serial Number field displays in the Inventory Search Fields section.
8. Click Save.
9. Log in to the Mobility application.
10. Click the Search icon.
11. Enter the Serial Number (for example, 8779808797) in the Search field and click Search.
   The inventory matching the specified serial number displays.

   ✍ Note: Search uses the first 40 characters of the search string.

Capacity Time Intervals

The time interval set consists of time intervals delimited with a comma (",,"). Time intervals within the time interval set cannot have time period in common (with the only exception of a "point in time" time interval.

Capacity Categories

A Capacity Category is a predefined set of work skills and/or work skill groups and time slots visible to a user who is booking the activities for the customers.
Based on the number of minutes available (Capacity = Initial Quota allocation minus used minutes), the user decides if enough time is available within a time slot to realistically promise a specific service window to the customer. This information is sent to the CSR via Capacity API. Capacity Categories are visible only if you are using the Oracle Field Service Cloud Capacity Cloud Service module.

**Note:** The Used Minutes value is calculated based on the exact time (in minutes) from start to end of a working day.

You must enable the Capacity Categories visibility profile permission for each user to access the Capacity Categories window:

- Read-Only: Select this option to display capacity categories in a view only mode.
- Read/Write: Select this option to let the user manage Capacity Categories in Oracle Field Service Cloud.

If the permissions are not configured for a user type, the activity types will not be visible to the users. Oracle Field Service Cloud maps the work skills to assign incoming activities to the resources. In general, many companies define quota for a work skill group rather than for an individual work skill. For example, separate skills are required for installation, un-installing and maintenance of modems, but from a scheduling perspective, quota is defined for all the modem-related works group.

A capacity category can also consist of a single work skill and the minimum required level of the skill level. For example, a category can be created for all the customer-oriented work and a separate group for VIP customers or for highly difficult tasks. The two categories would contain the same work skills but the minimal qualification level in the VIP group is higher. Because of the categories and the multi-skill functionality, the same activity can match several rows in the Quota table and can be added to the Used capacity several times. The duration of this activity will be taken into account for all the capacity categories it matches.

## Create a Capacity Category

Create a capacity category to configure work skills, work skill groups and time slots.

1. Click **Configuration** > **Capacity Categories**.
   The **Capacity categories** screen appears.

2. Click **Add New**.
   The **Add Capacity category** window appears.

3. Enter the appropriate information in the following fields:
   The following table describes the fields available on the **Add Capacity category** screen.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the capacity category. The name is displayed in the list and in the quota matrix. If the application is configured for multiple languages, input boxes will appear for each language.</td>
</tr>
<tr>
<td>Label</td>
<td>Specify a label. It is used in the context of APIs and it must conform to a standard naming convention.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the <strong>Active</strong> check box to mark this capacity category as active. Only active capacity categories are used in the quota matrix.</td>
</tr>
</tbody>
</table>

4. Click **Save**.
   Once you create the capacity category, you must add work skills, work skill groups and time slots to the category.
Modify a Capacity Category

Edit an existing capacity category as and when you need.

1. Click **Configuration > Capacity Categories**.  
The **Capacity categories** screen appears.
2. Select the check box next to the capacity category that you want to change.
3. Click the pencil icon in the **Name** column.  
The **Edit Capacity Categories** window appears.
4. Change the fields that you wish to edit.
5. Click **Save**.

Delete a Capacity Category

Delete a capacity category when you no longer need it.

1. Click **Configuration > Capacity Categories**.  
The **Capacity categories** screen appears.
2. Select the check boxes next to the capacity categories that you want to delete.
3. Click **Delete**.
4. Click **OK**.  
The selected capacity categories are deleted.

Add or Edit Work Skills Within a Capacity Category

A Capacity Category can contain one or more work skills and each work skill must meet a minimum required level.

1. Click **Configuration**.  
2. In the **General** section, click **Capacity Categories**.  
The **Capacity Categories** screen appears.
3. Click the pencil icon in the **Work Skills** column for the Capacity Category that you want to add or edit.  
The **Edit Work Skill** window appears.
4. Select a work skill and add the minimum level of the skill required in the corresponding text box.  
The default value is 1. When the minimum level of a work skill is defined, an activity will match a Capacity Category, if a required skill level for the activity skill is equal to or more than the level of the Capacity Category.

> **Note:** If a capacity category contains a group of work skills, the activity matches the category if it requires at least one of work skills from the group.

Recalculate activities after any edits or updates have been made to apply changes to pending and future activities in the system.
Chapter 1
Configure Oracle Field Service Cloud

Add or Edit Time Slots Within a Capacity Category

A Capacity Category can contain one or more time slot associations.

1. Click **Configuration**.
2. In the **General** section, click **Capacity Categories**.
   
   The **Capacity Categories** screen appears.
3. Click the pencil icon in the **Time Slots** column for the Capacity Category you want to add or edit.
   
   The **Edit Time Slots** window appears.
4. Select a time slot.
5. Click **Save**.

Create a Group or Help Desk

Oracle Field Service Cloud Collaboration enables communication between the application users and lets you organize help desk activities. You can use the chat window of Oracle Field Service Cloud Collaboration to access other data from the application, instead of using the Manage interface. For example, you can share details about a resource, an activity, or an inventory item or you can move activities and inventory. Oracle Field Service Cloud Collaboration is visible only if it is configured. This procedure describes how to create a group or help desk.

The **Collaboration** screen shows settings that affect the way the user interface appears to the end user. While you may retain the default settings for most of these settings, you can change a few settings during implementation based on your business needs. Access to the **Collaboration** screen is controlled by the **Collaboration** visibility profile permission. You must set this permission for each user type that you want to manage Collaboration. If the action is not configured for the user type or if no visibility is defined, Collaboration will not be visible to the user. If you select ReadOnly, Collaboration is placed into a view only mode. If you select Read/Write for this setting, the user can manage Collaboration in Oracle Field Service Cloud.

To create a group or help desk:

1. Click **Configuration**.
2. In the **Subsystems And Integrations** section, click **Collaboration**.
   
   The **Collaboration** screen appears.
3. Click the + icon.
   
   The **New group** screen appears.
4. Fill up the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the group or help desk you are creating.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of group you are creating—options are group and help desk.</td>
</tr>
<tr>
<td>Active</td>
<td>Specifies whether the group or help desk is active.</td>
</tr>
<tr>
<td>Description</td>
<td>A description for the group or help desk.</td>
</tr>
</tbody>
</table>

5. If applicable, click the pencil icon in the **Groups to collaborate with** section to select the groups that the newly created group can collaborate with.
Chapter 1

Configure Oracle Field Service Cloud

6. Select the required groups and click OK.
7. If applicable, click the pencil icon in the Assisting Helpdesks section to select the help desks the newly created group can be assisted by.
8. Select the help desks and click OK.
9. Click Save.

Edit or Delete a Group or Help Desk

Oracle Field Service Cloud Collaboration enables communication between the application users and lets you organize help desk activities. You can use the chat window of Oracle Field Service Cloud Collaboration to access other data from the application, instead of using the Manage interface. For example, you can share details about a resource, activity, or inventory item or you can move activities and inventory. This procedure describes how to edit an existing group or help desk.

1. Click Configuration.
2. In the Subsystems And Integrations section, click Collaboration.
   The Collaboration screen appears.
3. Select an existing group or help desk.
4. To delete, click Delete.
5. If applicable, click the pencil icon in the Groups to collaborate with section to select the groups that the newly created group can collaborate with.
   The Select Groups window appears.
6. Select the required groups and click OK.
7. If applicable, click the pencil icon in the Assisting Helpdesks section to select the help desks the newly created group can be assisted by.
8. Select the help desks and click OK.
9. Click Save.

Configure the Display Screen

The Display screen shows settings that affect the way the user interface appears to the end user. While you may retain the default settings for most of these settings, you can change a few settings during implementation based on your business needs.

Access to the Display window is controlled by the Display visibility profile permission. You must set this permission for each user type that you want to manage Business Rules. If the action is not configured for the user type or if no visibility is defined, Activity Types will not be visible to the user. If you select ReadOnly, Display is placed into a view only mode. If you select Read/Write for this setting, the user can manage Display. To configure the display settings:

1. Click Configuration.
2. In the Displays section, click Display.
   The Display screen appears.
3. Complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
</tbody>
</table>
# Configure Oracle Field Service Cloud

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First day of the week</td>
<td>The week that the working week begins.</td>
</tr>
<tr>
<td>Time input</td>
<td>The way time is entered in the application—whether it is chosen from a drop-down with fixed increments or is entered manually.</td>
</tr>
<tr>
<td>Allow application to be launched inside iframe</td>
<td>Lets you launch Core Manage Cloud Service in an iFrame.</td>
</tr>
<tr>
<td>Remember User Name on Login Screen</td>
<td>The control to display the <strong>Remember my username</strong> check box on the <strong>Login</strong> screen. Selecting the <strong>Remember my username</strong> check box saves the user name and populates it automatically, when a user uses the same device and browser to log in to the application. This feature is available only for users who have the Internal and LDAP login policies, and not for users who have the SAML or OpenID Connect policies. If a user’s authentication fails, the user name is not populated when the user logs in the next time.</td>
</tr>
<tr>
<td>Enable password reset on Login screen</td>
<td>Displays the <strong>Can’t sign in</strong> link on the <strong>Login</strong> screen, which helps users reset their passwords. Resetting the password is a global feature and is available only for users assigned to an Internal Login Policy. This is not available for users assigned to LDAP, SAML, and OpenID Login Policies. Selecting this check box displays the <strong>Email for password reset</strong> field.</td>
</tr>
</tbody>
</table>
| Email for password reset                    | The source from which you want to get the email address of the user, who wants to reset their password. This field includes custom properties that can be chosen as the source of the email address to which the recovery email is sent. The custom properties are displayed only if the following conditions are satisfied:  
  - Entity = User  
  - Type = String  
  - GUI = Text or Email |

**Company time zones**

| Time zones                                | The globally available times zones. Use the **Edit** icon to add the required timezones.                                                                                                              |

**Company language**

| Languages                                 | The globally available languages. Use the **Edit** icon to add the required languages.                                                                                                           |
| Login screen language                     | The language used on the login screen when accessing the application.                                                                                                                            |

**Mobile settings**

| Number of activities per page             | The number of activities or resources to appear on one page on the mobile device. Default value is 5.                                                                                               |
| Number of inventory per page             | The number of equipment records to appear on one page on the mobile device. Default value is 10.                                                                                                 |
| Number of days to view on the Calendar    | The number of days to appear on the mobile device at a time. Default value is 14.                                                                                                              |
| Idle time minimum                         | The threshold under which idle time is not displayed on the **Time View** for Mobility.                                                                                                          |

**Quota settings**

| Major Capacity Usage                      | On the Quota grid, quota and minutes used display in brown once used = X% (major) of initial quota. Enter the percent of quota that indicates major capacity usage. Expected duration comprises [……] % of quota. |
| Critical Capacity Usage                   | On the Quota grid, quota and minutes used display in bright red once used = X% (critical) of initial quota. Enter percent of quota that indicates critical capacity usage. Expected duration comprises [……] % of quota. |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Plan column that shows data set in Forecasting</td>
<td>Whether a plan created in forecasting is available in the quota management screen.</td>
</tr>
<tr>
<td><strong>Alert settings</strong></td>
<td></td>
</tr>
<tr>
<td>Activity has not been started x minutes before the end of Service Window</td>
<td>The activity turns red and a Resource Tree warning appears based on the value set in this field. Enter the number of minutes preferred.</td>
</tr>
<tr>
<td>Activity has not been completed x minutes before the end of SLA Window</td>
<td>The activity turns red and a Resource Tree warning appears based on the value set in this field. Enter the number of minutes preferred.</td>
</tr>
<tr>
<td>Route has not been started x minutes after the start time of resource work day</td>
<td>A warning appears on the resource’s record within the Resource Tree. Enter the number of minutes.</td>
</tr>
<tr>
<td>Activity has not been started x minutes after ETA</td>
<td>A warning appears on the resource’s record within the Resource Tree. Enter the number of minutes.</td>
</tr>
<tr>
<td><strong>Activity list settings</strong></td>
<td></td>
</tr>
<tr>
<td>Travel time representation</td>
<td>The color for travel time, if a visual of travel time is desired on the Time and List views.</td>
</tr>
<tr>
<td><strong>Resource tree visualization</strong></td>
<td></td>
</tr>
<tr>
<td>Show assistants</td>
<td>Shows assistants on the Resource Tree.</td>
</tr>
<tr>
<td>Show teams</td>
<td>Shows teams on the Resource Tree.</td>
</tr>
<tr>
<td>Show activity/teamwork counters</td>
<td>Shows the count of activities or teamwork on the Resource Tree.</td>
</tr>
<tr>
<td><strong>Map</strong></td>
<td></td>
</tr>
<tr>
<td>Fade resources</td>
<td>Whether a resource becomes transparent after geolocation data update.</td>
</tr>
<tr>
<td>Fade resource time</td>
<td>The number of minutes after geolocation data update after which a resource’s time becomes transparent.</td>
</tr>
<tr>
<td>Hide resource time</td>
<td>The number of minutes after geolocation data update after which a resource’s time is hidden.</td>
</tr>
<tr>
<td><strong>Activity history</strong></td>
<td></td>
</tr>
<tr>
<td>Monitored activity fields</td>
<td>The list of activity fields to be monitored. If one of these fields (or properties) is changed, a record is inserted into a corresponding history table. Use the Edit icon to add the required activity fields.</td>
</tr>
<tr>
<td>Monitored inventory fields</td>
<td>The list of inventory fields to be monitored. If one of these fields (or properties) is changed, a record is inserted into a corresponding history table. Use the Edit icon to add the required inventory fields.</td>
</tr>
<tr>
<td>History user type</td>
<td>The user type to be used to build the identifiers of objects (activities, inventory, and service requests) that are to be logged into the history.</td>
</tr>
</tbody>
</table>

4. Click **Save**.  
The settings are saved.
Set Your Language

Manage the language setting specific to your company requirements.

The application supports 23 languages to be set up as your preferred language.

ียว Note: A few terms (such as words used in report headers) may not get translated to the language selected as the company’s preferred language.

1. Click Configuration > Display
   The Display page opens.

2. Under Company Language, select the appropriate languages from the available list and move them to the selected list.

3. Select the Login Screen Language from the drop-down list.

4. Click Save.
   The selected language is set.
Create a Filter

Filters have two primary uses—first, filters narrow down lists of activities or resources within the workspace area based on defined fields and values. These filters are used within the Time, List and Map views. This provides an ad hoc reporting capability. Second, filters within routing plans predefine the information that determines how routing will distribute activities across available resources. These filters are commonly set up to differentiate the cost or value of assigning certain jobs to certain resources, as well as determining the priority of certain types of activities.

Access to the Filters window is controlled by the Filters visibility profile permission. You must set this permission for each user type that you want to manage Filters. If the action is not configured for the user type or if no visibility is defined, Activity Types will not be visible to the user. If you select ReadOnly, Filters is placed into a view only mode. If you select Read/Write for this setting, the user can manage Filters. To create a filter:

1. Click Configuration.
2. In the **Displays** section, click **Filters**.
   The filters listing appears.

3. Click **Add New**.
   The Add filter window appears.

4. Complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>The filter name that the users see. Enter the name in English and in all the languages that are active in the application.</td>
</tr>
<tr>
<td>Applicable for</td>
<td>The entity type (activity or resource) that the filter pertains to. The entity determines the table fields that can be selected when applying the filter conditions.</td>
</tr>
<tr>
<td>List/Time/Map/Daily</td>
<td>The views within which the filter is available.</td>
</tr>
<tr>
<td>Routing</td>
<td>Whether the filter is used within routing plans.</td>
</tr>
<tr>
<td>Restriction of Visible Activities</td>
<td>Whether you want to restrict filter activities from appearing if resource routes have not been activated or a working day has not yet begun. This configuration is related to the User Type. Once the filter is configured, apply the filter as a visibility restriction filter for user type.</td>
</tr>
<tr>
<td>User Types</td>
<td>The user types that the filter is available for. This field is displayed if you select the List/Time/Map/Daily check box. Use the arrow buttons to move the user types between the Available and Selected columns.</td>
</tr>
</tbody>
</table>

5. Click **Add**.
   The filter is saved.

You must add conditions for the filter. If no conditions are added, the filter does not work.

### Add a Filter Condition

Use conditions to define the activity you are searching for.

1. Click **Configuration, Filters**.
   The **Filters** screen is displayed.

2. Locate the filter you want to add a condition to.

3. Click **Conditions** in the **Actions** column.

4. Click **Add New** at the top of the screen.
   The **Add filter condition** dialog appears.

5. Complete the following fields:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Choose one or more activity or resource-based criteria on which to base the filter.</td>
</tr>
<tr>
<td>Dynamic</td>
<td>Select the box if you want the user to type a value for the field that the condition is for.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Select one or more options to represent how the field selected above relates to the Value entry.</td>
</tr>
<tr>
<td>Value</td>
<td>These are the options that can be associated with the Field chosen for this condition. If multiple values are applicable for this condition to be met, then add them to the Selected column.</td>
</tr>
</tbody>
</table>
Field name | Action
--- | ---

6. Click Add.
7. Navigate to the Work Area and verify that the filter is listed in the View drop-down menu.
8. Test the filter to ensure that it meets your requirements.

Delete a Filter Condition

When a filter condition is no longer needed, you can remove it from the application.

1. Click Configuration. Click Filters from the Displays section.
2. Find the filter that has the condition you want to delete from and click the Conditions link.
3. Select the check boxes next to the condition that you want to delete.
4. Click Delete above the list of conditions.
5. Click OK.

Delete a Filter

When you do not need a filter anymore, you can remove it from the application.

1. Click Configuration. Click Filters from the Displays section.
2. Select the check boxes next to the filters that you want to delete.
3. Above the list of filters, click Delete.
4. Click OK.

Glossary Entries

Use the Glossary to configure the default names of UI elements to your business needs. For example, instead of the default term for the Activity Status, Completed, you can use the glossary to configure the term to display as Done.

You can configure the description of a user-interface element, only if the element corresponds to a glossary item in the Oracle Field Service Cloud glossary.

The changes made to glossary references are global, that is, the change is consistent for all users. However, the same glossary entry might belong to different categories or sub categories. For example, the glossary entry, Not Done belongs to the categories, Activity Status, Activity History Operation, Notification Trigger Name, and Action Link. If you modify the glossary entry, Not Done that belongs to the category, Activity Status, then the change does not affect other categories.

Note: The glossary entries for the Screen Configuration (Manage, Collaboration, Mobility, and Plugin) categories are configured for the selected user types.

The Glossary Visibility Profile permission that controls the access to the Glossary window for a User Type is set using the Company Configuration context in the Screen Configuration, Manage section. Only User Types that have Read/Write access can modify the glossary.
The following columns display on the Glossary page:

- **Category**: Displays the category and the sub category, if available, in the format, <Category:Subcategory>. For example, Activity: First Manual Operation.
- **Label/ID**: The label/ID of the glossary entry displays. If label is not available, the ID displays. You cannot change labels in the glossary.
- **Columns for each language**: The selected languages are displayed. See [Add an Active Language](#).

You can click on the text highlighted in red on any of the Language column to view the number of missing glossary entries.

When you update one of the missing glossary entries, the red highlight on the text box disappears and the count in the Language column is updated. If no entries are missing, the warning text on the column header disappears.

Click the Search icon in the search field to list the glossary entries. You can select a specific category from the drop-down list next to the search box and enter a term in the Search field to search for the required glossary entries.

By default, the original text for all glossary entries is displayed. When you modify the original text of a glossary entry and click Save, the modified text is overwritten. However, the original text is still visible, when you hover the mouse over the modified text.

### Modify a Glossary Entry

Oracle Field Service Cloud glossary items have a unique identifier referred to as placeholder IDs. The Placeholder ID that displays next to an UI element lets you identify the correct glossary item that you want to edit in the Configuration, Glossary page. For example, assume that you want to use the term, *Show* instead of the default term, *View*.

You can also modify the description of an UI element using an in-context editor so that you need not access the Configuration, Glossary page. This example explains how to modify the description of a UI element, View using placeholders and in-context editor. To modify a glossary entry:

1. Select your user name (for example, Admin) at the top right corner.
2. To modify the description of each UI element using placeholders:
   a. Select **My Display**.
   b. Select the **Show Placeholder ID** check box.
   c. Click **OK** and refresh the page.
   
   Each UI element that corresponds to an Oracle Field Service Cloud glossary item in the application displays an ID next to them.

   d. Select **Dispatch, Activities**.
   e. Make a note of the placeholder ID (for example, 8047) for the UI element, *View*.
   f. Click **Configuration**.
   g. Click **Displays, Glossary**.
   h. Enter the **Placeholder ID** in the search field and click the Search icon.
   
   The glossary entry displays.

   i. Select **English** as the language and enter the term, *Show* in the field.
   j. Click **Save**.

   The glossary entry is modified and you can view the original text, *View* when you hover the mouse over the modified term, *Show*.

3. To modify the description of each UI element using the in-context editor:
   a. Repeat steps 1 to 2.c from the above procedure.
   b. Select your user name (for example, Admin) and select **Glossary Editor is Off**.

   The in-context glossary editor is turned on.
c. Select Dispatch, Activities.
d. Select View.
   An on-screen glossary editor displays.
e. Enter the term, View in the English field.
f. Click Save.
g. Deselect Glossary Editor is Off and the Show Placeholder ID check box from the My Display screen.
h. Refresh the page.
   The modified description displays.

Export and Import Glossary Items

You can export the glossary entries to a .csv file to achieve the following goals:

- Translate a list of glossary entries to one of the selected languages that is set using the Languages button.
- Modify a list of glossary entries.

> Note: It is recommended that updates are made using a text editor. Do not use Microsoft Excel, as it converts the .csv file from a comma-delimited file with quote qualifiers to a comma-delimited file without quote qualifiers.

Therefore, you can simultaneously update a list of glossary entries and import the updated list into the application. This example explains how to export a list of glossary entries related to the Category, Activity Hint and import the modified entries into the application. To export glossary entries:

1. Click Configuration.
2. Click Displays, Glossary.
3. Select Activity Hint as the Category from the drop-down list.
   The entries related to Activity Hint display.
4. Click Export.
   The Export dialog displays and by default, the languages that display on the Glossary page are selected. You can also export the entries to any of the deselected languages. To add a language, see Add an Active Language.
5. Select the Filtered option to only export the entries related to the Category, Activity Hint. Or, select the All option to export all the glossary entries.
6. Click Export.
7. Save the file in the .csv format, for example, test.csv.
8. Open test.csv, modify the required entries in the English (en-US) and Spanish (es-ES) columns, and save the file.
9. Click Import on the Glossary page, select test.csv, and click Import.
10. Click Save.
    The modified entries display in the English and Spanish columns.

Add an Active Language

The Languages button enables you to select the active languages (that is, the languages that you want to display) on the Glossary page without accessing the Display, Company Language setting. Based on your selections, the Language columns (drop-down lists that let you toggle among the selected languages) are updated.
To add an active language:

1. Select **Languages** from the **Glossary** page.
2. Click the **Plus** icon.
3. Select the language, for example, **Spanish** and click **Add**.
   
   The selected language displays in the **Languages** list.
4. Click **OK**.

The selected language, Spanish displays as an option in both the Language columns.

---

**Edit Property Descriptions**

You can edit the description for properties for each user type and for each screen separately using the following categories:

- Screen Configuration – Manage
- Screen Configuration - Mobility
- Screen Configuration - Collaboration and Identifiers

Each category has a sub category that is associated with the respective screen within Screen configuration. For example, the sub category, Activity fields for export that belongs to the category, Screen Configuration – Manage is associated with the Activity fields for Export screen that belongs to the Screen Configuration – Manage within the **Configuration, User Types** page.

**Note:** If you share a screen configuration across multiple user types, then the properties of that screen configuration are also shared, and, therefore, any change to the description of a property of that screen configuration, affects all user types.

For example, if you share the screen configuration that belongs to the user type, Administrator using the **Copy or share screen configuration, Use Screen configuration of** option across user types, Technician and Field Engineer, even the properties of the screen configuration that belongs to the user type, Administrator are also shared.

Assume that the **Activity fields for Export** screen that belongs to the user type, Administrator has the property, Work Order and the screen is shared across multiple user types, Technician and Field Engineer.

When you edit the glossary entry for the Work Order property, the changes are also applied for the user types, Technician and Field Engineer.

By default, the **Glossary** page displays all properties for each screen within Screen configuration. If there are custom names for any of the user types, then the original and custom names for the property are displayed in a comma-separated format for each language.

This example shows how to add a custom name, Job Code to the user type, Technician for the Work Order property in the Activity fields for export screen that belongs to the category, **Screen Configuration – Manage**. To edit a property description:

1. Click **Displays, Glossary**.
2. Select **Screen Configuration – Manage** from the drop-down list and click the **Search** icon.
   
   The properties related to Screen Configuration – Manage display.
3. Click the **Edit** icon in the language column that is displayed for the Work Order property for the Screen Configuration - Manage: Activity fields for export category.
The property label, appt_number and the original name, Work Order display.

4. Click the Plus icon and select the user type, Technician.

**Note:** The Edit Custom Names for User Types screen and the Plus icon displays when there are custom names for user types. If there are no custom names for user types, then the Add screen displays when you click the Edit icon.

5. Click Add.
6. Enter the custom name, Job Code in the field.
7. Click OK.

The custom name, Job Code displays along with the original name, Work Order in a comma-separated format for each language.

### Holidays

There may be certain holidays when it would not be appropriate to send messages to customers. Use the Holidays section within Notifications to set up the dates where certain outgoing messages will be blocked.

Access to the Holidays window is controlled by the Notifications visibility profile permission. You must set this permission for each user type that you want to manage holidays. If the action is not configured for the user type or if no visibility is defined, Holidays will not be visible to the user. If you select Read Only, Holidays is placed into a view only mode. If you select Read/Write for this setting, the user can manage Holidays.

### Add a Holiday

There may be certain holidays on which it would not be appropriate to send messages to customers. Use the Holidays section of the Company Settings to set up the dates where certain outgoing messages will be blocked.

1. Click Configuration.
2. In the Subsystems and Integrations section, click Notifications.
3. Click Holidays.
   
   The Holidays screen appears.

4. Click Add new.
   
   The Add holiday window opens.

5. Enter the name of the holiday in the Add holiday box.
6. Select the status from the Status drop-down menu.
7. Select the date on which the holiday falls.
8. Click Add.
   
   The holiday appears in the list.

### Delete, Activate, or Deactivate a Holiday

There may be certain holidays on which it would not be appropriate to send messages to customers. Use the Holidays section of the Company Settings to set up the dates where certain outgoing messages will be blocked.

1. Click Configuration.
2. In the **Subsystems and Integrations** section, click **Notifications**.
3. Click **Holidays**.

   The **Holidays** screen appears.

4. Select the check box next to holiday that you want to delete or deactivate.
5. Click **Delete**, **Activate**, or **Deactivate**.
6. Click **OK**.

   The updated holiday list is displayed. Deactivated holidays are not included for selection.

### Inventory Types

Inventory Type helps you distinguish between serialized and non-serialized inventory.

Access to the **Inventory Type** window is controlled by the **Inventory Types** visibility profile permission. You must set this permission for each user type that you want to manage Inventory Types. If the action is not configured for the user type or if no visibility is defined, Inventory Types will not be visible to the user. If you select **ReadOnly**, Inventory Types is placed into a view only mode. If you select **Read/Write** for this setting, the user can manage Inventory Types.

### Add an Inventory Type

You can create **serialized inventory** and **non-serialized inventory** types.

1. Click **Configuration**.
2. In the **Resources, Activities and Inventories** section, click **Inventory Types**.
3. Click **Add new**.

   The **Add inventory type** dialog appears.

4. Complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter a unique identifier for this inventory type.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the inventory type available in drop-down menus.</td>
</tr>
<tr>
<td>Non Serialized</td>
<td>Select this check box if the inventory type is non-serialized.</td>
</tr>
<tr>
<td>Supports required inventory</td>
<td>Select this check box to make the inventory type required for selected activities.</td>
</tr>
<tr>
<td>Model Property</td>
<td>If desired, select additional characteristics for this inventory type from the drop-down list.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a name for this inventory type in each appropriate language field.</td>
</tr>
<tr>
<td>Unit of measurement</td>
<td>If this inventory type is non-serialized, enter a unit of measure. Use a language and a unit of measure appropriate for the country in which this inventory type will be used.</td>
</tr>
</tbody>
</table>

5. Click **Save**.
Activate or Deactivate an Inventory Type

Inventory Type helps you distinguish between serialized and non-serialized inventory.

1. Click **Configuration**.
2. Select **Inventory Types** from the **Resources, Activities and Inventories** section of the menu.
3. Select the check box next to inventory type(s) that you want to activate or deactivate.
4. Click **Activate** or **Deactivate**.
5. Click **OK**.

Link Templates

Link Templates are link profiles containing link type, time between activities constraints, scheduling constraints, and assignment constraints. Links between the activities are created with the help of Link Templates.

Linked activities ensure scheduling and detailed planning for complicated, multi-step tasks, which may potentially involve different resource types, different times, and time constraints. Configuring all these link constraints in a multi-step task allows our routing engine to assign and schedule activities while meeting all of the requirements.

The Link Templates screen includes the list of link types that exist in the system. You can edit existing links and add new ones. Note that existing activity link types cannot be removed from the system but can only be deactivated.

Access to the Link Templates window is controlled by the **Link Templates** visibility profile permission. You must set this permission for each user type that you want to manage Link Templates. If the action is not configured for the user type or if no visibility is defined, Link Templates will not be visible to the user. If you select ReadOnly, Link Templates is placed into a view only mode. If you select Read/Write for this setting, the user can manage Link Templates.

Add a Link Template

Link Templates are link profiles containing link type, time between activities constraints, scheduling constraints, and assignment constraints. Links between the activities are created with the help of Link Templates.

1. Click **Configuration**.
2. In the **General** section, click **Link Templates**.
3. Click **Add Link Template**.
   The **New Link Template** dialog is displayed.
4. Select the appropriate icon that represents the way in which you want to link activities.
   The fields below the icons change based on your selection.
5. Complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum interval</td>
<td>Minimum time interval between activities. Select one of the options:</td>
</tr>
<tr>
<td></td>
<td>o Adjustable: The time interval is adjustable with the specified default value.</td>
</tr>
<tr>
<td></td>
<td>o Non-adjustable: The time interval is non-adjustable with the specified predefined value.</td>
</tr>
</tbody>
</table>
## Configure Oracle Field Service Cloud

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum interval</td>
<td>Maximum time interval between activities. Select one of the options:</td>
</tr>
<tr>
<td></td>
<td>◦ Adjustable: The time interval is adjustable with the specified default value.</td>
</tr>
<tr>
<td></td>
<td>◦ Non-adjustable: The time interval is non-adjustable with the specified predefined value.</td>
</tr>
<tr>
<td></td>
<td>◦ Unlimited: The time interval is unlimited, with no restrictions.</td>
</tr>
<tr>
<td>Assignment constraints</td>
<td>Whether there are any constraints in assigning the activities to resources. Click <strong>Different resources</strong> if the linked activities can be performed by different resources. Click <strong>Same resource</strong> if the linked activities must be performed by the same resource.</td>
</tr>
<tr>
<td>Scheduling constraints</td>
<td>Whether there are any constraints in scheduling the activities. Click <strong>Different days</strong> if the linked activities can be performed on different days. Click <strong>Same day</strong> if the linked activities must be performed on the same day.</td>
</tr>
<tr>
<td>Link for the 1st activity</td>
<td>Specifies translations for the first activity. English is set as a default language, unless other languages are specified. You must also specify the label for this link which will be used by external systems.</td>
</tr>
<tr>
<td>Link for the 2nd activity</td>
<td>Specifies translations for the second activity. English is set as a default language, unless other languages are specified. You must also specify the label for this link which will be used by external systems.</td>
</tr>
<tr>
<td>Label</td>
<td>A unique identifier for this Link template.</td>
</tr>
<tr>
<td>Status</td>
<td>Whether this activity link type is available for selection as an option in the Add link pop-up window.</td>
</tr>
</tbody>
</table>

### Login Policies

Login Policies determine the authentication method and options for users to access the application.

There are five types of authentication methods:

- **Internal** - The internal authentication method (BasicHTTP) is a good solution for small companies with relatively few user credentials, which can be stored directly in the application database.

- **LDAP** – The LDAP (Lightweight Directory Access Protocol) authentication method is similar to the internal method, the only difference being that the users’ credentials are stored outside Oracle Field Service Cloud in an external LDAP server. This method can be used by companies which prefer to store their user data in an external server to increase security. When LDAP authentication is used, the user enters their credentials into Oracle Field Service Cloud which then passes them to the LDAP server for verification. To enable LDAP authentication, a software that supports LDAP v3 must be installed and configured on the customer’s back-end server. Examples of such software are: Active Directory, OpenLDAP.

- **SAML** – The SAML (Security Assertion Mark-Up Language) authentication method is an SSO method involving authentication data exchange between the user, the service provider (SP) and the identity provider (IdP). The user wishing to access the services of the service provider has to pass the authentication by the identity provider which asserts the user’s identity to the service provider. The user’s data is stored with the identity provider and is verified by the user’s credentials. If the user authentication is successful, the service provider verifies the user’s login policy and grants access to the application. One user can be associated with only one login policy and, therefore, its data can be stored with only one identity provider. The application supports SAML 2.0 protocol, therefore, you can use any SAML 2.0 identity provider. The identity provider details must be used in configuring the SAML Login Policy.
IDCS for Web SSO: You can use Oracle Identity Cloud Service (IDCS) as an identity provider for web SSO. This option helps customers store user credentials in a different store instead of Oracle Field Service Cloud. This option is part of the SAML authentication option, and you can upload the metadata as an XML file.

- OpenID Connect - With the OpenID Connect authentication method the user uses their account created with an OpenID Connect Identity Provider to login to any website supporting OpenID Connect authentication. The user registers their OpenID Connect URL with the OpenID Provider which becomes the user's identifier. OpenID Connect can be a method of choice for companies preferring cloud data storage and using the same credentials to access multiple websites.

Generally, the authentication method used depends on the company's business principles and requirements. In most cases, a company uses one authentication method, although, use of several authentication methods within the same company is technically possible.

Add a Login Policy

Login policies determine the authentication method and options for users to access Oracle Field Service Cloud. The application includes a default login policy, however, you can add multiple policies with multiple authentication methods.

Before you implement OpenID Connect: Create or register Oracle Field Service Cloud as an application in your identity provider. Get the Configuration URL, Logout URL, Client ID, and Client secret from the identity provider. Further, define an attribute that will be used for the username.

1. Click Company name > Configuration
   The Add Policy dialog appears.

2. In the Users and Security section, click Login Policies.
3. Click Add new.
   The Add Policy dialog appears.

4. Complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>A unique identifier label. For SAML login policy, enter only alphabets, numbers, and underscores ( _ ).</td>
</tr>
<tr>
<td>Policy name</td>
<td>A name assigned to this policy. Enter the name in English and in all the languages that are active in the application.</td>
</tr>
<tr>
<td>Authenticate using</td>
<td>The type of authentication method used for this login policy.</td>
</tr>
<tr>
<td>Max login attempts</td>
<td>The number of invalid login attempts after which the user is blocked. When this field is set to 0 (zero), the feature is disabled. However, disabling this feature is not recommended for security reasons.</td>
</tr>
<tr>
<td>Login block timer</td>
<td>The number of minutes during which the user remains blocked after reaching the maximum number of invalid login attempts.</td>
</tr>
<tr>
<td>Force password change after</td>
<td>Number of days after which the user must change their password to access the application. When this field is set to 0 (zero), the feature is disabled.</td>
</tr>
</tbody>
</table>
### Field Service Cloud

**Chapter 1**

**Configure Oracle Field Service Cloud**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User activity relogin time</td>
<td>The duration of the idle time after which the user is prompted to re-enter the password upon an attempt of any action in the application.</td>
</tr>
<tr>
<td>Relogin timeout</td>
<td>The period after which the user is prompted to re-enter the password regardless of whether the user was active or not.</td>
</tr>
<tr>
<td>Max sessions</td>
<td>The maximum number of simultaneous sessions allowed to the user.</td>
</tr>
<tr>
<td>Min password length</td>
<td>The minimum number of characters in the password.</td>
</tr>
<tr>
<td>Password must contain letters</td>
<td>Whether the password must contain alphabets.</td>
</tr>
<tr>
<td>Password must contain digits</td>
<td>Whether the password must contain numbers.</td>
</tr>
<tr>
<td>Password must contain special symbols</td>
<td>Whether the password must contain special characters and symbols.</td>
</tr>
<tr>
<td>Password must not contain personal details</td>
<td>Whether the password must not contain personal details such as the user’s first name or last name.</td>
</tr>
<tr>
<td>Password must differ from old password</td>
<td>Whether the password must be different from a previous password.</td>
</tr>
<tr>
<td>Disable weak password hash</td>
<td>When selected, authentication based on SHA-256 hash function is used. When cleared, authentication based on MD5 is used.</td>
</tr>
</tbody>
</table>

**Note:** If the customer’s LDAP server allows setting the period of forced password change, it is recommended that the period set in the application is shorter than the one set on the LDAP server. This way, the password changes initiated by the application occur earlier than those initiated by the LDAP server which ensures correct and reliable performance.

| Allow access only for certain IP addresses | Whether you want to restrict access to specific IP addresses. By default, a login policy is created without any restrictions to the IP addresses from which the user may log in. Select the check box to enable the restriction. When this check box selected, the **Allowed IP address list** field appears, where you can enter the IP addresses that can access the application. |

The following fields are displayed for the **LDAP** authentication method, along with the fields listed earlier:

<table>
<thead>
<tr>
<th>LDAP server URL</th>
<th>The actual host name or IP address of the LDAP server.</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDAP DN pattern</td>
<td>If the <strong>LDAP server is MS Active Directory</strong> check box is selected, this field contains the part of the UPN (User Principal Name) common among the users. In this case the LDAP DN pattern must always contain the UPN pattern. UPN (User Principal Name) is a string of characters used to represent a resource available in Active Directory. It should be used when communicating with MS Active Directory servers. An example of this field value is %<a href="mailto:s@test.corp">s@test.corp</a>, where %s is a special placeholder to be substituted with the user’s login. If the <strong>LDAP server is MS Active Directory</strong> check box is not selected, this field contains the common path to the LDAP tree for the users, their DN pattern. DN (Distinguished Name) is a string of characters used to represent a resource available in the LDAP directory. An example of this field value is cn=%s,dc=example,dc=com, where %s is a special placeholder to be substituted with the user’s login in the application.</td>
</tr>
</tbody>
</table>

| LDAP server is MS Active Directory | Whether the LDAP server is a MS Active Directory.                                                                                                                                                         |

The following fields are displayed for the **SAML** authentication method:
## Oracle Field Service Cloud
### Administering Oracle Field Service Cloud

## Chapter 1
### Configure Oracle Field Service Cloud

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify SAML IdP</td>
<td>The way in which you want to select the SAML identity provider. The options are:</td>
</tr>
<tr>
<td></td>
<td>- Upload metadata XML</td>
</tr>
<tr>
<td></td>
<td>- Specify metadata URL</td>
</tr>
<tr>
<td></td>
<td>- Oracle IDCS</td>
</tr>
<tr>
<td></td>
<td>- Manual populate</td>
</tr>
</tbody>
</table>

**IdP Metadata XML**

- This field is displayed if you select **Upload metadata XML** in the Specify SAML IdP field. Click **Upload** to upload the XML file that contains the metadata details for the identity provider. If the uploaded file is incomplete, or does not contain the details in the proper format, the message, Cannot download metadata from the specified XML: XML parser error is displayed. Ensure that the XML includes or conforms to the following information:
  - Metadata XML must be in accordance with SAML 2.0 specifications.
  - The file contains “SAML Issuer” (parameter “entityID” of the node “EntityDescriptor”).
  - The file provides identity provider certificate (nodes “md:EntityDescriptor/ md:IDPSSODescriptor/KeyDescriptor/KeyInfo/X509Data/X509Certificate/*”).

**IdP Metadata URL**

- This field is displayed if you select **Specify metadata URL** in the Specify SAML IdP field. Type the URL from which you want to take the SAML metadata details for the identity provider. If the URL is unresolved, the message, Cannot download metadata from the specified URL: no route to host is displayed.

**IDCS Metadata XML**

- This field is displayed if you select **Oracle IDCS** in the Specify SAML IdP field. Click **Upload** to upload the XML file that contains the metadata details for Oracle IDCS. Contact your implementation consultant for more details on Oracle IDCS.

**OFSC Metadata XML**

- The link to download the OFSC metadata XML. You must pair your identity provider with Oracle Field Service Cloud. Use the downloaded XML file to register Oracle Field Service Cloud with your identity provider.

**Max sessions**

- The maximum number of simultaneous sessions allowed to the user.

**SAML issuer**

- Used to identify asserts from Identity provider (IdP), it can be any string provided by IdP, not only URL. It is used for IdP and Service provider (SP) initiated connections.

**SAML identity provider certificate**

- IdP public key used to sign requests.

**SAML identity provider login URL**

- IdP URL to redirect to for login. It is needed only for SP initiated logins.

**SAML identity provider logout URL**

- IdP URL to redirect to for logout. It is needed only for SP initiated logins.

**SAML attribute containing username**

- The SAML assertion attribute name where IdP must store the user name (login name for Oracle Field Service Cloud). Example:

  ```xml
  [saml:Attribute Name="uid"
   NameFormat="urn:oasis:names:tc:SAML:2.0:attrnameformat:basic"]
  [saml:AttributeValue xsi:type="xs:string"]dispatcher[/saml:AttributeValue]
  [/saml:Attribute]
  ```

  If it is empty then Oracle Field Service Cloud gets the user name from the Name Identifier element of Subject statement. Example:

  ```xml
  [saml:Subject]
  [saml:NameID
   SPNameQualifier="https://sp.com/sp/module.php/ saml/sp/ metadata.php/ default-sp"
   Format="urn:oasis:names:tc:SAML:2.0:nameidformat: persistent"]dispatcher[/saml:NameID]
  [/saml:Subject]
  ```
Field Service Cloud
Administering Oracle Field Service Cloud

Chapter 1
Configure Oracle Field Service Cloud

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signature hashing algorithm</td>
<td>The security-hashing algorithm that is used to authenticate users through a SAML login policy. The option you select determines the security algorithm that is applied to OFSC Metadata, which is used to pair your identity provider with Oracle Field Service Cloud. We recommend that you use &quot;SHA-256&quot;.</td>
</tr>
</tbody>
</table>

The following fields are displayed for the **OpenID** authentication method:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max sessions</td>
<td>The maximum number of simultaneous sessions allowed to the user.</td>
</tr>
<tr>
<td>OpenID identity provider login URL</td>
<td>The Identity Provider URL to start authentication.</td>
</tr>
<tr>
<td>OpenID logout URL</td>
<td>URL to which the user is redirected after logout. It may be the URL for logout from the Identity Provider.</td>
</tr>
<tr>
<td>OpenID attribute containing username</td>
<td>The name of the OpenID attribute where the Identity Provider should store the user's name (login name for Oracle Field Service Cloud). Example: <a href="http://axschema.org/contact/email">http://axschema.org/contact/email</a> (This attribute returns the user's email). The attribute must have a unique value for each user.</td>
</tr>
</tbody>
</table>

The following fields are displayed for the **Open ID Connect** authentication method:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max sessions</td>
<td>The maximum number of simultaneous sessions allowed to the user.</td>
</tr>
<tr>
<td>Configuration login URL</td>
<td>The Identity Provider URL to start authentication.</td>
</tr>
<tr>
<td>Logout URL</td>
<td>URL to which the user is redirected after logout. It may be the URL for logout from the Identity Provider.</td>
</tr>
<tr>
<td>Attribute containing username</td>
<td>The name of the OpenID attribute where the Identity Provider must store the user's name (login name for Oracle Field Service Cloud). Example: email.</td>
</tr>
<tr>
<td>Client ID</td>
<td>The value of the field containing data from registered OpenID provider (for example, Client ID).</td>
</tr>
<tr>
<td>Client secret</td>
<td>The value of the field containing data from registered OpenID provider (for example, Client Secret).</td>
</tr>
</tbody>
</table>

5. In your OpenID application, configure a link back URL to https://login.etadirect.com/openid-connect-linkback. Your Identity Provider uses this link to redirect users to Oracle Field Service Cloud upon successful login.

**Related Topics**

- Sample Metadata XML File for SAML Identity Provider

Sample Metadata XML File for SAML Identity Provider

Sample metadata XML file for SAML identity provider:

```xml
<?xml version="1.0"?>
  <md:IDPSSODescriptor protocolSupportEnumeration="urn:oasis:names:tc:SAML:2.0:protocol">
    <md:KeyDescriptor use="signing">
      <ds:KeyInfo xmlns:ds="http://www.w3.org/2000/09/xmldsig#">
        <ds:X509Data>
          <ds:X509Certificate>MIID7TCCAtWgAwIBAgIJANn3qP9lF7M3MA0GCSqGSIb3DQEBCwUAMIGMMQswCQYDVQQGEwJVQTEXMBUGA1UE...</ds:X509Certificate>
        </ds:X509Data>
      </ds:KeyInfo>
    </md:KeyDescriptor>
  </md:IDPSSODescriptor>
</md:EntityDescriptor>
```
Organizations

An organization is an entity comprising multiple people, tools, and vehicles that collectively operate as a unit toward a common goal. In other words, an organization is either a main company, a subdivision (Line of Business of an organization), or a third-party company that has a contract with the main company. An organization can have buckets, organization units, field resources, tools or vehicle associations. You must create an organization before adding any type of resource. There is one default organization and you can create additional organizations (in-house and contractor) to meet your operational needs. For example, if XYZ Inc. is the main organization, XYZ East Coast and XYZ West Coast could be subdivisions. The resources that are directly employed with the organization can be included in the organization. An Organization can have buckets, organization units, field resources, tools or vehicle associations. You must create an organization before adding any type of resource. There is one default organization and you can create additional organizations (in-house and contractor) to meet your operational needs. For example, if XYZ Inc. is the main organization, XYZ East Coast and XYZ West Coast could be subdivisions. The resources that are directly employed with the organization can be included in the organization.
are known as in-house resources. The resources that are employed by a third-party company that subcontracts work are known as contractors. It is recommended that you create an organization for each contractor company. If the main organization cannot directly assign activities to contractor resources for legal reasons, it can assign activities to a bucket that contains contractors. Further, a field resource, tool or vehicle will automatically inherit the parent’s Organization, while a bucket or organization unit can be changed to any defined Organization in the system.

Create, Edit, or Delete Organizations

An Organization is either a main company, a subdivision (Line of Business of an Organization), or a third-party company that has a contract with the main company. An Organization can have buckets, Organization units, field resources, tools or vehicle associations. You can create, edit, or delete Organizations.

1. Click **Configuration > Organization**.  
The **Organizations** screen appears.
2. Click **Add New**.  
The **Add Organization** dialog appears.
3. Enter the name of the Organization in the **Name** field. Enter the names in the corresponding language fields for languages other than English.
4. Enter a label for the Organization in the **Label** field.  
   This label will be used as the Organization identifier in APIs.
5. Select the type of Organization from the **Type** drop-down list.  
The Organization type can be in-house or contractor.
6. Click **OK**.  
The Organization is added to the list of Organizations.
7. To edit an Organization, click the Organization on the **Organizations** screen.  
The **Edit Organization** screen appears. Edit as required and click **Submit**.
8. To delete an Organization, click **Remove** on the **Organizations** screen.  
   You can remove only those Organizations that do not have field resources, tools, or vehicles assigned to them.

Message Scenarios

A Message Scenario consists of one or more scenario steps, which determine the message content, recipients, delivery channels, and business rules. While each Message Scenario has at least one start step, you can configure multiple inner steps to execute different actions based on the results of the preceding steps. The intent is to ensure that the right people or systems receive the expected notifications, while considering all potential circumstances.

When you want to use Message Scenarios for time-based notifications (for example, notifications to customers) the recommendation is to use Reminders, Alerts, or Visit selections in the Launch Conditions. For other Launch Conditions (for example, Route, Activity, Inventory, and Service Requests) the recommendation is to use the Core API/Events REST API for integration with Oracle Field Service Cloud.

>Note: Because the messages go to your customers, you must test them carefully and thoroughly to ensure that the launch conditions, scenarios, steps, and channels are set up correctly. For more information about Launch conditions warnings and notes, Scenario Steps elements, Channel errors, Supported variables within the body of the message, refer to Oracle Field Service Cloud Message Scenario Configuration Guide.
Create a Message Scenario

A message scenario is a set of rules that specify how to process a message to a system or customers when a Launch condition occurs. A launch condition is triggered by a predefined event in the system, for example, when a reminder notification should be sent to a customer 60 minutes prior to a resource’s estimated arrival time.

1. Click **Configuration**.
2. Click **Message Scenarios** in the **Subsystems And Integrations** section.
   The **Message Scenarios** screen displays.
3. Click the **Plus** icon in the left pane.
   The **Add Message Scenario** screen displays.
4. Enter **Route Not Activated** in the **Name** field.
5. Select a date from the **Active From** field.
6. Click **OK**.
   The Route Not Activated message scenario displays on the left pane.

Define the Settings for a Scenario Step

The **Settings** tab enables you to define the general settings for a message step which includes the following settings:

- **Step Info section**: Define the type of the message step, intended recipient, and the delivery method.
- **Notification Time section**: Define when to send the message (for example, day of event or for how many days) and the time interval when the messages are sent.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step Info section</strong></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Enter the name of the step that displays in the <strong>Scenario steps</strong> section.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of step, Start or Inner. Start steps are the first steps that occur when a scenario is initiated. An inner step is run after a preceding step is completed.</td>
</tr>
<tr>
<td>Delivery Channel</td>
<td>Select the message agent for delivering the message. Options: Email, Set Property, user-defined channel, Collaboration.</td>
</tr>
<tr>
<td>Note: If you select collaboration as the delivery channel, see <strong>Use Collaboration as a Delivery Channel</strong></td>
<td></td>
</tr>
<tr>
<td>Recipient</td>
<td>The options available varies based on the selected delivery channel (Email, Set Property, user-defined channel, or Collaboration). Select the intended recipient (Customer, Resource, Dispatcher, or use static address) of the message. By default, the recipient address is fetched from the activity or resource fields for the options, Customer, Resource, or Dispatcher. However, if you select Use static address, then you must enter a static recipient address in the format, <a href="mailto:notify@etadirect.com">notify@etadirect.com</a>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Customer Notification Time</td>
<td>Select the time for notifying customers. For example, ETA, Service window, or Delivery window.</td>
</tr>
<tr>
<td>Reply Address</td>
<td>Enter the e-mail address (for example, <a href="mailto:notify@etadirect.com">notify@etadirect.com</a>) for sending notifications when you select Email as the Delivery channel and Customer, Dispatcher, or Resource as the Recipient.</td>
</tr>
<tr>
<td>Time Zone and Language</td>
<td>Select the time zone and language for the email content when you select Email as the Delivery channel and use static address as the Recipient.</td>
</tr>
<tr>
<td>Static address</td>
<td>Enter the email address or distribution group to which you want to send emails when you select Email as the Delivery channel and use static address as the Recipient.</td>
</tr>
<tr>
<td>Email address source</td>
<td>Refers to the resource property that contains e-mail information when Dispatcher or Resource is selected as a recipient or refers to the user-defined property that contains e-mail information when Customer is selected as a recipient.</td>
</tr>
</tbody>
</table>

**Notification time section**

<table>
<thead>
<tr>
<th>Sending time</th>
<th>Select one of following options:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Day of event</td>
</tr>
<tr>
<td></td>
<td>• Time of event</td>
</tr>
<tr>
<td></td>
<td>• Day of route</td>
</tr>
<tr>
<td>From</td>
<td>Select the starting time for the messages. For example, if you select 8 AM from the drop-down list, then the messages are sent from 8 AM.</td>
</tr>
<tr>
<td>Sending will time out in</td>
<td>Specify the interval in hours and minutes. The messages are sent during the specified interval.</td>
</tr>
<tr>
<td>Number of Attempts On ‘failed’ status</td>
<td>Indicates the maximum number of resend attempts. For example, if you enter 3 in the Interval field and 10 in the Minutes field, then the message is resent for 3 times after every 10 minutes.</td>
</tr>
<tr>
<td>Number of Attempts On ‘sent’ status</td>
<td>Available only for External Systems.</td>
</tr>
<tr>
<td></td>
<td>Indicates the maximum number of attempts to resend the notification status received.</td>
</tr>
<tr>
<td></td>
<td>For example, if you enter 3 in the Interval field and 10 in the Minutes field, then the notification status is resent for 3 times after every 10 minutes.</td>
</tr>
<tr>
<td>Sending delay</td>
<td>Specify the time in minutes if you want some time to elapse after an event. For example, for Post Appointment Survey messages, you want to ensure that the resource leaves the premises before the customer receives the survey.</td>
</tr>
<tr>
<td>Block messages for specific days</td>
<td>Select the days for which you do not want to send messages.</td>
</tr>
<tr>
<td>Block messages for holidays</td>
<td>Select the option, if you do not want to send messages during holidays. You must set up holidays using <strong>Configuration, Holidays</strong>.</td>
</tr>
<tr>
<td>Blocked messages sending</td>
<td>Indicates the number of days before the holiday. For example, if you select 2, then the messages are stopped before two days.</td>
</tr>
</tbody>
</table>
For our example, enter the following details:

1. Click Add New in the Scenario steps section.
   The Add scenario step screen displays.
2. Enter Start test in the Name field.
3. Select Start from the Type drop-down list.
4. Select Email from the Delivery Channel drop-down list.
5. Select day of event and + from the Sending time drop-down list.
6. Enter 2 in the days field.
7. Enter 5 in the hours field and 30 in the minutes field in the Sending will time out in field.
8. Select Service Window from the Customer notification time drop-down list.
9. Click Add.

The Start test message step displays in the Scenario steps section. The Scenario steps section also displays other details such as sending time, the number of messages that are being sent today, and a graph of the progress. The graph and the queue details are hidden if the screen size is not enough to display the details.

Related Topics

- Send Notification Messages

Define the Message Content

The Patterns tab defines the content of the message that you want to send to your customers or systems. You can use variables within the body of the message to substitute the property value within the content of the message.

Based on the delivery channel, the template for the message differs as follows:

- If the selected Delivery Channel is Email or External System, then the template for the message is defined using the Subject and Body fields.
- If the selected Delivery Channel is Set Property, then the template for the message is defined using the property field and property value.

For example, assume that Cancellation Reason property is associated with the entity, Activity. When a customer cancels an activity, you need to set the Cancellation Reason property field for the activity to the value, 14. Using the Set Property delivery channel, you can use the Cancellation Reason property in the Subject field and define the required value in the Body field. So when the step is run, the application changes the value in the Cancellation Reason property to 14.

Also, you can determine when you want to generate the content of the message using the Generate content on message creation or Generate content on message sending options. For example, assume that you want to send a Post Appointment Survey message to your customer and the Sending delay field in the Settings tab is set to 40 minutes. Assume that the content of the Post Appointment Survey message has three activity property fields.

Although the message is created when the message step is run, the property values may change after 40 minutes. Hence, select the Generate content on message sending option so that you receive the latest changes. For example, if you want to display the customer address in the content of the message, enter the label name of the property field using { }. For example, {caddress}.

1. Select the Start test message step from the Scenario steps section.
2. Select the Patterns tab.
3. Enter test start in the Subject field.
4. Enter start test activity started at {caddress} in the Body field.
5. Select **Generate content on message sending** option and click **Update**.

Define Conditions

The **Next Steps** tab identifies the relation between different steps of a scenario and defines the conditions for the execution of subsequent steps.

For example, assume that the start step (that is, the start test activity) fails due to some reason and you want to inform a resource in the Helpdesk department that the activity has failed. To handle the above condition, you must create an inner step and define the message that you want to send to the Helpdesk department.

*Note:* By default, the **Next Step** drop-down list in the **Start test, Next Steps** tab is empty. Since the inner step handles a specific condition when the Start Step fails, it is required to create an inner step and link the Start step with the Inner step.

To create an inner step, follow the steps in the Define the settings for a scenario step using the Settings tab section, but modify the following settings:

- Enter **test inner** in the **Name** field, select Inner, Resource, and Email from the **Type, Recipient, and Delivery Channel** drop-down lists.
- Enter the email address of the Helpdesk department in the **Reply address** field.
- Select the **Patterns** tab and enter the message that you want to send in the **Subject** and **Body** fields.

For our example, let us configure the Start step so that when the Start step fails, the inner step (that is, test inner) runs and sends the failure message to the Helpdesk department.

1. Select the **Start test** message step from the **Scenario steps** section.
2. Select the **Next Steps** tab.
3. Select **Failed** from the **Status** drop-down list.
4. Select the check box and enter the required description.
5. Select **test inner** from the **Next Step** drop-down list.
6. Click **Add**.
   
   The configured condition displays in the list.

7. Click **Update**.
   
   The test inner step is updated with the latest settings.

Block Message Steps

The **Conditions** tab enables you to define conditions to block the messages in a step. The application checks for any blocking conditions, and if the conditions are met, then the messages in the step are not processed.

Assume a scenario where you want to block the messages that are sent to the customer if the customer cancels an activity. To handle the above scenario, define a condition to verify whether the value in the Activity Status field is Cancelled as follows:

1. Select the Start test message step from the **Scenario steps** section.
2. Select the **Conditions** tab.
3. Select **Activity Status** from the **Field** drop-down list.
4. Select **In** from the **Condition** drop-down list.
5. Enter Cancelled in the Value field.
6. Select Failed from the Result drop-down list.
7. Enter activity is cancelled in the Description field.
8. Select Check on message sending option.
9. Click Add.

The configured condition displays in the list. If an activity is cancelled, then the customer receives a notification that is configured in the Conditions tab, that is, “failed, activity is cancelled.”

Add Launch Conditions

Launch conditions are trigger events that invoke message scenarios and scenario steps to deliver configured messages to client systems.

Assume that you want to invoke the message scenario that you have created, that is, Route Not Activated when a resource’s route is not activated. Therefore, you need to add a launch condition to invoke the scenario as follows:

1. Click Configuration > Message Scenarios .
2. Click Add New in the Launch Conditions section.
3. Select Route is not Activated from the The scenario will be launched when drop-down list.
4. Enter the number of minutes in the minutes after shift starts according to calendar field.
5. Click OK.

The launch condition displays in the Launch Conditions section of the Message Scenarios screen. For each launch condition of the scenario, the Launch Conditions section also displays the number of messages that are in the queue. If the number of messages is greater than 999, then the numbers are displayed as follows:

- Range 1000-999999 - "k". For example, 1000 messages are displayed as "1k"; 10000 messages are displayed as "10k".
- Range 1000000 and greater - "m". For example, 1000000 messages are displayed as "1m"; 123000000 messages are displayed as "123m"

Note: When the user selects a message scenario in the routing plan as a Fallback option, a read-only launch condition, Routing fallback is automatically populated in the message scenario. When the user removes the message scenarios from all associated routing plans, the launch condition is removed from the message scenario. The launch condition has a count of routing plans to which it is associated. You can click the count of routing plans in the launch condition UI to view the routing plans.

Send Notification Messages

Channels define a mechanism to communicate notification triggers to external systems. The Email agent is used for sending messages when the Email delivery channel is selected.

However, if you want to send messages to an external system (for example, client system), then you must define the details of the client system (such as Host, Port number, URL, Connection method, and so on) using the Delivery Channels screen. For example, let us create a delivery channel, external sys 1 as follows:

1. Click Channels.
   The Delivery Channels screen displays.
2. Click the Plus icon on the left pane.
3. Enter **external syst 1** in the **Name** field.
4. Select the required option from the **Status** drop-down list.

**Note:** If notification scenarios contain at least one message step that uses an internal delivery channel (e-mail or voice) then that channel is accessible in the list of channels. A user with appropriate permissions can select Active or Inactive to resume or stop the message delivery for any external or internal channel. For example, you can block a channel using the Inactive option in Test instances to disallow test messages to reach real customers. Messages that are not delivered due to inactivated delivery channel get the status ‘obsolete’ with the description, EXTERNAL_NOTIFICATION_ARE_DISABLED. Note that the 'set property' messages do not have a delivery channel and cannot be handled this way.

5. Enter **agent.com** in the **Host** field and **8080** in the **Port number** field.

**Note:** Enter one of the following values (20, 21, 22, 25, 80, 290, 389, 443, 587, 873, 2401, 3668, 4011, 4142, 5308, 5666, 5900, 5901, 6666, 6460, 7800, 8080 8443, 14861 and 20106) in the **Port** field.

6. Enter the URL Path of the server (optional).
7. Enter the name and password of the user for authorization purpose.
8. Select the **Allow basic access authentication** check box if you want to implement HTTP basic authentication while integrating with external systems.

When you select the check box, the outbound methods (such as send_message, drop_message, get_message_status methods) send the standard HTTP header "Authorization" with base64-encoded user credentials (standard basic access authentication). Also, the <user> SOAP structure is sent in the body of the request. The client application can either use the standard HTTP header "Authorization" or the <user> SOAP structure to send user credentials in the request.

**Note:** When the check box is not selected, the standard HTTP header is not used in the request and the client application can use the <user> SOAP structure for authentication. For more information, see the Integrating with Outbound API Guide.

9. Select a connection from the **Connection** drop-down list to denote the encryption protocol type.

**Note:** By default, **Not Encrypted** option is selected. If you select default encryption or any other encryption type, then complete the necessary fields in the **Advanced Settings** section.

10. Click **Add**.

The channel displays in the **Delivery Channel** drop-down list in the **Add scenario step** and **Modify scenario step** screens. The delivery channel, external syst 1 also displays on the left pane on the Delivery Channels screen. The channel details are displayed in:

- Green if there are no warnings and the channel is active
- Gray if there are no warnings and channel is inactive
- Red if there are warnings, or count of message scenarios is greater than 0 and the channel is inactive

Active and Inactive are also displayed on active and inactive channels respectively.

---

### Use Collaboration as a Delivery Channel

You can use collaboration as a delivery channel to send alerts of different types of events or situations in Oracle Field Service Cloud to collaboration users (for example, technicians, help desk operators, and resources). Also, you can broadcast
notifications or alerts to collaboration user groups or help desk groups on occurrence of an event or when a predefined condition is met in Oracle Field Service Cloud.

- Subscribe to Collaboration to view the Collaboration option as a delivery channel in the message scenario. View the About screen in your instance to verify whether the service is enabled.
- Create collaboration users, user groups, or help desk groups.

➤ **Note:** For more information on configuration settings, see the Configuring Collaboration section in the Oracle Field Service Collaboration Cloud Service Guide.

For example, assume that you want to notify the resource using collaboration as a delivery channel when an activity is created in Oracle Field Service Cloud. Assume that the message scenario, `new appt` is associated with the `Activity is Created` launch condition and has a scenario step, Collab Alert.

1. Log in to Oracle Field Service Cloud as a Administrator.
2. Click **Configuration, Message Scenarios**.
3. Select the Collab Alert scenario step.
4. Select Collaboration from the **Delivery Channel** drop-down list in the **Settings** tab.
5. Select one of the following options from the **Recipient** drop-down list:
   - Resource: Delivers message to the resource associated with the launch condition. By default, Oracle Field Service Cloud considers the language and time zone of the user associated with the resource.
     ➤ **Note:** If the collaboration permission is not configured for the resource, then the message scenario displays a False Method status in the **Messages** tab of the **Activity Details** screen for the scenario step.
   - Use static address: Enables you to send the message to specific users, user groups, and helpdesks. Click **Add New** and search for the required users, user groups, and helpdesks. Select the required users, user groups, and helpdesks to add them to the **Recipients** section.
     ➤ **Note:** You must enter three letters in the **Search** field to search for the required users, user groups, and helpdesks.
6. Enter the message content in the **Subject** and **Body** fields of the **Patterns** tab.
     ➤ **Note:** The default language of the company is configured from the **My Display, Language** drop-down list and is selected as the language for the message content. To add more languages, see **Configure the Display Screen**. For example, if English is configured as the default language and if the **Subject** and **Body** fields in the **Patterns** tab is populated is English, then regardless of the user’s language, the message is sent to the recipient in English. However, you can use the **Pattern** tab to specify another language for the message content. You can specify any one of the languages selected from the **My Display** setting as the language for the message content. For example, if English is configured as the default language and the **Subject** and **Body** fields in the **Patterns** tab is populated is Spanish, then the message is sent to the recipient in Spanish. If the default language is not configured then English is considered as the default language of the recipient and the message is sent to the recipient in English.
7. Configure the required fields and click **Save**.
   The details such as sending time and the selected delivery channel are updated for the Scenario step.

Assume that a new activity is assigned to the resource, Phillip. The message scenario is triggered and the Collab Alert scenario step is displayed with the New status in the **Messages** tab of the **Activity Details** screen.
When the message alert is sent to the resource, the status in the Messages tab of the Activity Details screen changes to Sent.

**Note:** If the scenario step is not configured properly or if the message alert is not sent to the resource, the status in the Messages tab of the Activity Details screen changes to Failed. However, if a message is invalidated because of an activity-related operation in Oracle Field Service Cloud (such as delete, move, suspend activity), the status in the Messages tab of the Activity Details screen changes to Obsolete.

To view the message alert, log in to Oracle Field Service Cloud using resource’s login credentials. For more information, see the About Collaboration Window section in the Oracle Field Service Collaboration Cloud Service Guide.

### Add a Non-Working Reason

If a resource is not available for work at some point during their regular work schedule/shift, then a non-working reason (illness, vacation, bereavement, etc.) must be applied to explain their absence. Once set, this reason appears on the calendar within the Daily view.

The list of non-working reasons can be configured through the Configuration screen.

1. To view the Non-Working Reasons screen:
   a. Click Configuration.
   b. In the General section, click Work Schedules.
   
   The Work Schedules screen appears.
   c. Click Non-Working Reasons.
2. To add a new non-working reason, click Add non-working reason.
3. To edit an existing non-working reason, click Modify on the far right of the grid.

In either case, you will be prompted to enter a name and a label (unique identifier) for the non-working reason.

### Properties

Each entity (for example, activity, resource, inventory, and users) contains a set of associated attributes. For example, resource records may contain attributes such as name and contact information as well as physical attributes such as gender or a photograph. These attributes within Oracle Field Service Cloud are combinations of fields or custom properties.

Properties with the Type “Field” are the native system properties that are available for the specified entities. For example, Name (property label, cname) is associated with an Activity, and Serial Number (property label, invsn) is associated with Inventory. Field type of properties can be mapped with similar client properties.

**Note:** Multiple fields or properties with the same name can exist. For example, Name can refer to a customer’s name (property label, cname) or a resource’s name (property label, pname). In this example, each Name property is assigned to a different entity and has a different property label.

Custom properties are attributes of entities that are unique to each client. You can create them through the user interface, import them, or create through an API. Once added, these properties are available for use in screen configurations, filters,
and numerous configuration areas (for example, search fields, duration field, and so on). You can create the following types of properties:

- **String**: These are custom properties that require alphanumeric entries. These can include free text boxes, URLs, phone numbers, or email addresses.
- **Integer**: These are custom properties that require numeric entries. This option can also be used for check boxes.
- **Enumeration**: These are custom properties that require selections from fixed lists. Option buttons and combo (drop-down lists) boxes are common examples of this property type.
- **File**: These are custom properties that require some type of file upload. These could include MIME types such as .gif, .jpg, .pdf, .mpeg, .zip, html, .wav, or .doc. Examples of File properties could be customer signatures or even technician photos.

### Create a String Property

The string property includes free text boxes, URLs, phone numbers or email addresses. Assume that resources can enter remarks for an activity after the activity is closed. The Activity Details form must contain a text box so the resource can enter remarks.

1. Click **Configuration**.
2. Click **Properties** in the **Resources, Activities, Inventories** section.
3. Click **Add New**.
4. Select **String** from the **Property Type** drop-down list.
5. Complete the following fields:
   - **Property name** (mandatory): Enter a name that you want to display to the end user in English and in all the languages that are active in the application.
   - **Property label** (mandatory): Enter a Unique database identifier for the Oracle Field Service Cloud API.
   - **Property hint** (optional): Enter a hint that you want to display when a user hovers over the field name. For example, Enter comments if any. Enter the text in English and in all the languages that are active in the application.
   - **Regular expression**: Enter an expression to validate the values or format the values in a certain way.
   - **Entity** (mandatory): Select **Activity** since the property is associated with the Activity Details form.
   - **Lines Count** (mandatory): Enter the number of lines that you want the property to display in the Activity Details form. For example, enter 3 to display a maximum of three lines.
   - **GUI** (optional): Select one of the following options to define how the property displays to users:
     - **Text Element**: Displays as a free text field. For our example, select this option.
     - **URL**: Displays as a clickable URL.
     - **Phone**: Displays as a clickable phone number.
     - **Email**: Displays as a clickable email address.
     - **Geolocation Element**: Displays a button to show the location on a map.
   - **Regular expression** (optional): Enter an expression to validate input or to force the data to display in a certain way.
     For example, if you want to display $23,540, then use the following regular expression: `/^$/?([1-9]{1}[0-9]{0,2}(/[0-9]{3})*/|[0-9]{0,2})?([1-9]{1}[0-9]{0,2})?([0-9]{1,2})?$/

Other examples:
- Ethernet ARP address: `^([0-9a-fA-F]{2}){5}[0-9a-fA-F]{2}$`
- Phone number: `(555)555-5555: /[/\d/-]{10}/`
### Clone property on Reopen/Prework (optional)
Enables you to duplicate the property while reopening the activity or applying prework for a new activity.

### Formatting (optional): If selected, displays the following options:
- Regular expression
- XSL transformation (converts an XML file into a table format viewable in HTML that is read-only).

**Note:** Formatted properties are not available for presentation on the Inventory Grid context layout screen.

Assume that you want to display the following data from a client system within Oracle Field Service Cloud:

<table>
<thead>
<tr>
<th>Group</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>One Time Charges and Credits</td>
<td>$100.00</td>
</tr>
<tr>
<td>Programming Change</td>
<td>$5.00</td>
</tr>
<tr>
<td>Programming Change</td>
<td>$5.00</td>
</tr>
<tr>
<td>Programming Change</td>
<td>$5.00</td>
</tr>
<tr>
<td>UNKNOWN</td>
<td>$0.00</td>
</tr>
<tr>
<td>Monthly Charges</td>
<td>$129.98</td>
</tr>
<tr>
<td>America's Top 250</td>
<td>$69.99</td>
</tr>
<tr>
<td>HD/SD (2TV) Receiver</td>
<td>$14.00</td>
</tr>
<tr>
<td>HD/SD (2TV) Receiver</td>
<td>$14.00</td>
</tr>
<tr>
<td>DVR Service</td>
<td>$6.00</td>
</tr>
<tr>
<td>Protection Plan</td>
<td>$6.00</td>
</tr>
<tr>
<td>Israeli: The Israeli Network</td>
<td>$19.99</td>
</tr>
<tr>
<td>Monthly Credits</td>
<td>$10.00</td>
</tr>
<tr>
<td>Cr: Agent $10x24 Mo</td>
<td>$-10.00</td>
</tr>
<tr>
<td>Monthly Charges and Credits</td>
<td>$119.98</td>
</tr>
</tbody>
</table>
Use the following regular expression for the above data: 
\(/(s+)?(.+w)+/\(s+\)/s+(\+)/n?/im = [item group="$1"]
[name]$2[/name][price]$4[/price][currency]$3[/currency][/item]

The following XML file converts the data given earlier into a table format:

```
<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
  <xsl:template match="/">
    <style>
      .property_table
      {
        font-size:12px;
        font-family: Arial;
        border-collapse: collapse;
      }
      .property_table .property_name
      {
        padding-left:15px;
      }
      .property_table td
      {
        border: 1px solid grey;
        padding: 4px;
      }
      .property_table .property_price
      {
        text-align:right;
      }
      .property_group
      {
        background-color:#ccc;
        font-weight: bold;
      }
      .property_group .property_name
      {
        padding-left:5px;
        font-weight: bold;
      }
    </style>
    <table class="property_table">
      <xsl:for-each select="root/item">
        <xsl:choose>
          <xsl:when test="@group=' ' métier"
            <tr class="property_group">
              <td class="property_name">[xsl:value-of select="name"][/td]
              <td class="property_price">
                <span>[xsl:value-of select="currency"]</span>
                [xsl:value-of select="price"]</td>
            </tr>
          </xsl:when>
          <xsl:otherwise>
            <tr>
              <td class="property_name">[xsl:value-of select="name"]</td>
              <td class="property_price">
                <span>[xsl:value-of select="currency"]</span>
                [xsl:value-of select="price"]</td>
            </tr>
          </xsl:otherwise>
        </xsl:choose>
      </xsl:for-each>
    </table>
  </xsl:template>
</xsl:stylesheet>
```
Create an Enumeration Property

Option buttons and drop-down lists are examples of the enumeration property. This means, you can have a set of valid values and you can select only one value from the enumeration set. For example, if you have four different types of customers, Standard, Gold, Silver, Bronze and you want to indicate the customer type on each activity record.

This example creates an enumeration property, Customer level with four values, Standard, Gold, Silver, and Bronze, and displays the property as a drop-down list in the user interface.

1. Click Properties in the Resources, Activities, Inventories section.
2. Click Add New.
3. Select Enumeration from the Property Type drop-down list.
4. Enter Customer level in the Property Name field. Enter the name in English and in all the languages that are active in the application.
5. Enter Cust_level in the Property label field.
6. Select Activity from the Entity drop-down list.
7. Select Combo box from the GUI drop-down list.
8. Specify the value, Standard in the Enumeration Values field and click Add.
Note: The values display in alpha-numeric order. The system automatically applies an index value to each specified value, and the index value is case sensitive. The APIs reference the index value. For example, if you want to use a readable value for the value, customer not home, you can use the code CNH instead of the default index value, 1 and map the code to the client system. You cannot edit the index value, after it is added.

9. Repeat step 6 for each value, that is, Gold, Silver, and Bronze. The specified values display in the Values field.

10. Select a value from the Values field.
11. Clear the Active check box.
12. Click Edit to make a value inactive and does not display in the user interface.
13. Click Add.

Create a File Property

File property type supports file transfers such as documents, photos, or signatures. This means, you can upload MIME types such as .gif, .jpg, .pdf, .mpeg, .zip, html, .wav, or .doc files.

1. Click Configuration > Properties.
2. Click Add New.
3. Select File from the Property Type drop-down list.
4. Enter a name for the property in the Property Name field. Enter the name in English and in all the languages that are active in the application.
   This is the name that is displayed on the context layout screen and any screen to which the property is added.
5. Enter a label for the property in the Property label field.
6. Enter a hint that you want to display when a user hovers over the field name in the Property hint field. Enter the hint in English and in all the languages that are active in the application.
7. Select the entity to which the property belongs, in the Entity field.
8. Select one of the following options for the GUI field:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File element</td>
<td>Select this option to upload a file. When uploaded, the file displays as a text link in the user interface. The following fields are displayed for this option:</td>
</tr>
<tr>
<td></td>
<td>◦ File size limit: Select the maximum file size you want to allow for File elements in Oracle Field Service Mobility Cloud Service. This field is displayed only for the File element option. The default and the maximum size allowed is 5 MB.</td>
</tr>
<tr>
<td></td>
<td>◦ Allowed MIME types delimiter: Select whether you want to display separate allowed MIME types with commas, or you want to display each allowed MIME type on a new line.</td>
</tr>
<tr>
<td></td>
<td>◦ Allowed MIME Types: Click the required types of files you want to allow for upload.</td>
</tr>
<tr>
<td>Signature element</td>
<td>Select this option to capture the resource’s signature.</td>
</tr>
<tr>
<td>Image element</td>
<td>Select this option to enable the user’s device to capture and upload the user’s photo, and to display the image as a thumbnail. The following fields are displayed for this option:</td>
</tr>
<tr>
<td></td>
<td>◦ Allow draw on image: Select this check box to let the user draw on the captured image using a stylus.</td>
</tr>
<tr>
<td></td>
<td>◦ Get geolocation: Select this option to save the location information on a map with the captured image.</td>
</tr>
</tbody>
</table>
9. Select whether you want to copy the property data when an activity is reopened or has a pre-work activity in the **Clone property data on Reopen or Prework** field.

10. Click **Add**.
    
    The new property type is added. Add this property to the context layout of the screen for the user profile for which you want to display.

---

### Create an Integer Property

Check boxes and text fields are examples of the integer property. Use the integer property to enter numerical values such as port number, or to select your decision such as whether an additional inventory has been approved by the dispatcher [Yes/No].

This example creates an integer property, Customer confirmed, and displays the property as a check box in the user interface.

1. Navigate to the **Configuration** screen.
2. Click **Properties** in the **Resources, Activities, Inventories** section.
3. Click **Add New**.
4. Select **Integer** from the **Property Type** drop-down list.
5. Enter **Customer confirmed** in the **Property Name** field. Enter the name in English and in all the languages that are active in the application.
6. Enter **Cust_decision** in the **Property label** field.
7. Select **Activity** from the **Entity** drop-down list.
8. Select **Checkbox element** for GUI.
9. Enter an expression in the **Regular expression** field to validate input or to force the data to display in a certain way.
10. Select whether you want to duplicate the property while reopening the activity or applying pre-work for a new activity.
11. Click **Add**.
    
    The newly added property appears on the **Properties** screen.

---

### Add a String Property to the Screen Configuration

After you create a property, you can assign it to a specific user type and determine where the property type displays on the screen.

Also, you can define the following visibility settings for the property type:

- Read only, read/write, or mandatory options.
- Conditions under which the property type displays.

*Note:* Not all conditions are available for every screen context.
Let’s assign the string property, CSR Notes property to a User Type, Administrator, and add it to the Activity Details form. Also, let us set the property type to Read-Only when the activity status is Completed and change the property type to Read Write when the activity status is Pending. To add a string property:

1. Click **Configuration, User Types** in the Users and Security section. The existing users display in the left pane.
2. Select **Administrator** from the left pane.
3. Select the **Screen Configuration** tab.
4. Expand **Manage** and click **Add activity/Activity details**.
5. Select a property from the Layout Structure pane and click **Add property**.
6. Select the property, CSR Notes and click **OK**. The property, CSR Notes displays in the Layout Structure pane.
7. Click **Add New Visibility** and select **Read-Only**.
8. Click **Add New Condition**.
9. Select **Activity Status** and **in (equal)** from the drop-down lists.
10. Click the **Plus** icon, select **Completed**, and click **Save**.
11. Click **Add New Visibility** and select **Read-Write**.
12. Click **Add New Condition**.
13. Select **Activity Status** and **in (equal)** from the drop-down lists.
14. Click the **Plus** icon, select **Pending**, and click **Save**.

You can view both the conditions in the Conditions column.

**Resource Types**

A resource type helps you identify the following differences:

- Account for cost differences between full time employees and contractors.
- Identify the resources that you want to track using geolocation.
- Manage quota and capacity for resources.
- Distinguish between team holder and team member.
- Share a resource’s inventory and work skills in a team.

You can create different resource types to differentiate the hierarchy of the Resource Tree. While creating a resource type, each resource type is assigned to a role. The roles (Field Resource, Vehicle, Tool, Bucket, and Organization Unit) enable you to differentiate the hierarchy of the Resource Tree. Each role is represented with the icons, Blue, Yellow, or Grey.

By default, the Load Threshold section displays (unless the Organization Unit role is selected) on the Add Resource Type screen and has the following options to determine how the icons display on the resource tree based on the resource’s load (full, normal, or empty load):

- **Number of Activities**: Defined amount of activities, over which a resource is considered to have full load and below which is considered an empty load.
- **Hours**: Defined amount of hours including travel, over which a resource is considered to have full load and below which is considered an empty load.
• Time Percent: Defined % of a resource’s work schedule for the day that includes activities and travels among them that is considered to be full, normal or empty. Travel time to and from work for the day is not included in these calculations.

Note: Specify the number of activities, hours, percentages in the Full Load or Empty fields. The display of icons on the resource tree depends on the specified values. For example, if 10 activities represent Full load, then the Blue icon displays.

Add a Resource Type for the Field Resource Role

A Field Resource is a resource that performs work, has work skills and work zones associated, and has a related user (actual person performing work or group of people). A Field Resource requires a user, can execute work, is shown with a Tech icon and does not include the Organization unit option.

Assume that you want to assign activities to a technician. Therefore, you have to create a resource type, technician and select Field Resource from the Role drop-down list.

Note: Some features are available only during the initial configuration. This will vary based on the options selected during the configuration. Features that are not available for editing after the initial configuration will be greyed out.

To add a resource type for the Field Resource role:

1. Click Company Name > Configuration.
2. Click Resource Types in the Resources, Activities, Inventories section.
3. Click Add resource type.
4. Enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name (mandatory)</td>
<td>Enter a name for the resource type. All supported languages are listed.</td>
</tr>
<tr>
<td>Label (mandatory)</td>
<td>A unique identifier for the resource type that is mapped to the Resource Management API.</td>
</tr>
<tr>
<td>Active</td>
<td>By default, the Active check box is selected and the resource type is activated.</td>
</tr>
<tr>
<td>Statistic Parameters section</td>
<td></td>
</tr>
<tr>
<td><strong>Personalize the estimation of activity duration</strong></td>
<td>When selected, the resource’s personal profile is used for duration calculations. Else, uses only company estimates. For more information, see How Activity Duration Is Calculated.</td>
</tr>
<tr>
<td><strong>Use durations reported to enhance company-wide estimations</strong></td>
<td>When selected, company-wide estimations are modified based on the data reported by the resource. If not selected, the company-wide estimations are not changed. This applies to both activity durations and travel estimations. Do not select this check box, if you do not want the durations reported by the resource to affect company level estimations.</td>
</tr>
<tr>
<td>Do not consider reported data for the first ____, working days, for statistic estimations</td>
<td>Data reported by the resource does not affect the company-wide estimations for the initial number of days specified in this field. The date is considered from the time the user accesses the system. Default value is 5 days. For example, if you enter 15 days, then the data reported by the resource for activity and travel durations are ignored for the first 15 days and will not be considered while calculating the company-wide estimates. This field is enabled only if the Use data reported to enhance company-wide estimations field is selected.</td>
</tr>
</tbody>
</table>

5. Select Field Resource from the Role drop-down list.
6. Select the required features from the following list:

- **Resource can participate in a team**: Select the Resource can participate in a team check box to determine whether the resource type is an assistant for teamwork activities. If deselected, then you cannot add the resource type, technician as an assistant to a team.

- **Resource can be a teamholder**: Select the Resource can be a teamholder check box to determine whether the resource type is a primary team holder of an activity.

  **Note**: An activity that requires a team is always assigned to the team holder whereas the assisting teamwork activities are assigned to the assistants for the duration of the teamwork.

- **Share inventory in teamwork**: Determines whether the resource type shares inventory with other team members after an activity is started. For example, if the team holder’s inventory has 5 items and the assistant’s inventory has 3 items, then when the activity is started, there are 8 items available for use at the job site.

- **Share geolocation in teamwork**: Select the check box to define whether a resource (team holder or assistant) shares the geolocation in a teamwork assignment. Although, the application uses the GPS device of each resource to predict the location of the resource, the following situations can occur:
  - Application is unable to obtain coordinates since the device of a resource has stopped to work.
  - Application is unable to find the location of the resource due to some reasons.

In the above situations, the application uses an algorithm to predict the location of the resource using the coordinates of other resources in the team. Therefore, you can view the location of each team resource in the map view.

- **Share work skills in teamwork (team-member only)**: Enables the resource to share work skills with the team holder. Sharing is defined on the work skill level according to the "Sharing of the skill in the team" parameter configured in the Add work skill screen.

- **Used for Quota management**: Enables you to consider the working time of each resource into the overall workflow capacity calculation of the bucket.

  For example, assume that each resource (Technician 1, Technician 2, and Technician 3 configured as a Field Resource) has a capacity of 480 minutes per day and the Use as Capacity Area check box is selected for each resource. Therefore, the Max Available field in the bucket has the overall workflow capacity of 1440 minutes. Now, if a new resource type, Technician 4 is added and if the Use as Capacity Area check box is selected, then the overall workflow capacity of the bucket changes to 1920 minutes.

- **Routing can assign activities**: Select the check box if you want routing to assign activities to a resource.

If selected, the following options enable you to specify the cost of the resource’s time that helps you to differentiate between resources (for example, Full time resources versus Contractors):

- **Working hours cost**: Actual working hours of the resource during the day based on activity durations. Select an option (Low, Normal, High, Highest). The routing algorithm factors working time cost differences between resource types for assignments.

- **Overtime cost**: Overtime refers to the minutes worked beyond the end of the resource’s working hours for the day. Specify cost increases either as X minutes after the end of the shift or the time beyond the X minutes threshold.

- **Travel Time cost**: Refers to the estimated time and the cost required for travelling between activities.

- **Working time**: Define the travel allowance for resources using the following options:
  - **Start travel**: Enables routing to consider travel time from the beginning of the resource’s working time for the day and to the resource’s first activity. The application estimates the actual travel time to the location of the first activity, when a resource’s Start location is defined. Note that when a route includes activities that require travel and activities that do not need travel, the travel between activities is split
Configure Oracle Field Service Cloud into two (or more) pieces by inserting non-travel activities in between. If there is any idle time before an activity, it is considered as travel time for the next activity. Select one of the following options:

- Travel time to the first activity is not included from the Working Time Start – when selected, travel time to the first activity will not be calculated. If an activity has a Service Window of 8:00 am-10:00 am, the activity will have an ETA of 8:00 am and the resource will have to leave their start location to arrive by 8:00 am.

- Travel time to the first activity is included from the Working Time Start – when selected, travel time will be calculated to the first activity. If a resource has 30 minutes of travel and the activity has a service window of 8:00 am-10:00 am the activity’s ETA will be 08:30 am.

- Resource is allotted up to <number> minutes of travel time prior to the Working Time Start – when selected, a portion of the travel time can occur prior to the start of the shift. If the value is set to 30 minutes and the resource need 45 minutes of travel the first 30 minutes will occur prior to the start of the shift and the ETA activity’s ETA will be 08:15 am.

- Final travel: Enables routing to consider travel time to a known end location. Select one of the following options:
  - Travel time from the last activity to the Resources End Location is not included from the Working Time End – when selected, travel time to the final location will not be calculated. If a resource’s shift ends at 6:00 pm with no overtime allowed, routing can assign activities that can end at 6:00 pm.
  - Travel time from the last activity to the Resources End Location is included from the Working Time End – when selected, travel time to the final location will be calculated. If a resource’s shift ends at 6:00 pm with no overtime allowed, routing cannot assign activities that can end at 6:00 pm.
  - Resource is allotted up to <number> minutes of travel time after the Working Time End – when selected, a portion of the travel time will occur after the shift ends. Suppose that the resource’s shift ends at 6:00 pm with no overtime allowed. When the value is set to 30 minutes and the resource needs 45 minutes of travel to the end location, the latest an activity can end would be 5:45pm.

- **Enable 'Not activated in time' alert and trigger:** Represents an alert that the resource’s route is not activated. For example, consider the resources, Technician 1 and Technician 2 configured as field resources. If the Enable ‘Not activated in time’ alert and trigger check box is selected for the resource, Technician 1 and not selected for Technician 2, then the notification messages are created only for Technician 1.

7. Click **Add**.

**Note:** The following features are available when a role, **Vehicle** or **Tool** is assigned to a resource type:

- Share inventory in teamwork
- Share geolocation in teamwork
- Share work skills in teamwork (team-member only)
- Working time includes travel to first activity
- Working time includes travel from last activity
- Enable ‘Not activated in time’ alert and trigger

The resource type, technician displays on the Resource Types screen. If you click Modify and change a feature setting of a resource type, the application automatically applies the changes to the resource type.
Example of a Travel Allowance Calculation

Roger’s assigned Resource Type has the following Work Time configurations:

- Travel time to the first activity is included from the Working Time Start
- Travel time from the last activity to the Resources End Location is included from the Working Time End

Jane and John’s assigned Resource Type has the following Working Time configurations:

- Resource is allotted up to 30 minutes of travel time prior to the Working Time Start
- Resource is allotted up to 30 minutes of travel time after the Working Time End

Consider Roger, Jane, and John, who have their work shift from 9:00 am to 6:00 pm and the following distances from work place:

- Roger lives 30 minutes from his first and last job. So, for both jobs, 30 minutes of travel is included part of his workday.
- Jane lives 45 minutes away from the first and last job. So, for both of her jobs only 15 minutes of the travel should be counted as part of her workday and the additional 30 minutes is beyond her workday.
- John lives 20 minutes away from his first and last job. So, no travel is part of his workday and the 20 minutes travel for the last job is done beyond his workday.

Using this example, if a new activity is created that is estimated to finish by 5:45 pm and overtime is no allowed, routing will not assign this activity to Roger. If it was assigned, Roger would incur overtime, because his shift ends at 6:00 pm. The routing engine would look for a more suitable resource.

Add a Resource Type for the Bucket Role

A bucket accumulates work that has not yet been distributed to field resources. A bucket does not require a user, cannot execute work or activities, is shown with a Double Tech icon, includes group option, and can have activities assigned.

Note: Some features are available only during the initial configuration. This will vary based on the options selected during the configuration. Features that are not available for editing after the initial configuration will be greyed out.

1. Click Configuration.
2. Click Resource Types in the Resources, Activities, Inventories section.
3. Click Add resource type.
4. Select Bucket from the Role drop-down list.
5. Enter the following information:
   - Name (Mandatory): Enter a name for the resource type. All supported languages are listed.
   - Label (Mandatory): A unique identifier for the resource type that is mapped to the Resource Management API.
   - Active: Select the Active check box to activate the resource type.
6. Select the Use as Capacity Area check box.
   This option is available only if you have purchased Capacity Cloud Service. For more details about Quota Management in Bucket, see the Oracle Field Service Cloud Using Capacity Cloud Service Guide guide.
7. Select the **Routing can assign activities** check box if you want routing to assign activities to the bucket.
8. Click **Add**.

The resource type, Bucket displays on the **Resource Types** screen.

### Add a Resource Type for the Organization Unit Role

An organization unit aggregates field resources, vehicles, and tools in a hierarchical structure to simplify management and reporting. An organization unit does not require a user, cannot execute work or activities, is shown with a Double Tech icon, includes group option and can have activities assigned.

> **Note:** Some features are available only during the initial configuration. This will vary based on the options selected during the configuration. Features that are not available for editing after the initial configuration will be greyed out.

1. Click **Company Name > Configuration**.
2. Click **Resource Types** in the **Resources, Activities, Inventories** section.
3. Click **Add resource type**.
4. Select Organization unit from the **Role** drop-down list.
5. Enter the following information:
   - Name (Mandatory): Enter a name for the resource type. All supported languages are listed.
   - Label (Mandatory): A unique identifier for the resource type that is mapped to the Resource Management API.
   - Active: Select the Active check box to activate the resource type.
6. Select the **Use as Capacity Area** check box to aggregate the capacity across buckets.

For example, assume that the maximum available capacity for Bucket 1 is 1920 minutes and the **Use as Capacity Area** check box is selected. Bucket 2 has a maximum available capacity of 2400 minutes and the **Use as Capacity Area** check box is not selected. Now, if you select **Use as Capacity Area** check box check box for Bucket 2, then the resource type, Group aggregates the capacity across Bucket 1 and Bucket 2 and changes the maximum available capacity of the Group to 4320 minutes.

7. Click **Add**.

The resource type, Organization Unit displays on the Resource Types screen.

### Add a Resource Type for Contingent Worker

Contingent (or Infrequent) Workforce is one where the workers do not work directly for the company. They are contractors that may not have dedicated or assigned routes everyday. They will be assigned work infrequently on an ad-hoc basis.

> **Note:** The Contingent Worker service must be enabled and available as part of your Oracle Field Service Cloud subscription.

1. Click **Configuration**.
2. Click **Resource Types** in the **Resources, Activities, Inventories** section.
3. Click **Add resource type**.
4. Enter the following information:
### Configure Oracle Field Service Cloud

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name (mandatory)</td>
<td>Enter a name for the resource type. All supported languages are listed.</td>
</tr>
<tr>
<td>Label (mandatory)</td>
<td>A unique identifier for the resource type that is mapped to the Resource Management API.</td>
</tr>
<tr>
<td>Active</td>
<td>By default, the Active check box is selected and the resource type is activated.</td>
</tr>
</tbody>
</table>

5. Select **Field Resource** from the **Role** drop-down list.

6. Select the **Resource is a contingent worker** check box.

The remaining check boxes are grayed out. The following rules apply to contingent worker resources:

- When the Resource is a contingent worker check box is selected, the Role cannot be anything other than "Field Resource".
- This resource cannot participate in teamwork.
- This resource cannot access resources other than themselves.
- This resource cannot access the video chat service if provisioned.
- Quota does not consider contingent workers while calculating the available capacity.
- Bulk, urgent, and immediate routing do not assign activities to this resource.
- The alert regarding route activation does not display for this resource.
- Travel and activity duration from these resources are not included in the company-wide statistics.

**Note:** The **Resource is a contingent worker** check box is grayed out on the **Edit resource type** screen. This means, after you create a contingent worker resource type, you cannot change it back to a normal resource. Further, a contingent worker resource can only be a field resource and this resource must have only one corresponding contingent worker user. Contingent workers are automatically removed from the application, if they have not activated a route in 12 continuous months.

### Shifts

#### Add a Shift

Shifts are defined as patterns of working time. This feature is designed to help with the non-standard types of shift that do not fall within the traditional 24-hour clock. You can create separate shifts for each of the different working time patterns within your organization.

1. Click **Configuration**.
2. In the **General** section, click **Work Schedules**.
   
   The **Work Schedules** screen appears.
3. Click **Shifts**.
   
   The **Shifts** screen appears.
4. Click **Add Shift**.

   The **Add Shift** window appears.
5. Fill up the following fields:
Add an Activity to a Shift

When you add an activity to a shift, the activity is added to the calendars of all of the resources that have that shift assigned to them.

1. Click **Configuration, Work Schedules, Shifts**.
   
   The **Shifts** list displays.

2. Click the **Activities** link in the row of the shift that you want to add the activity to.

3. Click **Add Activity**.
   
   The **Add Activity** screen displays. If this activity is an internal activity, the layout of the screen changes. If it is a customer-facing activity, the layout stays the same.

4. Complete the applicable fields.
Configure Oracle Field Service Cloud

<table>
<thead>
<tr>
<th>Field name</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recurrence-Repeats-Daily</td>
<td>Apply to schedules such as every other day or every 3rd day. If you select this option, add the frequency of occurrence in the field Days between occurrences.</td>
</tr>
<tr>
<td>Recurrence-Repeats-Everyday</td>
<td>Applies to every day schedules that repeat without exception and without any modification options.</td>
</tr>
<tr>
<td>Recurrence-Repeats-Weekly</td>
<td>Apply calendars that have a regular weekly pattern. Select the days that apply to this shift using the check boxes for the individual days. Indicate the frequency of this pattern weekly by adding a value to the Weeks between occurrences field.</td>
</tr>
<tr>
<td>Recurrence-Repeats-Yearly</td>
<td>Occurs every year from the selected date entered in the From day until the date entered in the To day field.</td>
</tr>
</tbody>
</table>

5. Click OK.

View Statistical Parameters

Oracle Field Service Cloud uses collected statistical data on actual activity and travel duration for calculating a resource’s estimated time arrival for the pending activities and the delivery window. In addition, the Routing module uses the collected statistics to assign activities to a resource in the most effective manner, according to the specified routing parameters. Statistical parameters are calculated separately for each resource, group/bucket, and whole company. If the data is not enough to predict the duration or travel for a resource, then the group/bucket or company values are used. Finally, if the data is not enough at the company level, then the default values are used.

1. Click Configuration.
2. In the Subsystems and Integrations section, click Statistics.
   The Statistics screen appears.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration parameters</td>
<td></td>
</tr>
<tr>
<td>Minimum relevant duration time in minutes</td>
<td>To ensure that outlier activity durations (sometimes due to non-compliance) do not adversely affect statistical calculations, durations with values less than or more than the minutes entered in these fields will be ignored by the statistics engine.</td>
</tr>
<tr>
<td>Maximum relevant duration time in minutes</td>
<td></td>
</tr>
<tr>
<td>Lower limit for personal ratio to calculate duration (%)</td>
<td>The lower and upper limit percentages are with respect to the company level duration for an activity. If the duration estimated for a resource’s assigned activity is beyond the lower or upper limit, the estimate is corrected so that it lies within the set limits. The Lower limit default value is 50 with an available range from 0-100. The Upper limit default value is 200 with an available range from 100-999. If the preference is always to use the personal learned duration without any lower or upper limits applied, the ranges must be set for the outer extremes with the lower limit set to 0 and the upper limit set to 999. Example: Suppose the company-level estimation for an activity is 50 minutes and the lower limit percentage is set to 80%. If the estimation for a resource is 30 minutes, the final estimation for the activity will be calculated as the maximum of 30 minutes and 80% of 50 minutes, which will be 40 minutes. The lower limit would be in effect and 40 minutes would be assigned to the activity.</td>
</tr>
<tr>
<td>Upper limit for personal ratio to calculate duration (%)</td>
<td></td>
</tr>
<tr>
<td>Travel time parameters</td>
<td></td>
</tr>
<tr>
<td>Default travel average time</td>
<td>The average value and standard deviation (in minutes) used for travel time prediction when there isn’t statistical data for travel between two specific travel statistics keys.</td>
</tr>
</tbody>
</table>
Field | Description
---|---
Minimum relevant travel time in minutes | In an effort to ensure that outlier travel durations (sometimes due to non-compliance) will not adversely affect statistical calculations, durations with values less than or more than the minutes entered in these fields will be ignored by the statistics engine.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coordinate calculation weight</td>
<td>This parameter defines the weighting proportion between the statistic (average travel time) and coordinate methods (straight line/airline) of calculating/predicting travel time between two locations. The options are as follows:</td>
</tr>
<tr>
<td></td>
<td>0 = Use only travel key based estimation</td>
</tr>
<tr>
<td></td>
<td>0.001 = Prefer travel key based estimation</td>
</tr>
<tr>
<td></td>
<td>0.5 = Use both estimations evenly</td>
</tr>
<tr>
<td></td>
<td>0.999 = Prefer coordinate method based estimation</td>
</tr>
<tr>
<td></td>
<td>1 = Use only coordinate method based estimation</td>
</tr>
</tbody>
</table>

Airline distance speed | The speed used to determine airline (straight line) distance time.

Departure/parking time | The amount of time that is allowed for parking and departure from one activity to another.

Delivery Window Parameters

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery window factor</td>
<td>Determines how much deviation should affect the calculation of future delivery windows based on their ETAs.</td>
</tr>
<tr>
<td>Delivery window granularity</td>
<td>This defines the number of minutes to which delivery window values will be rounded.</td>
</tr>
<tr>
<td>Delivery window minimal size</td>
<td>When delivery window is calculated, this is the smallest value (in minutes) that will be provided.</td>
</tr>
<tr>
<td>Delivery window maximal size</td>
<td>When delivery window is calculated, this is the largest value (in minutes) that will be provided.</td>
</tr>
</tbody>
</table>
| Delivery window should not start earlier than 
 minutes prior to start of service or SLA window | Prevents the delivery window from starting outside the previously agreed service window. When the option is enabled, the statistically calculated delivery window cannot start earlier than the specified number of minutes before the service window or SLA window start. |

Stats Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity duration stats fields</td>
<td>This group represents the formation of the keys (made up of fields) used for the grouping of work duration and travel duration values to find the averages.</td>
</tr>
<tr>
<td>Activity travel stats fields</td>
<td>The user-defined activity keys make it possible to sort the collected statistical data according to various activity characteristics, such as work order type, activity properties, activity postcode, etc.</td>
</tr>
<tr>
<td>Resource travel stats fields</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** You can specify durations for specific activities and technicians through APIs. For more information, see the REST API for Oracle Field Service Cloud guide.

**Related Topics**

- How Activity Duration Is Calculated
- Pre-Calculated Travel Statistics
Update Travel Statistics

Travel statistics can be updated when the not assigned activities with default travel time are assigned to a resource. The travel time is received from Oracle Spatial and Graph Route Server which updates the travel statistics in real-time.

1. Open Configuration > Statistics.

   The Statistics page appears.

2. Set up the Default Travel Time and Minimal Statistical Travel Time to ensure there is no statistical information for the travel time between these activities.

   The setup time is applied to the activities of the bucket.

3. To assign the activities in the bucket to a resource, select the appropriate activities and click Move.

   The travel time value is received from street level route service and set up as per this value.

Themes

View Themes

You can implement custom Themes that allow customers to use their own logos as headers in the user interface or on the login page. In addition, it allows customers the ability to define a custom theme color, which appears as the header. Access to the Themes is controlled by the Themes visibility. For each user type that you want to manage Themes, set the Read/Write permissions. When the visibility is set to ReadOnly, Themes is disabled, and when no visibility has been granted, the Themes screen is not visible at all.

1. Click Configuration.

2. In the Displays section, click Themes.

   The Themes screen appears and displays the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the theme.</td>
</tr>
<tr>
<td>Default</td>
<td>Displays whether the theme is selected as the default theme. The default theme has a check mark next to it. When you click Select default, you can set whether all users or only new users will have this theme set as the default.</td>
</tr>
<tr>
<td>Active</td>
<td>Displays whether the theme is active. An active theme has a check mark next to it. The Set enable or Set disable actions determine whether the theme is active or not.</td>
</tr>
<tr>
<td>Actions</td>
<td>Displays the actions available for the Theme. The following actions are available:</td>
</tr>
<tr>
<td></td>
<td>○ Edit – Allows editing the options for the selected theme. See the Add a Theme section for an explanation of the options.</td>
</tr>
<tr>
<td></td>
<td>○ Set default - Sets this theme as the default theme. You can set whether all users or only new users will have this theme set as the default.</td>
</tr>
<tr>
<td></td>
<td>○ Set enable - Enables a currently disabled theme.</td>
</tr>
<tr>
<td></td>
<td>○ Set disable - Disables a currently enabled theme.</td>
</tr>
</tbody>
</table>
Add a Theme

You can implement custom Themes that allow customers to use their own logos as headers in the user interface or on the login page. In addition, it allows customers the ability to define a custom theme color, which appears as the header. Access to the Themes is controlled by the Themes visibility. For each user type that you want to manage Themes, set the Read/Write permissions. When the visibility is set to ReadOnly, Themes is disabled, and when no visibility has been granted, the Themes screen is not visible at all.

1. Click **Configuration**.
2. In the **Displays** section, click **Themes**.
   The **Themes** screen appears.
3. Click **Add new**.
   The **Add theme** window appears.
4. Complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the theme.</td>
</tr>
<tr>
<td>Color Theme</td>
<td>Displays the hexadecimal code for the theme’s color. Clicking this field displays a color picker. Either enter the hexadecimal code for the color to be used for this theme, or select a color using the color picker.</td>
</tr>
<tr>
<td>Title Page</td>
<td>The HTML Title tag for this theme. For example: <a href="https://demo2.etadirect.oracle.com">https://demo2.etadirect.oracle.com</a></td>
</tr>
<tr>
<td>Copyright</td>
<td>Copyright information. The text should contain placeholders for {YEAR} and {VERSION} that will be automatically replaced to current year and major version. Example: © 2003-{YEAR} Oracle Corporation. All rights reserved. Version {VERSION}. The maximum length of this string is 255 characters.</td>
</tr>
<tr>
<td>Big (logo)</td>
<td>Select the logo in .png format. This logo is used with screens of width 1024 and more, or between 320 and 768.</td>
</tr>
<tr>
<td>Small (logo)</td>
<td>Select the logo in .png format. This logo is used in other cases within Core Manage and Mobility.</td>
</tr>
<tr>
<td>Login (logo)</td>
<td>Select the logo in .png format. This logo is used in the login portal.</td>
</tr>
</tbody>
</table>
Add a Travel Area

Travel areas define the maximum allowed travel territory for a company and can contain groupings of work zones. Typically, companies have at least one high-level travel area listed.

1. Click Configuration.
2. In the General section, click Work Zones.
3. Click Travel Areas.
   The Travel Areas screen appears.
4. Click Add travel area.
   The Add travel area pop-up window appears.
5. Fill up the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the travel area.</td>
</tr>
<tr>
<td>Label</td>
<td>Your company specific unique identifier for the area.</td>
</tr>
</tbody>
</table>

6. Click OK.
   The Travel Areas screen appears.

Custom Forms

From a business perspective, Forms are paper documents that Field Resources fill in, while performing their work. From Oracle Field Service Cloud perspective, a Form is a pre-configured screen that can be configured using data elements that exist only in the context of a Form.

Features of Forms:

- Administrators may create as many Forms as needed for the business.
- Forms are not User Type specific; they are independent screens that are connected to User Types screens through links that are configured on context layouts.
- After the Form is configured, all users see the same Form and capture the same data regardless of their User Type.
- The Form Field data elements, which can be added to forms are not associated or “bound” to a specific field or custom property.
- Forms are available only in Core Application, iOS and Android apps; they are not available in the Legacy Manage application.
- Contents of a submitted Form cannot be changed, even if a related entity or Form configuration changes later.
- When a Form is submitted, all Form field elements, except those that have auto-calculated default values or values filled through predefined parameters are blank.
- Forms do not support links to any types of screens such as standard actions, plug-ins, or other forms.
Forms are represented in three ways in Oracle Field Service Cloud:

- A configuration screen where all the required elements are added.
- A screen on a mobile device or a computer where technicians and dispatchers fill in data.
- A submitted Form result that represents every sample of the completed Form. These results are available to users on separate screens and can be retrieved through APIs.

Provide Access to the Forms & Plugins Screen

Users with access to the Forms & Plugins screen can add and modify custom Forms and plug-ins.

1. Click **Configuration > User Types**.
2. Select the type of user for which you want to provide access.
3. Go to the **Screen configuration** tab.
4. In the **Main menu** tree, click **Configuration**.
5. Click **Click to Add** and select the **Forms & Plugins** check box.
6. Click **OK**.
7. Click **Forms & Plugins** and then click **Add new visibility**.
8. Select **Read-write** and click **Save**.
9. Click **Close**.

All the users of the selected User Type now have access to the **Forms & Plugins** screen.

How a Form is Configured

Here are the high-level steps to configure a Form.

1. Create the Form.
2. Configure the Form elements.
3. Add the Form to a screen.

Create a Form

You create a Form so that Field Resources can fill it to capture statutory or business data required for an activity.

1. Click **Configuration > Forms & Plugins**.
2. Click **Add Form**.
   - The Add Form screen appears.
3. In the **English** field, add a name for the Form in English.
4. Add the names in other required languages.
5. In the **Label** field, add a label for the Form.
6. Click **OK**.
   - The Form is saved. The next step is to add elements to the Form.
Configure the Form Elements

After you create a Form, you must add elements to it. Form elements are the fields in which a Field Resource can display and capture the required data.

1. Click Configuration > Forms & Plugins.
2. Click the stack icon and click Modify content for the Form that you want to edit.

   The Visual Form Editor screen appears. Another way to open this screen is when you add the Form to a screen. If you are configuring a screen and there is a button that is configured to open a Form, then you can use the Modify Form content option. In this case, a new editor session is opened with the specified Form content. Ensure that you have saved all the changes to the screen configuration before you click Modify Form content.
3. Drag and drop the element that you want to add to the Form. For example, add a section, a text box, a check box, or a file element.

   Here are some special elements that you can add:
   - Form Field: Adds a field such as text box, list, check box and so on, to the Form. This type of fields exist on the Form only for presenting and gathering information. The data entered in Form fields will only be captured in a screen shot of the Form when the Form is Submitted. This data is not stored in the application. However, data for other fields and properties is captured as normal.
   - Barcode/QR Scanner: Adds an icon to the Form, using which users can scan a barcode or a QR code. The embedded scanning functionality (that is, camera) on the resource’s mobile device is used to scan the code. The results of the scan is populated automatically in the associated field. This option is available as part of the Input element. Before using the scan option, users must ensure that the Android and iOS app that is installed on their devices has access to the device’s camera. In Core Application, Barcode/QR scanner is displayed as a text box.
   - Date and Time: Adds a date, time, or date and time field to the Form. The format of data in ‘Date/Time’ pickers is controlled by user settings. Specifically ‘Time’ (sudate_fid) and ‘Date’ (sudate_fid) user fields. The data captured from ‘Date’, ‘Time’, and ‘DateTime’ components is stored and exposed through the ‘formSubmitted’ event of Events API in a predefined format. The formats are:
     - yyyy-mm-dd for ‘Date’
     - HH:mm for ‘Time’
     - yyyy-mm-dd HH:mm for ‘DateTime’

   Integrators must convert data into other formats, if required.
   - Hidden value: Adds a field to:
     - Include calculated values, which are not required to be displayed when the Form is filled.
     - Include pre-populated values by open parameters. The values for these parameters are configured on the Form button. When the user opens the Form, these values are populated on the Form.
     - Use in other expressions, whose values will be included into the submitted Form data with the values of all other Form elements.

4. In the Data binding section, bind the elements to appropriate entities and fields:
   a. Click the pencil icon.
      The Bind visual element to data source screen appears.
   b. Click the drop-down list and select the entity that defines the data source.
   c. In the Data field list, select the specific field, which you want to associate with the selected element.
      If the Show only fields appropriate for element type check box is selected, only the fields that are appropriate for the selected entity and the element type are displayed. If the check box is not selected and you select a different type of field, the element type is changed accordingly. For example, if your element type is Date and Time and you select Activity ID [aid], then the element type is changed to Input field.
d. Click **OK**.

5. In the **Visibility** section, configure the visibility settings.
   a. To change the visibility, click **Add new**. In the **Access mode** section, select the required visibility.
   b. If you want to add any conditions to make the element visible, click the plus icon.
   c. Add the required condition and click **Save**.

   The visibility is Read-write (RW) by default.

6. In the **Translations** section, add the labels for the field in the required languages.

   The application adds a label by default and you can change it here. You can use this label in default expressions and in the visibility conditions of other Form items. Further, you can use this label to refer to the submitted values in APIs.

   Here is the screen that shows Form elements:

   ![Visual Form Editor > Survey](image)

7. Click **Save** on the **Visual Form Editor** screen.

   The Form elements are saved. The next step is to add the Form to a context layout through a User Type screen configuration.

---

**Where Can Forms Be Used**

You can open Forms from the following screens:

- Activity details and Inventory details: You can open Forms from the links in the action bar and buttons inside the content.
- Activity list, Inventory list, Forms history, User options, Print route: You can call Forms from the links in the action bar.
- Dispatch console: You can open Forms from the links on the activity hint.
- Screens containing resource tree: You can call Forms from the links on the resource hint.
- Time view, List view: You can add Forms to the action menu.

Forms relate to the entities from which they are opened and submitted. In other words, if a Form is submitted in the context of an activity, then it remains connected to the activity. Users can view Form submission results from this specific activity. The same idea applies to inventory and resources contexts.
Add the Form to a Screen

You add a Form to a context layout screen, so that Field Resources can open and fill it.

1. Click Configuration > User Types.
2. Select the type of user for which you want to add the Form.
3. Click Screen configuration.
4. Find and click the screen to which you want to add the Form.
   The Visual Form Editor screen appears.
5. Drag-and-drop the Button element to the section from where you want to invoke the Form.
6. Click the button.
7. In the Standard action screen field, click the pencil icon and then select Custom Forms.
8. In the Screens list, select the name of the Form that you want to open and click OK.
   The label of the Form is displayed in the Custom Forms field, as shown in the following figure:

By default all Forms have a visibility of Read-only.

9. In the Visibility section, add the conditions based on which the Form is visible.
10. In the Parameters section, add the values that you want the Form to be populated with:
     a. Click Add new.
        The Add parameter screen appears.
     b. Click Entity and select Form data.
        The Hidden value, Date, Time, and Date and Time elements added to the Form appear in the Field name list.
     c. Select an element in the Field name list.
     d. In the Value field, add the value that you want to be populated for the element.
        For example, let’s say you have a field by name City and you want to populate it with New York. Select City in the Filed name list and enter New York in the Value field. Whenever a Field Resource opens the Form, New York is populated for City. In another example, let’s say you want to populate today’s date in a Date field.
Select the Date field in the **Filed name** list and enter ‘today’ in the **Value** field. Whenever a Field Resource opens the Form, today’s date is displayed. Similarly, enter ‘current time’ in the **Value** field to display the current time in the **Time** field.

e. Click **Save**.

11. In the **Translations** section, add a name for the Form.
   This name is displayed on the screen from which the Form will be invoked.

12. Click **Save** on the **Visual Form Editor** screen. The Form is added to the selected screen.

---

### Call a Form From a Button or Link

Apart from adding a link to a Form on a screen, you can add a link to open a Form from read-only screens such as the activity hint. This serves as a short cut to open the Form.

1. Follow the procedure described in the Add the Form to a Screen topic.

   ✷ **Note:** You can configure the fields in the Form to populate values when Field Resources open the Form.
   - You use the **Parameters** section of the **Button configuration** screen to pass the values that need to be populated. Further, using the **Parameters** section, you can also configure all the entities to populate values, although they are not present on the Form explicitly.

---

### View Form Submission Results

The Forms history screen (Formerly ‘Requests history’) collects all the Form submission results. The Forms history screen for an activity gives all the Form submissions for the activity. The Forms history screen for an inventory item provides all the Forms submitted for an inventory item. Similarly, Forms history available from the Activity list and User options provides a list of Form submission results for a specific resource.

1. Click **Forms history** for an activity, an inventory, or a resource.
2. Click any record.

   The specific form is displayed with the values that were entered at the time of submission.
   - When a Form is submitted, the application stores a snapshot of the values that were entered. The snapshot data remains unchanged even if the corresponding entities and fields change later. In addition, except for the auto-calculated default values or values filled through predefined parameters, the remaining field values are erased. Further, every time a Form is submitted, a formSubmitted type of event is created. You can retrieve the details of individual submissions by subscribing to this event. See the REST API guide for more information.

---

### Lifecycle of a Form

From the time a user opens a Form on a mobile device to the time a Dispatcher views its submission results, a Form is viewed and processed in different ways.

The lifecycle of a Form is as described here:

- A user opens a Form on a device.
  - All Form field elements, except those that have auto-calculated default values or values filled through predefined parameters are blank.
Form elements bound to fields and properties inherit their values.

- The user fills in data and submits the Form.
- Data is stored:
  - All submitted data is stored as a Form snapshot.
  - Values of fields and properties bound to screen elements are populated and saved separately.
- Data is available to customers:
  - On the user interface.
  - In an event of Events API.
  - As a Service request, if conditions match.
- User goes to step 1 if there is a need to fill the Form again.
  - All Form field elements, except those that have auto-calculated default values or values filled through predefined parameters are blank.
  - Form elements bound to fields and properties inherit actual values.

**Export and Import Forms**

You export the contents of a Form, so that you can import it and create a similar Form.

1. Click **Configuration > Forms & Plugins**.
2. Find the Form that you want to export.
3. Click the stack icon and then click **Export**.
4. Click **Save** and save the file the required location.
   The Form is saved in .json format.
5. To import a Form:
   a. Click **Add Form** and add the Form details.
   b. Click the stack icon and then click **Import**.
   c. On the **Import form content** dialog, click **Browse** and select a .json file.
      The file is validated and the contents of the Form are saved.

**Integrate with Other Applications**

Your organization may have different software applications to take care of different business aspects. You can integrate those applications so that when an event occurs in one application, the appropriate changes are performed automatically in the other application. You can integrate applications in two ways: through Integration Cloud Service (ICS) and through REST APIs.

**Integrating using ICS**

When you use ICS, you create an integration point in Oracle Field Service Cloud. When an event occurs in Oracle Field Service Cloud, it is sent to the appropriate application through ICS. For example, a company in the manufacturing sector
may have an ERP application to take care of their stocks. The company can integrate the ERP application with Oracle Field Service Cloud, so that when a field technician installs or deinstalls an equipment, the stock is updated in both, Oracle Field Service Cloud and the ERP application.

Integrating using REST APIs

Use REST APIs to integrate third-party applications such as mobile apps. To let a mobile app access REST APIs on behalf of a user, you use the OAuth 2.0 authentication. To use OAuth 2.0 authentication, you must register the client application with Oracle Field Service Cloud. Then, your client application requests an access token from Oracle Field Service Cloud or other external token service providers such as, Oracle Identity Cloud Service. The client application then sends the token to the API that you want to access.

Integrate with ICS

Your organization may have different software applications to take care of different business aspects. You can integrate those applications so that when an event occurs in one application, the appropriate changes are performed automatically in the other application. For example, a company in the manufacturing sector may have an ERP application to take care of their stocks. The company can integrate the ERP application with Oracle Field Service Cloud, so that when a field technician installs or deinstalls an equipment, the stock is updated in both, Oracle Field Service Cloud and the ERP application. One of the ways with which you can integrate the applications is through Integration Cloud Service (ICS). When you use ICS, you create an integration point in Oracle Field Service Cloud. When an event occurs in Oracle Field Service Cloud, it is sent to the appropriate application through ICS.

เทรด Note: Configure this integration only if you want to send events or data from Oracle Field Service Cloud to ICS.

1. Log in to Oracle Field Service Cloud.
2. Click **Configuration > Integration Cloud Service (ICS)**.
   The **Integration Cloud Service (ICS)** screen appears.
3. To add a new integration, follow these steps:
   a. Click **Add new**.
      The **Add Integration Cloud Service (ICS) Access** dialog opens.
   b. Add a name or description for the application for which you are creating the integration in the **End Point Label** field.
      If you are using multiple instances of an application, such as Production and Testing, you can create multiple access points for the application.
   c. Add the host name of the application for which you are creating the integration in the **ICS Domain** field.
      For example, if the URL is “https://integration-a12345.integration.us2.oraclecloud.com/integration/flowsvc/ofsccloudadapter/NAME/v01/“ then ICS Domain is: “integration-a12345.integration.us2.oraclecloud.com”.
   d. Add the user name of the ICS user in the **ICS Username** field.
      This user must exist in ICS and have permissions to access the integration endpoint.
   e. Add the password for the user name in the **ICS Password** and **Confirm Password** fields.
      The user name and the password are used to authenticate with ICS when Oracle Field Service Cloud starts sending events to ICS.
   f. Click Add.
      The integration details appear on the **Integration Cloud Service (ICS)** screen. Next, you must log in to ICS to add the connection details and map the required fields.
4. To modify an integration, follow these steps:
   a. On the **Integration Cloud Service (ICS)** screen, click **Modify** for the end-point that you want to modify.
      The **Edit Integration Cloud Service (ICS) Access** dialog opens.
b. Edit the fields as required. You can edit all the fields, except for **ICS Domain**.

c. Click **Submit**.

5. To delete an integration, on the **Integration Cloud Service (ICS)** screen, click **Delete**. The application stops sending events and updates to ICS.

### Integrate with REST APIs

Oracle Field Service Cloud supports OAuth 2.0 authentication for API access. Use OAuth 2.0 authentication to let third-party applications such as a mobile app access REST APIs on behalf of a user. To use OAuth 2.0 authentication, you must register the client application with Oracle Field Service Cloud. Then, your client application requests an access token from Oracle Field Service Cloud or other external token service providers such as, Oracle Identity Cloud Service. The client application then sends the token to the API that you want to access.

Oracle Field Service Cloud supports the following types of token service:

- **OFSC Token Service**: The client application uses Oracle Field Service Token service to obtain an OAuth2 access token and authenticate with the APIs. OFSC token service supports two types of authentication:
  - **Client Credentials**: Authentication using client credentials is primarily used for back-end to back-end integration. For example, an application that requires pushing data to Oracle Field Service Cloud.
  - **JWT Assertion**: JWT assertion authentication can be used for back-end to back-end integration or for mobile applications. The Access Token generated using assertion flow may include the user identity, and Oracle Field Service Cloud performs actions as that user. The advantage of using assertion flow is that user’s password is not shared with Oracle Field Service Cloud. When you use this type of authentication, the public key of the third-party application is imported into the Application entity and the third-party application can make API calls using its private key.

- **External Token Service**: The client application uses an external token service such as Oracle Identity Cloud Service to obtain an OAuth 2.0 access token and authenticate with the APIs.

- **Oracle Identity Cloud Service**: The client application uses **Oracle Identity Cloud Service** to obtain an OAuth 2.0 access token and authenticate with the REST APIs. You can upload the signing certificate for Oracle Identity Cloud Service and then configure Oracle Identity Cloud Service to issue **OAuth2 Access Tokens**. See the Oracle Identity Cloud Service documentation for information about where to get the signing certificate: [https://docs.oracle.com/en/cloud/paas/identity-cloud/index.html](https://docs.oracle.com/en/cloud/paas/identity-cloud/index.html).

Use the following details to configure Oracle Identity Cloud Service:

- **Primary audience**: `<your Oracle Field Service Cloud instance name>`. For example, `ofsc-x1111`
- **Scope**: The scope name must begin with a slash (`/`), followed by the application ID that you created in Oracle Field Service Cloud. For example, if the application ID is `new_app` then the Scope is `/new_app`.

After filling in these details, note down the **client_id** and **client_secret** of the application.

Integrating applications using REST APIs includes the following steps:

1. Register the OAuth client application.
2. Configure the authentication.
3. Enable access to specific APIs for your application.

For more information about calling REST APIs from third-party applications, see the REST API for Field Service Cloud guide.
Create an Application

If you want to call REST or SOAP APIs from a third-party application, you must register the third-party application by adding it on the Application screen in Oracle Field Service Cloud.

1. Click Configuration > Applications.
   The Applications screen appears.
2. Click the plus icon, add the following details, and then click Submit:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Name</td>
<td>Name of the third-party application that you want to register.</td>
</tr>
<tr>
<td>Application ID</td>
<td>A unique ID of the application.</td>
</tr>
</tbody>
</table>

3. On the Applications screen, click the application that you want to register on the left pane and complete the following fields:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application general info section</td>
<td></td>
</tr>
<tr>
<td>Application Name</td>
<td>Name of the third-party application that you want to register. This field is populated automatically.</td>
</tr>
<tr>
<td>Application ID</td>
<td>A unique ID for the application. This field is populated automatically.</td>
</tr>
<tr>
<td>Active</td>
<td>Status of the Application. Inactive Applications do not authenticate or authorize anyone. When you make an active Application inactive, previously-issued access tokens do not work.</td>
</tr>
<tr>
<td>Token Service</td>
<td>Type of token service or identity provider the Application uses. Default is OFSC.</td>
</tr>
</tbody>
</table>

4. Select the authentication service using the following fields:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication settings section</td>
<td></td>
</tr>
<tr>
<td>Authenticate using Client ID/Client Secret</td>
<td>Select this check box to authenticate the application using client ID and client secret. Click Show Client ID/Client secret to view the client ID and client secret.</td>
</tr>
<tr>
<td>Client ID</td>
<td>The client ID for the third-party application. This ID is automatically generated.</td>
</tr>
<tr>
<td>Client Secret/Show Secret</td>
<td>The client secret for the third-party application. This information is automatically generated.</td>
</tr>
<tr>
<td>Authenticate using JWT assertion</td>
<td>Select this check box to authenticate the application using JWT assertion.</td>
</tr>
<tr>
<td>Authenticate using external access token</td>
<td>Select this check box to authenticate the application using an external access token. This field is displayed if you select External for Token service.</td>
</tr>
<tr>
<td>Client Certificate/Upload</td>
<td>The certificate signed by the private key of the Application. If this is absent, you cannot use OAuth2 JWT Assertion authentication. Click Upload to upload the certificate.</td>
</tr>
</tbody>
</table>

5. Select specific APIs for your application using the following fields:
Field name | Description
---|---
API Access section
Add new | Click to add new APIs. The **Add API access** dialog appears. Select the APIs you want to add and click **Submit**.
Available methods | The list of the API methods available for the corresponding API. Click the menu to modify the fields or methods and to remove access to the API.
Available entities | The list of entities that the users of the current Application have access to. This option is available only for Core API and Metadata API fields.
Available resource fields/ Available activity fields/ Available inventory fields/ Available service requests fields/ Available user fields | The list of the fields available for the corresponding API. Clicking this opens the layout structure screen, where you can select the fields that the users of the current Application will be able to use to set or update using the API. This screen functions as a context layout structure screen where the fields and their visibilities are set.
Remove access | Removes access to this API. Users that have access to this Application cannot use the corresponding APIs anymore.

6. Add any access restrictions using the following fields:

Field name | Description
---|---
Additional restrictions section:
Visible resources | The resources that are visible to the Application. The Application performs actions only on the resource tree nodes that are included in this setting. If no resources are specified, the Application has access to entire resource tree. Click the pencil icon to select the resources that are visible to this Application.
Allow access only for certain IP addresses | The IP addresses that can access the current application. Add the IP address in the box.
Allow Cross-origin resource sharing (CORS) from the following web domains | The white-list of domains from which you can make AJAX requests to Oracle Field Service Cloud REST API. Enter each domain name on a separate line. The following rules apply:
- The maximum length of a domain names is 253 characters.
- The maximum number of domain names you can add is 100.
- No leading or trailing white space must be present in a domain name.
- Wildcards or special characters are not supported.
- A single asterisk "*" indicates that all domains are allowed.
- Domain names that are added or modified take a few minutes to be populated across the application.

The following table describes how the **Visible resources** field works:

<table>
<thead>
<tr>
<th>Visibility restrictions</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empty</td>
<td>When a user is authenticated on behalf of this Application, their location in the resource tree is used for visibility restrictions. The Application cannot authorize itself, it can only authorize users.</td>
</tr>
<tr>
<td>Present</td>
<td>When a user is authenticated on behalf of this Application, an intersection (not union) of their location in the resource tree and the application visibility restrictions are used for visibility restrictions.</td>
</tr>
</tbody>
</table>
Activity Booking

When a technician performs an activity at the customer’s premises, the customer may enquire about the possibility to perform another job for them on a different day. The technician must be able to collect the information about the new job, create an activity, and schedule it right away. To book an activity, the technician must also have the ability to check the available capacity for that specific date and time. This situation is handled by the Activity Booking option in Mobility. You must configure the activity booking context properly to get the most accurate and precise capacity calculation. The Book new activity option is configured in the Mobility section of the Screen Configuration screen.

Accessed via the Mobility application, the feature of allows a user to create an activity in a specified capacity bucket and time slot, which will be then routed on a general basis. To be able to book an activity, the quota must be available in the selected capacity bucket on the selected date and time slot for a specific capacity category. As soon as the activity is booked, the capacity required for its performance is subtracted from the available capacity and added to the used capacity. The used capacity is compared to the quota values to make sure that orders for new activities are accepted only when the capacity is still available. As having capacity information up-to-date is crucial for the functionality, Activity Booking is available only in the online mode.

Create a Layout for Booking an Activity

Use the Book new activity option in the Mobility section of the Screen Configuration screen to create a layout for booking an activity.

1. Click Configuration > User Types.
2. Select the user type for which you want to add a layout for booking a new activity.
3. In the Access settings section of the General tab, select the Allow access via Mobility check box.
4. Expand the Mobility section and click Book new activity.
   The Visual Form Editor opens.
5. Drag-and-drop the fields that you want on the Book new activity screen.
   You must have Activity type (aworktype) field. However, you cannot add file type of fields or properties, tabs, and the Time slot field.
6. Select the visibility settings for all the fields.
7. Click Submit.
   The layout is saved.

Activity Type Constraints

The activity booking function applies a number of constraints on certain activity types.

Some activity types determine whether at all an activity can be booked, while others affect the configuration of different properties on the context. The list of activity types is available in the Activity Types screen. Click Configuration > Activity Types to access the Activity Types screen. Describe only those activity type constraints and conditions that apply equally to all the activity types that you want to be available for booking.
Time Slot Support

You must enable the Support of time slots option for each activity type that is to be considered for booking.

To select this option, click Configuration > Activity Types. On the Activity Types screen, select the type of activity that you want to be considered for booking. Open the activity, select Support of time slots, and click Update.

Calculate Travel

If you enable the Calculate travel feature for the activities to be booked, then the capacity calculation will additionally consider all fields and properties in the Activity travel stats fields.

To select the Calculate travel feature, click Configuration > Activity Types. On the Activity Types screen, open the activity type for which you want to add the feature. Select the Calculate travel check box and click Update. When you select this feature, you must add all the fields that you have selected for the Activity travel stats fields in the Statistics screen to the Book new activity context layout and set the visibility as Mandatory.

Calculate Activity Duration

If you enable the Calculate activity duration using statistics feature for the activities to be booked, then the capacity calculation will additionally consider all fields and properties in the Activity duration stats fields.

To select the Calculate activity duration using statistics feature, click Configuration > Activity Types. On the Activity Types screen, open the activity type for which you want to add the feature. Select the Calculate activity duration using statistics check box and click Update. When you select this feature, you must add all the fields that you have selected for the Activity duration stats fields field in the Statistics screen to the Book new activity context layout and set the visibility as Mandatory.

Enable Work Zone Support

You must enable work zone support for booking activities. If you have enabled work zones support, at both, the company level and the activity level for the corresponding activity types, all fields from the work zone key are considered for capacity calculation.

To enable work zone support at the company level, click Configuration > Business Rules. Select Work Zone support in the General section. To select this option at the activity level, click Configuration > Activity Types. On the Activity Types screen, select the type of activity that you want to be considered for booking. Open the activity, select Support of work zones, and click Update. Click Configuration > Work Zones and note down the field selected for Work Zone Key. Add this field with a Mandatory visibility in the Book new activity context layout.
Enable Work Skill Support

You must enable work skill support for booking activities. If you have enabled work skill support, at both, the company level and the activity level for the corresponding activity types, all fields from the work skill conditions are considered for capacity calculation.

To enable work skill support at the company level, click **Configuration > Business Rules**. Select **Work Skill support** in the **General** section. To select this option at the activity level, click **Configuration > Activity Types**. On the **Activity Types** screen, select the type of activity that you want to be considered for booking. Open the activity, select **Support of work skills**, and click **Update**. Click **Configuration > Work Skills** and click **Work skill conditions**. Open the work skill that you want to be considered for booking and note down the work skill conditions. Add these field with a Mandatory visibility in the Book new activity context layout.

Time Slot Screen Configuration

The **Schedule booked activity** context defines the layout of the **Time Slot** screen. While the time slot selection widget is pre-configured and cannot be changed, all other details of the booked activity can be specified in the **Schedule booked activity** context.

The following restrictions apply to the context configuration:

- You can add only read-only visibility condition for activities or properties on the context layout.
- You cannot create tabs in the Schedule booked activity context.

Otherwise, there are no special constraints, as opposed to the **Book new activity** context. The Schedule booked activity context is available in the **Mobility** section of the **Screen Configuration** screen.

Activity Booking Error Messages

This section provides the list of possible errors and the corresponding messages the user may encounter while booking activities.

**Missing Context Error**

If at least one of the two contexts (‘Book new activity’, ‘Schedule booked activity’) is not added before using the Activity Booking functionality, the message: Form is misconfigured. Context layout missing appears. Depending on which context is missing, the error is shown so, you can access the corresponding screens.

**Validation Errors**

If any of the mandatory fields is empty on the booking activity contexts (‘Book new activity’, ‘Schedule booked activity’), the validation message, Validation failed, please review your form is shown. If a time slot has not been selected on the **Time Slot** screen, the activity is not booked and the message, Validation failed, please review your form. Time slot is not selected is displayed.
Capacity Calculation Errors

Capacity is not calculated in the following cases:

- Data entered in the previous step (creating booked activity) is insufficient.
- A configuration has not been properly performed.
- There is no available capacity that matches with the activity parameters.

The possible error messages that may occur at the capacity calculation stage, that is after submitting information entered in the booking activity form are as follows:

- Work skills support is disabled at the company level.
- Work skills are not supported by this type of activity.
- Capacity category cannot be determined using the given activity fields.
- The selected activity type is inactive.
- Work zone cannot be determined by the given activity fields.
- Field or property that is required for work zone 'location' value calculation is missing.
- Time slots are not supported by this type of activity.
- Field or property that is required for the duration estimation is missing.
- Field or property required for travel estimation is missing.
- The matching buckets found do not have the required quota for booking this activity.
- Unable to find appropriate quota bucket for this activity.

User Types

Use user types to manage permissions and restrictions for all users. You can create user types for your business that correspond to your existing business roles. Each user type has a profile that defines security and display permissions, such as the user’s login method, the ability to use certain functions, and access to menu items and properties. They may also include custom screen context layouts.

You assign each user exactly one user type. You can add or change user types at any time, and delete those which are no longer needed. You can also copy existing user type configurations to make new ones. This makes it easy to create multiple user types that share similar configuration settings.

For each screen or function that you want to make available for a given user type, you set the visibility to **Read-only** or **Read-write**. If you do not define a visibility value, that screen or function is hidden for that user type. Access to a screen or tab automatically includes access to the actions on that screen.

User-Type Settings

A new user type has to be configured according to its business role. Similarly, alterations of a business role may require modifications of the corresponding user-type settings.

Changes to a user type assigned to Oracle Field Service Core Manage Cloud Service users are applied shortly after they are saved on the **User Types** screen. Changes to a user type assigned to Oracle Field Service Mobility Cloud Service users are applied after the next synchronization.
User-type settings fall into the following four categories, which appear as tabs:

- **General**
  These basic settings define the user-type options with respect to resource types and other users, as well as the user-type access to the system and to its functions.

- **Screen configuration**
  These settings define the screens, windows, pop-up windows and other elements visible to a certain user type and supports the context layout editor where the content, arrangement and visibilities of each context are set.

- **Restrictions and Filters**
  These settings define the restrictions on the activities and fields that are visible to the users of the current type.

### General Tab Settings

The following table describes the fields available on the **General** tab:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Type Info</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td>A unique identifier of the user type.</td>
<td>Required. No spaces are allowed.</td>
</tr>
<tr>
<td>Name</td>
<td>A user-friendly name that describes the user type.</td>
<td>Required. Spaces are allowed.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates whether the user type is active.</td>
<td>Activating a user type simply makes it assignable to users. Inactive user types still apply to users that are assigned to them.</td>
</tr>
<tr>
<td><strong>Login Policy</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assigned resource types</td>
<td>Shows the resource types available for this user type.</td>
<td>To change the assigned resource types, click the pencil icon. You cannot remove a resource type if any users are currently assigned to this user type.</td>
</tr>
<tr>
<td>Can create users of the following user types</td>
<td>Lists the user types that this user type can create.</td>
<td>Inactive user types are greyed out and cannot be created by this user type. Permission to create user types is reciprocal. For example, if user type Manager can create user type Dispatcher, user type Dispatcher can create user type Manager. To change the user types this user type can create, click the pencil icon.</td>
</tr>
<tr>
<td>Can be created by users of following user types</td>
<td>Lists the user types that can create the current user type.</td>
<td>Inactive user types are greyed out. Permission to create user types is reciprocal. For example, if user type Manager can create user type Dispatcher, user type Dispatcher can create user type Manager.</td>
</tr>
</tbody>
</table>
## Configure Oracle Field Service Cloud

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow access to web application</td>
<td>When enabled, users of the current type can use the unified Core Application to manage dispatch operations.</td>
<td>This functionality is deprecated and is not recommended for new implementations.</td>
</tr>
<tr>
<td>Use Legacy Manage for Dispatch operations</td>
<td>When enabled, users of the current type can use the legacy <em>Manage</em> and Mobility interfaces, as it used to be in the earlier versions. However, even those users will be presented with the unified login screen.</td>
<td><strong>Note:</strong> If you have cleared the previous check box and want to clear this check box as well, ensure that you have configured the Configuration screen for Mobility and the User Types screen for any other User Type. If you have not configured these screens, you cannot get back the access to Legacy Manage.</td>
</tr>
<tr>
<td>Allow legacy access via API using user login and password.</td>
<td>When enabled, users of the current type can use the system via APIs. This option is used for backward compatibility only. New customers must configure the access using application credentials.</td>
<td></td>
</tr>
<tr>
<td>Allow access via installed application for Android</td>
<td>When enabled, users can access the application through the Oracle Field Service Cloud Mobile for Android application.</td>
<td></td>
</tr>
<tr>
<td>Allow access via installed application for iOS</td>
<td>When enabled, users can access the application through the Oracle Field Service Cloud Mobile for iOS application.</td>
<td></td>
</tr>
<tr>
<td>API access permissions are configured using selected application</td>
<td>Select the Application that provides API permissions to the users of the selected user type.</td>
<td>Create an Application and configure API permissions in the Applications screen.</td>
</tr>
</tbody>
</table>

### Permissions

<table>
<thead>
<tr>
<th>Maps</th>
<th>When enabled, the user can access the Map View on the <em>Activities</em>, <em>Quota</em>, and <em>Resource Work Zones</em> screens.</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Use real-time traffic data</td>
<td>When enabled, the check box, <em>Show Traffic</em> is shown on the Map view. Users can select the <em>Show Traffic</em> check box to view the current traffic data in the selected route.</td>
<td>This option is not available for Contingent Workers (set as ‘Resource is a Contingent Worker’ parameter in Manage, under Configuration, and Resource Types). The real-time update is available to users of Oracle Field Service Enterprise Cloud when Oracle Field Service Standard Map Cloud Service with Google Maps or Baidu Maps is part of your subscription.</td>
</tr>
<tr>
<td>Enable GPS Telemetry</td>
<td>When enabled, the user’s geopositioning information can be collected directly from the user’s device.</td>
<td></td>
</tr>
<tr>
<td>Allow access to required inventory</td>
<td>When enabled, the Mobility user is able to access the Required inventory functionality and perform all related actions.</td>
<td>The <strong>Required Inventory</strong> permission for Manage is implemented as visibility for the Required Inventory tab in the Add activity or Activity details context.</td>
</tr>
<tr>
<td>Enable Smart Location alerts</td>
<td>When enabled, the user can receive alerts on their mobile device whenever any compliance</td>
<td></td>
</tr>
</tbody>
</table>

---

**Note:** For backward compatibility, the *Manage* and *Mobility* interfaces are still available, but they will be deprecated in future releases. New customers should configure the access using application credentials instead.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parts Catalog</td>
<td>When enabled, the user can search for particular spare parts in the catalog using the standard search function.</td>
<td></td>
</tr>
<tr>
<td>Collaboration</td>
<td>Select the check box to view the collaboration settings.</td>
<td></td>
</tr>
<tr>
<td>Allow inventory move via chat</td>
<td>In addition to chat functions, allows the user to transfer inventory via chat.</td>
<td></td>
</tr>
<tr>
<td>Allow image sharing via chat</td>
<td>In addition to chat functions, allows the user to share images via chat.</td>
<td></td>
</tr>
<tr>
<td>Allow activity move via chat</td>
<td>In addition to chat functions, allows the user to transfer activities via chat.</td>
<td></td>
</tr>
<tr>
<td>Activity Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow activity move between resources</td>
<td>When enabled, the user can move an activity from one resource to another</td>
<td></td>
</tr>
<tr>
<td>Allow activity move from non-scheduled pool to scheduled one</td>
<td>When enabled, the user can convert a non-scheduled activity to one that is scheduled.</td>
<td></td>
</tr>
<tr>
<td>Allow access to non-scheduled pool</td>
<td>When enabled, the user can access the pool of non-scheduled activities and perform actions to them.</td>
<td></td>
</tr>
<tr>
<td>Allow activity reorder inside the route</td>
<td>When enabled, the user can change the position of an activity in the route.</td>
<td></td>
</tr>
<tr>
<td>Allow activity reschedule/move to non-scheduled pool</td>
<td>When enabled, the user can move an activity to a different date or make it non-scheduled.</td>
<td></td>
</tr>
<tr>
<td>Allow activity deletion</td>
<td>When enabled, the user can delete an activity together with canceling it. Otherwise, a canceled activity remains in the system.</td>
<td></td>
</tr>
<tr>
<td>Ignore work zones/work skills mismatch on activity move</td>
<td>When enabled, the user can move activities to resources with work zones and/or work skills not matching those of the activity.</td>
<td></td>
</tr>
<tr>
<td>Allow repeating/mass activity creation</td>
<td>When enabled, the user can create mass and repeating activities.</td>
<td></td>
</tr>
<tr>
<td>Allow action time adjustment in legacy Manage</td>
<td>When enabled, the user can manually adjust the time of activity actions in the legacy Manage application. Otherwise, the action time is logged as the current time.</td>
<td></td>
</tr>
<tr>
<td>Display the remaining Activity Time</td>
<td>When enabled, the activity work progress countdown is displayed.</td>
<td></td>
</tr>
<tr>
<td>Allow next activity selection on Complete</td>
<td>When enabled, the user completing an activity can select the next activity to start. Otherwise, only the next activity in the route can be started.</td>
<td></td>
</tr>
<tr>
<td>Display and allow adjustment of remaining Travel Time</td>
<td>When enabled, the Travel Time Countdown is displayed and the user can adjust travel time in Mobility. Available values are: 5, 10, 15, 30,</td>
<td></td>
</tr>
</tbody>
</table>
### Resource Management

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suggest activity by location</td>
<td>When enabled, displays the number of activities that are assigned in the same location for a technician. This information is displayed above the Start button on the Resource Info screen.</td>
<td>The distance within which a location falls is determined by the <strong>Resource is considered to be at the activity location if the distance to it is less than X meters</strong> setting in the SmartLocation/GPS section on the Business Rules screen.</td>
</tr>
</tbody>
</table>

### Screen Configuration Tab

The following table describes the fields available on the **Screen Configuration** tab:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application screens</td>
<td>Includes the contexts used in the Core Application.</td>
<td></td>
</tr>
<tr>
<td>Legacy Manage</td>
<td>Includes the contexts used in the legacy Core Manage.</td>
<td></td>
</tr>
<tr>
<td>Collaboration and Identifiers</td>
<td>Includes the contexts used in Collaboration and the entity identifier contexts.</td>
<td></td>
</tr>
<tr>
<td>Plugin API</td>
<td>Includes the plug-ins used with activity, inventory, and resource properties. This context layout is deprecated with release 19A. Use the Forms &amp; Plugins screen to configure new plug-ins and migrate the existing plug-ins. When you finish migrating all the plug-ins, the Plugin API section will be removed.</td>
<td></td>
</tr>
</tbody>
</table>

### Restrictions and Filters Tab

The following table describes the fields available on the **Restrictions and Filters** tab:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide all activities</td>
<td>Determines if the users will or will not be able to access any activities in the system after a certain time. When enabled, the administrator also has to set the time after which the activities are to be hidden.</td>
<td></td>
</tr>
<tr>
<td>Hide activity fields</td>
<td>Determines if the users will or will not be able to access certain activity fields after a certain time. The fields to be hidden are defined in the Field restrictions context accessible by clicking the Activity fields link. When enabled, the administrator also has to set the</td>
<td></td>
</tr>
</tbody>
</table>
### Screen Configuration Settings

Screen configuration settings define the screens, windows, pop-up windows and other elements visible to a certain user type. They also support the context layout editor, in which the content, arrangement, and visibilities of each context are set.

The **Screen configuration** tab contains the list of all contexts available in Oracle Field Service Cloud. All contexts are split into three sections that correspond to their location in the system:

- **Application screens**: The contexts used in Core Application.
- **Legacy Manage**: The contexts used in the legacy Oracle Field Service Core Manage Cloud Service.
- **Collaboration and Identifiers**: The contexts used in Oracle Field Service Collaboration Cloud Service and the entity identifier contexts.

The **Screen configuration** tab is active when the **Allow access to web application** option is enabled for the user type. The same settings also influence the availability of the screen configuration sections. If the **Allow access to web application** option is disabled for the user type, the **Application screens** section will be collapsed and inactive.

The list of settings is organized hierarchically and shows the relationships between different contexts. All context names are links to the context layout editor screens. The following figure shows the Screen configuration tab:

![Screen Configuration Tab Diagram](image)

> **Note**: Any screen configuration settings made in the **Application screens** section are retained if the **Allow access to web application** option is disabled afterwards for the user type. If access is allowed again, the same screen configuration settings apply again for the user type.
Links to new (not edited) or empty contexts are shown in red, while links to edited contexts are shown in blue. If you remove all elements from a context, its link color changes from blue to red to indicate that the context is now empty. If you create a user type without copying the settings of another user type, all contexts are shown in red. When configuring screens for a user type, the **Context layout structure** page provides an indicator to show that a property is configured. When you add an item to the **Layout structure** column of the page, it appears in red until you add visibility to the field. After you define a visibility for the item, it is no longer highlighted in the **Layout structure** column.

**Note:** You can add or remove the Collaboration Group and Operator of Helpdesk properties from the context layout structure of the **Add/Edit User** context for each user type. After you update the properties in the **Add/Edit User** context, select a user from the **Resource Settings, Users** screen and click **Modify** to view the updated properties.

The hierarchy of contexts starts from the **Main menu items** context defining the main menu items available or unavailable for the current user type. The configuration of the **Main menu items** context defines the menu bar elements visible or hidden for a particular user type. Each menu bar element opens a certain screen and, therefore, provides access to its functionality. If a certain screen has been made available for a user type, all users of such type will have access to the entire functionality implemented on that screen. Similarly, if a screen has been made unavailable for a user type, all users of such type will not be able to use the functionality implemented on that screen.

Changing the visibility of the **Message Scenarios** menu item to **Read-write** allows the user to view and edit all elements of a message scenario. With the **Read-only** visibility, they can only view them. The following figure shows the **Settings** tab of the **View scenarios step**, which was set as read-only in the **Screen Configuration** screen:

The links to contexts are connected with arrows showing the relation between the contexts. Hovering the mouse over an arrow highlights it in red for better visibility. The following figure shows a highlighted arrow, which means you are hovering the mouse over that arrow:
Click a link to open the **Context layout structure** screen and define the fields and actions of the context, and their visibilities for the user type. You can copy a context layout to another user type if the other user type uses the same or slightly modified layout of the same screen or window. For this purpose, the **Context layout structure** screen has the **Copy to** button, which opens the list of all user types in the system.

For the **form** type contexts, the link leads to the **Visual Form Editor** screen, allowing the user to edit context layouts in an easier and more transparent manner. You can delete the default Read/Write visibility on the sections and tabs in the Visual Form Editor. Additionally, Read/Write visibility is not added after migration. When the visibility condition for a property is mandatory and the property value is cleared, the value is set to null and the visibility is selected.

If the screen configuration of the current user type is shared with one or more other user types, such user types will be preselected in the **Copy to** list. If the user type selected in the list shares its screen configuration with other user types, such user types will be automatically selected as well. The current context layout will be applied to the selected user types. In this case it replaces the previous context layout settings, if any.

When a context layout is copied for another user type, only the current context is copied while the rest of the screen configuration remains unchanged. When a context layout is copied, two separate identical context layouts are created. Each layout can be edited independently causing no changes in the other one. However, if the destination screen configuration is shared with other user types, the current context layout will be copied to all user types sharing the same screen configuration.

Context layout copying is confirmed with the message, **Layout has been successfully copied**. Closing the **Context layout structure** screen returns the user to the **User types** screen.

The **Collaboration and Identifiers** section contains the contexts falling under two groups:

- **Identifiers**: Includes the identifier contexts for activity, inventory and service request
- **Collaboration**: Includes all contexts related to the Collaboration module, as shown in the following figure:
If the user type is created as a copy of another user type and the screen configuration is shared, the message, Screen configuration shared with: (User type) displays on the Screen configuration tab. When the screen configuration is shared with another user type, the same set of settings is used for both user types, and both user types refer to them simultaneously. A shared screen configuration means that all context layouts and their visibilities are similar for all user types sharing them. If the screen configuration is modified for one of the user types, the same changes will immediately apply to all other user types sharing it.

The Change action link allows selecting a different source of the screen configuration for the current user type. In this case the current user type is dissociated from the shared screen configuration. Three options are available:

- Use Screen configuration of (User Type): The screen configuration is shared with one or more user types. Only one set of configuration settings exists, and any changes of the screen configuration of one of the user types causes similar changes of the screen configuration of other user types. In this case sharing is inherited, that is, if the user type selected for sharing already shares its screen configuration with other user types, the same screen configuration will be used for all of them. The note underneath advises the user about the user types sharing the same screen configuration.

- Create Screen configuration as copy of (User Type): The screen configuration is copied from another user type. In this case two independent sets of settings are created, and any changes apply only to the user type for which they are made. The note underneath advises the user about the user type whose screen configuration will be copied.

- Create empty Screen configuration: The current screen configuration is cleared. Only the settings of the current user type are cleared. If the screen configuration had been shared with or copied from another user type previously, it is disconnected and a new independent screen configuration is created. The note underneath advises the user that only the screen configuration of the current user type will be cleared.

If a user type has an independent screen configuration, it can be replaced with another by sharing or copying the screen configuration of another user type. All user types with screen configurations not related to those of other user types have the Copy/share screen configuration link. This link leads to the same screen configuration options as are offered for changing the current screen configuration. However, as the current screen configuration is not used elsewhere in the system, selecting any option will remove it permanently. The note warns the administrator that the current configuration will be lost.

Configure Header Icons

The application includes two distinct themes—a classic style and a modern style. The modern style theme is called Vanilla and it displays icons in the header region for the most frequently accessed screens. It has a menu to the left of the screen, which provides access to the remaining screens. The classic style theme displays tabs with text. The following image shows the Vanilla theme user interface with the left pane, hamburger icon, and the header regions marked 1, 2, and 3 respectively:
This topic describes how to configure the header.

1. Click **Configuration > Themes**.
2. Click **Set default** in the Vanilla theme row.
3. Click **Configuration > User Types**.
4. Select the user type that you want to modify (you can also select the one that you are using). Click **Screen configuration**.
5. Click **Main menu items**.
   The **Context layout structure** screen appears.
6. In the **Dispatch** section, reorder the menu items as required.
   The first item in the list becomes the Home page and gets the **Home** icon. The application displays only four icons before the ‘|’ marker, regardless of the number of items you place in the **Dispatch** section.
7. Click **Close** and refresh the browser.
   The newly configured theme and the icons appear.

### Configure the Main Menu

You can configure the main menu using the **Main Menu** screen context. The configuration affects the Supervisor view. The Manage, Maps, Calendars, and Resources menus are pre-configured for this layout and are available by default.

1. Log in to the application.
2. Click **Configuration > User Types**.
3. Select a User Type for which you want to add the main menu. Click **Screen configuration**.
4. Click **Application screens > Main menu**.
   The context layout structure screen appears.
5. Click the **Click to add** button and add any item that you want to display on the main menu.
   New layout items are available as Read-Only.
6. Click **X** at the top-right corner.
7. Sign out and sign in to the application.
   The newly configured main menu appears.

### Edit the Context Layout Screen

Use the Context Layout Screen to configure the fields that appear on the application screens.

1. Click **Configuration > User Types**.
The **User Types** screen appears.

2. In the left pane, select the user type for which you want to edit the context layout.
3. Click **Screen Configuration**.
4. Expand Application screens, Legacy Manage, Collaboration and Identifiers, or Plugin API. For example, click Application screens.
5. Click the screen for which you want to edit the context layout. For example, click **Add activity/Activity details**.

   The **Context layout structure** for the selected screen and the selected user type opens. On this screen, you can add or edit properties, actions, tabs, columns, and sections. Properties appear as fields and actions appear as buttons. Tabs, columns, and sections define the structure of the layout. You can also configure visibilities to properties and define the conditions under which the visibility settings are effective.

6. Follow these steps to add a property:
   a. Click the **Click to add** button.
      The **Add property** dialog appears.
   b. Select the property that you want to add and click **OK**.

7. Follow these steps to configure the visibility for the newly added property:
   a. Click **Add new visibility**.
      The [property name] visibility screen appears.
   b. Select the access mode.
   c. To add a condition for visibility, click **Add new condition**.
      The corresponding fields appear.
   d. Select a property, select the condition, select the additional condition if available, and then click the tick mark. For example, the condition can be equal, not in, empty, and so on. If you have selected the property as activity status and the condition as equal, the additional condition can be suspended and pending.

8. Follow these steps to add an action:
   a. Click the **Click to add** button under **Actions**.
      The **Add action** dialog appears.
   b. Select the action that you want to add and click **OK**.
      After adding the action, set visibility for it. Visibility is not set by default, so you must configure it for every field and action that you add.

9. Follow these steps to add a tab:
   a. Click a property and click **Group**.
      The **Add to group** dialog appears.
   b. Enter the name of the group.
   c. Select one of the following options and then click **OK**:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section</td>
<td>Select this option to start a new section or block.</td>
</tr>
<tr>
<td>Tab</td>
<td>Select this option to start a new tab with the name provided earlier.</td>
</tr>
<tr>
<td>Predefined tab</td>
<td>Select this option to include a predefined tab. Select the tab from the <strong>Tab</strong> type drop-down list. Predefined tabs are the tabs available in the application by default.</td>
</tr>
</tbody>
</table>

10. Follow these steps to add a column or section:
    a. Select a property or an action and click **Add marker**.
    b. In the **Add marker** dialog, select **End of column** or **End of section**.
    c. Click **OK**.
Visual Form Editor

The Visual Form Editor is used to configure context layouts in the Mobility application for each user type. After configuring the context layout, you must select the **Allow access to web application** check box for each user type to view the context in the application.

The editor enables you to configure the following entities, when available, for each form:

- **Fields**: Displays properties that are relevant for the selected context or that belong to a specific entity.
- **Actions**: Displays actions that are relevant for the selected context or that belong to a specific entity.
- **Special elements**: The following options are available:
  - **Add Text**: Enables you to add text to the section of a form.
  - **Section and Tab**: Contains the selected fields and actions from the Fields and Actions objects.

You can define **Visibility** settings for each object of the form. Values with identical visibility settings are grouped and the grouping happens after the settings are saved. Also, using the **Translations** section, you can translate the text that displays on each object to any of the supported languages.

By default, the Visual form editor displays the following elements:

- **Header**: Displays the selected actions from the Actions object.
- **Footer**: Contains the default **Dismiss** and **Submit** buttons for a form. You can only define visibility settings for the **Submit** button.
- **Submit and Dismiss** buttons: Indicates the button that is visible for all forms.

**Default Values and Validation Rules**

You can configure string and integer fields to include default values and validation rules. This helps when your business needs some fields to be populated by default and some fields to be calculated automatically, based on the value of another field. The fields that you configure here are applicable only to Oracle Field Service Mobility Cloud Service. Further, this function is allowed only for `string`, `int` and `enum` custom properties.

You can configure the fields and properties in the following ways:

- **Add a default value**: A default value is an auto-calculated value of a field or property. This value is based on certain business rules and is dependent on the values of other fields and properties. The default value is represented as a formula filled in the corresponding configuration field. For example, when a property is filled with a specific value, another property is filled with the current date or time.

- **Add a validation rule**: A validation rule is a restriction based on certain business rules and is dependent on the values of other fields and properties. A validation rule is represented as a formula filled in the corresponding configuration field. For example, the value entered for a property (property A) falls within a specific range (between values of property B and property C).

- **Use a formula for configuring the visibility and the value visibility**: The formula is based on certain business rules and is dependent on the values of other fields and properties. The formula for the visibility of the field and its value must be filled in the corresponding configuration field. It’s possible to transform an existing visibility configured through a constructor to a formula. The application uses this formula for calculating visibility as the primary path and visibility from the constructor as the secondary path.
Note: If a default expression is configured with an empty value for a read-only field or property, it will NOT be hidden on the screen. This means, the user will see the field or property label on the screen, but it will not have any value.

Auto-Generated and Auto-Calculated Fields
Auto-generated and auto-calculated fields can have a visibility of Read-Only. Regardless of the configured visibility, the application displays such fields as Read-Only. Further, such fields are not available for selection on the Context Layout Structure screen of add screens such as, 'Add activity' and 'Add inventory'. The fields that can be set only as read-only are as given in the following table:

<table>
<thead>
<tr>
<th>Entity</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTIVITY</td>
<td>ETA</td>
<td></td>
</tr>
<tr>
<td></td>
<td>acoord_status</td>
<td>Coordinate Status</td>
</tr>
<tr>
<td></td>
<td>acoord_x</td>
<td></td>
</tr>
<tr>
<td></td>
<td>acoord_y</td>
<td></td>
</tr>
<tr>
<td></td>
<td>activity_alerts</td>
<td></td>
</tr>
<tr>
<td></td>
<td>activity_capacity_categories</td>
<td></td>
</tr>
<tr>
<td></td>
<td>activity_compliance</td>
<td></td>
</tr>
<tr>
<td></td>
<td>activity_workskills</td>
<td></td>
</tr>
<tr>
<td></td>
<td>aid</td>
<td>Activity ID</td>
</tr>
<tr>
<td></td>
<td>astatus</td>
<td>Activity status</td>
</tr>
<tr>
<td></td>
<td>atravelarea</td>
<td>Travel Area</td>
</tr>
<tr>
<td></td>
<td>atype</td>
<td>Activity Type</td>
</tr>
<tr>
<td></td>
<td>auto_routed_to_date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>auto_routed_to_provider_id</td>
<td></td>
</tr>
<tr>
<td></td>
<td>auto_routed_to_provider_name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>aworkzone</td>
<td>Work Zone</td>
</tr>
<tr>
<td></td>
<td>c_zid</td>
<td></td>
</tr>
<tr>
<td></td>
<td>date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>delivery_window</td>
<td></td>
</tr>
<tr>
<td></td>
<td>end_time eta_end_time</td>
<td></td>
</tr>
<tr>
<td></td>
<td>first_manual_operation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>first_manual_operation_interface</td>
<td></td>
</tr>
<tr>
<td></td>
<td>first_manual_operation_user_id</td>
<td></td>
</tr>
<tr>
<td></td>
<td>first_manual_operation_user_login</td>
<td></td>
</tr>
<tr>
<td></td>
<td>first_manual_operation_user_name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>service_window</td>
<td></td>
</tr>
<tr>
<td>Entity</td>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>INVENTORY</td>
<td>time_delivered</td>
<td></td>
</tr>
<tr>
<td></td>
<td>inv_aid</td>
<td>Activity Id</td>
</tr>
<tr>
<td></td>
<td>inv_change_invid</td>
<td>Changed Inventory ID</td>
</tr>
<tr>
<td></td>
<td>inv_pid</td>
<td>Resource Id</td>
</tr>
<tr>
<td></td>
<td>invid</td>
<td>Inventory Id</td>
</tr>
<tr>
<td></td>
<td>invpool</td>
<td>Inventory pool</td>
</tr>
<tr>
<td>REQUIRED INVENTORY</td>
<td>required_available_quantity</td>
<td>Quantity in Resource Pool</td>
</tr>
<tr>
<td></td>
<td>required_model</td>
<td>Model</td>
</tr>
<tr>
<td></td>
<td>required_quantity</td>
<td>Quantity</td>
</tr>
<tr>
<td></td>
<td>required_type</td>
<td>Type</td>
</tr>
<tr>
<td>SERVICE REQUEST</td>
<td>appt_ident</td>
<td>Activity</td>
</tr>
<tr>
<td></td>
<td>srcreated</td>
<td>Created</td>
</tr>
<tr>
<td></td>
<td>srdate</td>
<td>Date</td>
</tr>
<tr>
<td></td>
<td>sr_id</td>
<td>Request Id</td>
</tr>
<tr>
<td></td>
<td>sr_aid</td>
<td>Activity</td>
</tr>
<tr>
<td></td>
<td>sr_invid</td>
<td>Inventory Id</td>
</tr>
<tr>
<td></td>
<td>sr_pid</td>
<td>Resource Id</td>
</tr>
<tr>
<td></td>
<td>sr_uid</td>
<td>User Id</td>
</tr>
<tr>
<td></td>
<td>uname</td>
<td>User</td>
</tr>
<tr>
<td>RESOURCE</td>
<td>alerts</td>
<td>(always hidden)</td>
</tr>
<tr>
<td></td>
<td>calendar</td>
<td></td>
</tr>
<tr>
<td></td>
<td>oncally_calendar</td>
<td></td>
</tr>
<tr>
<td></td>
<td>pcapacity_bucket</td>
<td></td>
</tr>
<tr>
<td></td>
<td>pending</td>
<td></td>
</tr>
<tr>
<td></td>
<td>pid</td>
<td>ID</td>
</tr>
<tr>
<td></td>
<td>p_initial_ratio</td>
<td></td>
</tr>
<tr>
<td></td>
<td>p_rprid</td>
<td></td>
</tr>
<tr>
<td></td>
<td>queue_status</td>
<td></td>
</tr>
<tr>
<td></td>
<td>reactivated</td>
<td></td>
</tr>
<tr>
<td></td>
<td>resource_capacity_categories</td>
<td></td>
</tr>
<tr>
<td></td>
<td>resource_effective_workskills</td>
<td></td>
</tr>
<tr>
<td></td>
<td>resource_time_slots</td>
<td></td>
</tr>
<tr>
<td></td>
<td>resource_workskills</td>
<td></td>
</tr>
<tr>
<td></td>
<td>resource_workzones</td>
<td></td>
</tr>
</tbody>
</table>
Entity | Field | Description
--- | --- | ---
skip_days_for_stats | | 
total | | 
pcolor | (always hidden) | 
USER | last_login | 
last_password_change | 
login_attempts | 
login_blocked_to | 
main_resource_id | 
mobile_activity_count | 
mobile_inventory_count | 
mobile_provider_count | 
show_placeholder_id | 
sucreated | 
sustatus | 
suupdated | 
uid | User ID |

Limitations
The following limitations exist for default values and validation rules:

- Work skills and work zones are not supported for default values and validation rules.
- Custom properties with the "Geolocation element" GUI is not supported for default values and validation rules.
- The following limitations are applied to the configuration of expressions:
  - 2000 characters for configuring default values
  - 2000 characters for configuring validation rules
  - 4950 characters for configuring visibility as an expression

Supported Screens
You can configure default values and validation rules only on the following Activity and Inventory screens for Oracle Field Service Mobility Cloud Service:

<table>
<thead>
<tr>
<th>Screen</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit/View activity</td>
<td>mobile_activity_details</td>
</tr>
<tr>
<td>Cancel activity</td>
<td>mobile_cancel_activity</td>
</tr>
<tr>
<td>Delay activity</td>
<td>mobile_delay_activity</td>
</tr>
<tr>
<td>End activity</td>
<td>mobile_end_activity</td>
</tr>
</tbody>
</table>
### Supported Fields

You can configure default values and validation rules only on the following fields:

<table>
<thead>
<tr>
<th>Property name</th>
<th>Property label</th>
<th>Type</th>
<th>Entity</th>
<th>GUI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Number</td>
<td>customer_number</td>
<td>field</td>
<td>activity</td>
<td>text</td>
</tr>
<tr>
<td>Activity Type</td>
<td>aworktype</td>
<td>field</td>
<td>activity</td>
<td>combobox</td>
</tr>
<tr>
<td>Address</td>
<td>caddress</td>
<td>field</td>
<td>activity</td>
<td>text</td>
</tr>
<tr>
<td>Appointment Number</td>
<td>appt_number</td>
<td>field</td>
<td>activity</td>
<td>text</td>
</tr>
<tr>
<td>City</td>
<td>ccity</td>
<td>field</td>
<td>activity</td>
<td>text</td>
</tr>
<tr>
<td>Customer Email</td>
<td>cemail</td>
<td>field</td>
<td>activity</td>
<td>email</td>
</tr>
<tr>
<td>Customer Mobile Number</td>
<td>ccell</td>
<td>field</td>
<td>activity</td>
<td>phone</td>
</tr>
<tr>
<td>Customer Phone Number</td>
<td>cphone</td>
<td>field</td>
<td>activity</td>
<td>phone</td>
</tr>
<tr>
<td>Duration</td>
<td>length</td>
<td>field</td>
<td>activity</td>
<td>text</td>
</tr>
<tr>
<td>Inventory Type</td>
<td>invtype</td>
<td>field</td>
<td>inventory</td>
<td>combobox</td>
</tr>
<tr>
<td>Name</td>
<td>cname</td>
<td>field</td>
<td>activity</td>
<td>text</td>
</tr>
<tr>
<td>Points</td>
<td>apoints</td>
<td>field</td>
<td>activity</td>
<td>text</td>
</tr>
<tr>
<td>Quantity</td>
<td>quantity</td>
<td>field</td>
<td>inventory</td>
<td>text</td>
</tr>
<tr>
<td>Serial Number</td>
<td>invsn</td>
<td>field</td>
<td>inventory</td>
<td>text</td>
</tr>
<tr>
<td>Service Request Type</td>
<td>srtype</td>
<td>field</td>
<td>service request</td>
<td>combobox</td>
</tr>
<tr>
<td>State</td>
<td>cstate</td>
<td>field</td>
<td>activity</td>
<td>text</td>
</tr>
</tbody>
</table>
Configure Default Values and Validation Rules

When you configure fields on the **Visual Form Editor**, you can add a default value or a validation rule for fields and properties, and use formulas to configure visibility and visibility value.

1. Click **Configuration**.
2. Click **User Types** in the **Users, Security, Integration** section.
3. Click **Screen configuration**.
4. Expand the **Application screens** section and click the screen that you want to modify.
5. Select the field for which you want to add a default value or a validation rule. If the field is not added to the context layout, drag it from the left pane and drop it in the right pane.

   By default, the field is assigned with a visibility of Read-Write (RW).

6. Follow these steps to change the default visibility:
   a. Click **Add New** in the **Visibility** section.

      The **Visibility settings** dialog appears.
   b. Select the required option in the **Access mode** section.
   c. If you want to change the visibility based on a condition, add it in the **Conditions** section.

      You can add a formula to determine the condition for visibility. The conditions entered here if any, are given priority over visibility inherited by the field or property.

   **Note:** When setting up the visibility for a specific property, you cannot create a visibility condition based on the property itself. For example, suppose that you want to set up the visibility of the property "City" as Read Write. You cannot set up a condition such as "City contains New York".

7. Follow these steps to add a default value or a validation rule:
   a. Expand the **Default value and validation** section.
   b. Enter a value in the **Default value** field.
   c. Enter a validation for the value in the **Validation** field.

      You can use arithmetic operators, comparison operators, or functions to form the validation rule.

8. Click **Save**.

   The details are saved and enforced when a user edits the corresponding screen the next time.
Language Expressions

The language containing operators and functions is used for configuring default values, validation rules, and visibility of fields and properties.

The language is described in the following table:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
<th>Usage Pattern</th>
<th>Use in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variables, entities, and properties</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>this</td>
<td>Value of current element</td>
<td>this &gt; 100</td>
<td>No</td>
</tr>
<tr>
<td>entity.property</td>
<td>Value of property of entity. Use for wrapping labels with spaces.</td>
<td>activity.aworktype = 1</td>
<td>Yes</td>
</tr>
<tr>
<td>entity.<code>label</code></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>White spaces and comments</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>[space], [tab], [line break]</td>
<td>Assuming multiple white spaces as single space. Assuming white space as separator.</td>
<td>this + 100</td>
<td>Yes</td>
</tr>
<tr>
<td>/* Any comment */</td>
<td>Assuming comment block as single white space.</td>
<td>activity.PROP_A1 &gt; 77 /* 77 - is predefined parameter */</td>
<td>Yes</td>
</tr>
<tr>
<td>Logical operators (case sensitive, operands will be converted to Boolean)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OR</td>
<td>Logical disjunction</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>AND</td>
<td>Logical conjunction</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Unary operators</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NOT</td>
<td>Logical not (operand will be converted to Boolean)</td>
<td>NOT (a AND b)</td>
<td>Yes</td>
</tr>
<tr>
<td>-</td>
<td>Arithmetic inversion (operand will be converted to Number)</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Equal Comparison Operators (case sensitive for Strings). Operands will be converted to String</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>=</td>
<td>Equal to</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not equal</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Comparison Operators (case sensitive for Strings). Use toNumber() for arguments if number comparison is needed.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal to</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Arithmetic Operators (all operands will be converted to Number, any arithmetic operation with Infinity/NaN returns Infinity/NaN)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>+</td>
<td>Addition</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>-</td>
<td>Subtraction</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication</td>
<td></td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Argument

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
<th>Usage Pattern</th>
<th>Use in</th>
</tr>
</thead>
<tbody>
<tr>
<td>/</td>
<td>Division Division by zero: Division by zero returns infinity, which will be converted to &quot;&quot; (empty string).</td>
<td>a / b</td>
<td>Yes Yes Yes</td>
</tr>
</tbody>
</table>

### Additional Operators (case sensitive)

<table>
<thead>
<tr>
<th>string CONTAINS needle</th>
<th>Returns true if ‘string’ contains ‘needle’ (operands will be converted to String)</th>
<th>this CONTAINS &quot;A0&quot; activity.PROPERTY_A1 CONTAINS concat(&quot;-&quot;, this)</th>
<th>Yes Yes Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>NOT activity.PROPERTY_A2 CONTAINS activity.PROPERTY_A3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>value IN (value1[, value2, [valueN]]) maximum 1000 arguments</td>
<td>Returns true if ‘value’ is equal to any ‘value1’...’valueN’ (value will be converted to String)</td>
<td>this IN (1, 2, 3, 4) activity.PROPERTY_A1 IN (&quot;value1&quot;, &quot;value2&quot;)</td>
<td>Yes Yes Yes</td>
</tr>
<tr>
<td></td>
<td>NOT activity.PROPERTY_A2 IN (&quot;value1&quot;)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>value BETWEEN (min, max)</td>
<td>Returns true if ‘value’ is equal to ‘min’, equal to ‘max’ or between them. The same as: value &gt;= min AND value &lt;= max (operands will be converted to Number)</td>
<td>1 BETWEEN (0, 100) NOT 200 BETWEEN (99, 100)</td>
<td>Yes Yes Yes</td>
</tr>
</tbody>
</table>

### Functions (case sensitive)

<table>
<thead>
<tr>
<th>if(condition, value1, value2)</th>
<th>Function which returns value1 argument if condition is true and value2 argument if condition is false (condition will be converted to Boolean)</th>
<th>if(activity.PROPERTY_A1 &gt; 0, 1, 0)</th>
<th>Yes No No</th>
</tr>
</thead>
<tbody>
<tr>
<td>now(string)</td>
<td>Returns current date in required format. View corresponding section for details</td>
<td>now(&quot;yyyy-MM-dd HH:mm:ss&quot;)</td>
<td>Yes No No</td>
</tr>
<tr>
<td>toNumber(value)</td>
<td>Formatting object to required number format</td>
<td>toNumber(activity.PROPERTY_A1) toNumber(&quot;123.45&quot;)</td>
<td>Yes Yes Yes</td>
</tr>
<tr>
<td>toString(value)</td>
<td>Formatting object to string</td>
<td>toString(activity.PROPERTY_A1) toString(123.45)</td>
<td>Yes Yes Yes</td>
</tr>
<tr>
<td>concat(string1, string2 […] ,stringN]) maximum 20 arguments</td>
<td>Concatenate strings (all operands will be converted to String)</td>
<td>concat(this, &quot;,&quot;, activity.PROPERTY_A1)</td>
<td>Yes Yes Yes</td>
</tr>
<tr>
<td>toLowerCase(string)</td>
<td>String to lower case (operand will be converted to String)</td>
<td>toLowerCase(activity.PROPERTY_A1)</td>
<td>Yes Yes Yes</td>
</tr>
<tr>
<td>toUpperCase(string)</td>
<td>String to upper case (operand will be converted to String)</td>
<td>toUpperCase(activity.PROPERTY_A1)</td>
<td>Yes Yes Yes</td>
</tr>
</tbody>
</table>
**Data Type Conversion**

The following table describes the types of data used for validation rules and the way the application converts them:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
<th>Usage Pattern</th>
<th>Use in</th>
</tr>
</thead>
<tbody>
<tr>
<td>empty(value)</td>
<td>Returns true if 'value' is undefined or empty string or NaN or Boolean, false in all other cases</td>
<td>empty(activity.PROPERTY_1)</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NOT empty(activity.PROPERTY_2)</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Examples of Validation Rules**

**Scenario 1: Report Gas Consumption**

Suppose that an activity contains information about gas consumption. There are three of types of consumption: predicted, actual, and removed. The 'predicted' amount of consumed gas is saved in the activity. When a Field Technician chooses to report the actual information about the consumed gas, then the difference between 'actual' and 'predicted' data should be calculated automatically. If the actual consumption exceeds the predicted consumption by more than 20 cubic meters and the conditions of the gas counter are good, then the 'Reporting notes' property is displayed.

**Prerequisites:**
Let us assume that 'Predicted gas consumption', 'Actual gas consumption', 'Difference', 'Counter is not broken' and 'Reporting notes' string-type properties are configured in the application. And, there is the 'Counter is not broken' integer property with a check box on the GUI.

**Configuration:**
The expressions should be configured in the 'Default' field for the 'Difference' property. It should look like:

```plaintext
activity.real_consumption - activity.predicted_consumption
```

**Visibility:**
The visibility for 'Reporting notes' should be set as Read/Write with the same formula as the condition:

```plaintext
(activity.real_consumption - activity.predicted_consumption) > 20 AND activity.counter_conditions = 1
```
Scenario 2: Checking Ratio

A Field Technician has to enter the Upstream Signal-to-Noise ratio to complete an activity (it is mandatory). The range should not be seen and it has to be anywhere between +32 to 52 dBmV. When the Field Technician enters a value of 55dBmV, which is not in the range then the Field Technician should know that is not the range and has to try again. The Field Technician measures again and enters 51dBmV, which is in the range allowing to complete the activity.

Prerequisites: Let’s assume that the Upstream Signal-to-Noise’ property is configured in the application. The ‘Upstream Signal-to-Noise’ property is configured on the ‘Complete activity’ screen as mandatory.

Configuration: The expression should be configured in the ‘Validation’ field for the ‘Upstream Signal-to-Noise’ property. It should: this BETWEEN (32,52).

Custom error message should be configured in the corresponding field to be displayed to the tech in Mobility.

Processing Rules

This topic describes the rules based on which default values and validation rules are calculated.

Default value rules

For read-only fields and properties:

- Default value is always calculated for empty fields and properties.
- Default value is not calculated for not-empty fields and properties.
- Default value is recalculated every time a dependent field is changed, where dependent fields are fields used in the formula of the rule.

For read-write or mandatory fields and properties:

- Default value is always calculated for empty fields and properties.
- Default value is not calculated for not-empty fields and properties.
- Default value is recalculated every time a dependent field is changed, when the dependent fields are used in the formula of the rule.
- Default value stops calculated once it’s manually changed on the open form.
- Default value stops calculated once it’s submitted with not-empty value.
- Default value is not calculated for fields and properties with pre-filled values defined on the Action links configuration screen.

Validation rules

For read-only fields and properties: Not applicable to read-only fields

For read-write fields and properties:

- Are used for read-write fields and properties.
- If a value of certain field or property does not match with the configured validation rule, then the form can be submitted.

For Mandatory fields and properties:

- Are applicable to mandatory fields and properties.
- If a value of certain field or property does not match with the configured validation rule, then the form cannot be submitted.
• For fields and properties where validation rules are not configured, the 'NOT empty' rule is automatically applied (current logic).

• For fields and properties where validation rules are configured, the system uses that rules on the submission of the form. That is, if a validation rule states that a mandatory field 'IS empty' then it will be submitted without value.

Conflict Resolution
If a configured visibility rule contradicts with a configured default value, the following rules are applied to resolve the conflict:

• for read-only fields and properties, the form is submitted and warning a message is displayed

• for mandatory fields and properties, the form is not submitted and an error message is displayed

Syntax for Default Values and Validation Rules
This topic describes the syntax to configure the default values and validation rules.

Naming of entities: Use the following names to relate custom properties and product fields to required entities:

• activity - prefix for activity properties/fields. Example: activity.PROP_A1

• inventory - prefix for inventory properties/fields. Example: inventory.PROP_I1

• resource - prefix for resource properties/fields. Example: resource.PROP_R1

• user - prefix for user properties/fields. Example: user.PROP_U1

• request - prefix for service request properties/fields. Example: sr.PROP_SR1

Operators: All operators are case sensitive and must be used in the configuration as described in the "Language expression" section. Examples:

• activity.PROP_A1 = 100 OR activity.PROP_A1 = 200 - is correct

• activity.PROP_A1 = 100 or activity.PROP_A1 = 200 - is incorrect

Numbers and Strings: String-type values must be used in expressions in double or single quotes. For example:

• "string expression"

• "12345"

• 'single'

Escape sequences: The allowed string escape sequences are:

• \‘ – To escape ‘ within single quoted string

• " – To escape " within double quoted string

• \ – To escape the backslash

• \n – To add line breaks between string

• \t – To add tab space

To ignore other escape sequences:

• \radasd => radasd

• \x123 => x123
To use integers in expressions, use them without of quotes. For example:

- 12345
- 6

Use float numbers with a dot as delimiter and without quotes. For example: 2.86954.

Properties and Fields

For properties and fields, the entity is given first followed by the label, and separated by a dot. If the label contains anything other than a to z, A to Z, 0 to 9, or underscore, wrap it with backticks. Examples:

- activity.PROP_A1 = 25
- activity.PROP_A1 <> activity.PROP_A2
- inventory.'LABEL WITH SPACE'

Functions in Language Expressions

Use functions in expressions in the format where the function’s name is given first followed by the expression in brackets. Separate arguments by comma. All functions are case sensitive and must be used in the configuration as described in the "Language expression" topic.

Examples for functions are:

- toNumber("string expression")
- if(activity.PROP_A1 > 10, 15, activity.PROP_A2 + 200)
- toLowerCase(activity.PROP_A1) - is correct
- tolowercase(activity.PROP_A1) - is incorrect

‘if’ function

The function consists of three attributes separated by comma. The function represents the following logic: if attribute 1 is <some value> then set <some value> else set <other value>. Example: if (activity.PROP_A1 > 0, 15, activity.PROP_A2+200)

‘now’ function

The function can be set as now("format") where the format can be DATE, DATETIME, TIMESTAMP. Include the value of the format between double quotes, similar to strings. Examples:

- DATE - now("yyyy/MM/dd")
- DATETIME - now("yyyy/MM/dd hh:mm:ss tt")
- TIME - now("HH:mm:ss")

‘toNumber’ and ‘toString’ functions

The rules described in the *Numbers and Strings* and *Properties and Fields* sections are applicable to the toNumber and toString functions. Examples:

- toNumber("12345")
- toNumber(activity.PROP_A1)
- toString(1245)
- toString(activity.PROP_A2)
'concat' function
The function can contain any number of operands separated by comma and placed in between brackets. Examples:

- concat("abc", 15,"cde")
- concat(activity.PROP_A1,activity_PROP_A2)

'toLowerCase' and 'toUpperCaase' functions
The functions are used to convert strings to lower or upper case. The functions contain only one operand placed in brackets. Examples:

- toLowerCase("ABCD")
- toLowerCase(activity.PROP_A1)
- toUpperCase("abcd")
- toUpperCase(activity.PROP_A1)

'empty' function
The function can be set with some field or property defined in brackets followed by the function. Examples:

- empty(activity.PROP_A1)
- if(empty(activity.PROP_A1),1000,activity.PROP_A2 +200)
- NOT empty(activity.PROP_A1)

Activity type groups
You can configure a group of activity types for default values, validation rules, and visibility fields and properties. It is configured in the format of activity.awortype_group = "LABEL", where the value defining a label of an activity type group is included in double or single quotes. Examples:

- activity.awortype_group = "internal"
- activity.aworktype_group IN ('customer', 'maintenance')

The now Function
The 'now' function returns the date and time in the resource time zone.

You can configure the function according to the format given in the following table:

<table>
<thead>
<tr>
<th>Format Character</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>d</td>
<td>Day of the month, 2 digits</td>
<td>1 to 31</td>
</tr>
<tr>
<td>dd</td>
<td>Day of the month, 2 digits, with leading zeros</td>
<td>01 to 31</td>
</tr>
<tr>
<td>H</td>
<td>24-hour format of an hour</td>
<td>0 through 23</td>
</tr>
<tr>
<td>h</td>
<td>12-hour format of an hour</td>
<td>1 through 12</td>
</tr>
<tr>
<td>HH</td>
<td>24-hour format of an hour, with leading zeros</td>
<td>00 through 23</td>
</tr>
<tr>
<td>hh</td>
<td>12-hour format of an hour, with leading zeros</td>
<td>01 through 12</td>
</tr>
<tr>
<td>M</td>
<td>Numeric representation of a month</td>
<td>1 through 12</td>
</tr>
</tbody>
</table>
### Format Character

<table>
<thead>
<tr>
<th>Format Character</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>m</td>
<td>Minutes</td>
<td>0 to 59</td>
</tr>
<tr>
<td>MM</td>
<td>Numeric representation of a month, with leading zeros</td>
<td>01 through 12</td>
</tr>
<tr>
<td>mm</td>
<td>Minutes, with leading zeros</td>
<td>00 to 59</td>
</tr>
<tr>
<td>s</td>
<td>Seconds</td>
<td>0 through 59</td>
</tr>
<tr>
<td>ss</td>
<td>Seconds, with leading zeros</td>
<td>00 through 59</td>
</tr>
<tr>
<td>t</td>
<td>Short uppercase Ante meridiem and Post meridiem</td>
<td>A or P</td>
</tr>
<tr>
<td>tt</td>
<td>Uppercase Ante meridiem and Post meridiem</td>
<td>AM or PM</td>
</tr>
<tr>
<td>yy</td>
<td>A two digit representation of a year, with leading zeros</td>
<td>17</td>
</tr>
<tr>
<td>yyyy</td>
<td>A full numeric representation of a year, 4 digits</td>
<td>2017</td>
</tr>
<tr>
<td>z</td>
<td>The time zone offset</td>
<td>±0 to ±11</td>
</tr>
<tr>
<td>zz</td>
<td>The time zone offset, with a leading zero</td>
<td>±00 to ±11</td>
</tr>
<tr>
<td>zzz</td>
<td>The full timezone offset, with a leading zero</td>
<td>±00:00 to ±11:30</td>
</tr>
</tbody>
</table>

### Configure a Context Layout Screen

Assume that you want to create a Edit/View Activity form for the context, Edit/View Activity that belongs to the user type, Administrator with the following objects:

- **Start** and **End** actions.
- Special element, **Section**
- **Name** and **Address** fields.

This example explains how to configure the entities, namely, fields, actions, and special elements for the form.

**Note:** Properties configured on the **Edit/View Activity** context (also known as **Activity Details** screen) are **ReadOnly**, even if the property visibility is set to **ReadWrite**. To set the property visibility to **ReadWrite**, you must add the properties to a tab.

1. Click **Configuration, User Types** in the **Users and Security** section.
   The existing users display in the left pane.
2. Select **Administrator** from the left pane.
3. Select the **Screen Configuration** tab.
4. Expand **Application screens** and select **Edit/View Activity**.
   The **Visual Form Editor** displays.
5. To add the special element, Section to the grid:
   a. Select **Special Elements**.
   b. Drag and drop **Section** to the grid to add a section to the form.
6. To add **Name** and **Address** fields to the section:
   a. Drag and drop the **Name** property from the Fields section.
   b. Drag and drop the **Address** property from the Fields section.
7. Click **Save**.
8. To add the Start and End actions:
   a. Drag and drop the Start action to the header from the Actions section.
b. Drag and drop the End action to the header from the Actions section.

9. Click **Save** at the top of the form editor.

After you configure the entities for a form, log in to the application and view the configured form.

**Note:** Visibility of tabs is the aggregated result of the configured visibility conditions for the child elements (for example, property, text). The following rules apply:

- The tab is visible and accessible, if at least one element is configured to be visible (for example, Read-write or Mandatory) or a Read-only element contains data.
- The tab is not visible or accessible, if none of the configured elements is visible (for example, no Read-write or Mandatory property or Read-only element without data).
- If a tab has all Read-Only elements, then the action links are shown. If at least one element in the tab is Read-Write or Mandatory, then the action links are not shown.
- If a tab has been configured with visibility conditions, it will be displayed in accordance with those conditions ignoring inner elements.

### Restrictions and Filters

The **Restrictions and Filters** tab sets the restrictions on activities and fields visible to the users of the current type.

The **Restrictions and Filters** tab has two sections:

- **Field restrictions**
- **Filters restricting visible activities**

The **Restrictions and Filters** tab is shown in the following figure:
Options in the **Field restrictions** section define whether all activities and/or certain activity fields are to be hidden from the users of the current user type. There are two options in this section:

- **Hide all activities**: Determines if the users will or will not be able to access any activities in the system after a certain time. When the **Hide all activities** option is enabled, the administrator must set the time after which the activities are to be hidden. Two options are available:
  - **starting tomorrow**: When selected, all users of the current type will only be able to access today’s activities
  - **starting day after tomorrow**: When selected, all users of the current type will only be able to access today’s and tomorrow’s activities. No activities beyond the selected time will be visible to these users.

- **Hide activity fields**: Determines if the users will or will not be able to access certain activity fields after a certain time. The fields to be hidden are defined in the **Field restrictions** context accessible by clicking the **activity fields** link. When the **Hide activity fields** option is enabled, the administrator must set the time after which the activity fields are to be hidden. Two **Hide all activity fields** menu options are available:
  - **starting tomorrow**: When selected, all users of the current type will only be able to access the selected fields of today’s activities
  - **starting day after tomorrow**: When selected, all users of the current type will only be able to access the selected fields of today’s and tomorrow’s activities. The restricted activity fields beyond the selected time will not be visible to these users.

Options in the **Filters restricting visible activities** section define whether the users of the current type will be able to view entire routes or only some activities. Setting the visibility restrictions requires proper configuration of the applicable filters.

To be used as a restriction on visible activities, a filter must be defined as applicable for **activity** in the **Add Filter** window. In addition, the **Restriction on visible activities** option must be selected. Clicking **Add** displays the **User Types** screen, where you can apply the current filter as a visibility restriction filter for the user type. The following figure shows the **Add filter** dialog with the **Applicable for**, **Restriction on visible activities** and the **Go to User Types screen to apply the current filter as visibility restriction filter for user type** fields highlighted:
The filters you add then display in the list of available filters in the **Restrictions and Filters** tab of the user-type configuration.

When a filter has been set for a user type, all users of such type will see only the activities defined in the filter settings according to the conditions set in the filter configuration.

The **User Types** section of the filter does not apply when setting restrictions on visible activities. The **User Types** section is inactive only when the **Restriction on visible activities** option is selected. However, it is used in configuring the filter to be used on **List/Time/Map/Daily** screens. The following figure shows the **Filters** menu:

![Filters Menu](image)

When the **List/Time/Map/Daily** option is selected, the **User Types** section becomes active. The note in the **User Types** section suggests that the **List/Time/Map/Daily** filter will be applied for selected user types.

When a filter is defined as a filter for **List/Time/Map/Daily** for a user type, this filter will appear in the **View** window on the **Activities** and **Daily** screens for users of such type. The list will include only the filters configured as described above.

**Note:** If the same filter is defined both as applicable for **List/Time/Map/Daily** and as a **Restriction on visible activities**, it works for two different groups of user types. The **List/Time/Map/Daily** filtering will be available for the user types selected in the same filter configuration window. However, the **Restriction on visible activities** will be set for the user types for which this filter is selected in the **Restrictions and Filters** settings.

**Add Access Schedule Fields**

To access the Access Schedule fields, add the Access Schedule (access_schedule) and/or Access Hours (access_hours) fields to the appropriate display context. While Access Schedule can be added in Read-Only and Read-Write mode, Access Hours can only have the Read-Only visibility. In most of the contexts (including activity-related screens, lists and hints, with the only exception of Activity details) the Access Schedule field also includes Access Hours if it is calculated.

**User Management**

How you configure and manage user types and individual users is dependent upon user-type settings.
User type settings affect the user management process. You should consider the following points when configuring user types and individual users:

- These settings allow the user logging in under this user type to open the Users screen and manage users.
- A user having access to the Users screen can see the list of all users existing in the system. However, the user can modify only the users of types defined under Can create users of the following user types. Users of other types have no action links and cannot be included in group actions (that is, no check boxes are available to them).
- If no user types have been defined in the Can create users of the following user types section, the user can see the users list but cannot modify existing user settings or add new users.
- A user is always related to one or more resources. The choice of resources for creating a new user is affected, on one hand, by the Assigned resource types setting in the User Type configuration and, on the other hand, by the Users can be created at the level of this resource feature of the resource type.
- When creating a new user type, the User Type field contains the list of user types defined in the Can create users of the following user types field of the current user type.

Create a User Type

Follow these steps to create a Oracle Field Service Cloud user type.

You must be logged into Oracle Field Service Cloud as an administrator.

When you create a user type that is not copied from an existing one, most of the options are disabled, and you must define the settings manually. When you use a copy, the new user type inherits all the settings from the copy.

1. Access the User Types screen.
2. Click the + icon at the upper left corner of the screen.
   The Add User Type window appears.
3. Enter a Label for the user type.
   This is a unique string identifier of the user type.
4. Enter a Name for the user type.
   This is a human-friendly name.
5. Optionally, choose an existing user type to copy settings from.
   a. Choose an existing user type from the available list.
   b. Optionally, click Share screen configuration.
      Choose this option if you want the new user type to have the same screen configuration options as the copied user type. If you change a shared screen configuration, the change will apply to all user types that use the configuration.
6. Click OK
   The User Type Settings screen appears.
7. Edit the user type values as necessary.
8. Click Save.
   Changes to a user type assigned to manage users are applied shortly after they are saved. Changes to a user type assigned to Mobility users are applied after the next synchronization.

Delete a User Type

You can delete a user type only if there are no users assigned to it.

You must be logged into Oracle Field Service Cloud as an administrator.

1. Access the User Types screen.
2. Select the user type you want to delete from the list.
3. Click the - icon at the upper left corner of the screen.
   
   The Confirm window opens.
4. Click OK.
   
   If the selected user type is assigned to any users, an error message displays indicating that the user type cannot be deleted. Else, the user type is deleted.

Export User Types

User types are exported together with all their settings, such as associated resource types, user types from which users can create or be created by the exported user type, permissions, context layouts, and filters.

The following actions are available on the Export user types window:

- Select all: Exports all user types existing in the application.
- Clear all: Clears any previously selected user types.

The search field at the top of the window allows you to filter the list by entering a search string. All items are exported under their labels. Clicking Export creates an XML file containing the data of the user types you selected. If you have not selected any user type, the error message Nothing to export displays.

Import User Types

You can import user types from an XML file. The imported user types replace the existing user types, if any.

The Import user types window allows you to select the XML file containing the user-types data. Import can process only XML files. If a file of any other type is selected, the import is rejected and an Import file type must be XML error message displays. Before importing a user type, the application checks to ensure that its entities (such as resource types, permissions, and context layout items) are valid.

Note: You cannot import your own user type. Your user type must be imported by a user of a different user type. For example, if your user type is Admin1, you cannot import it. You can create another user type Admin2, and Admin2 can import Admin1.

Validation messages are as follows:

- Successfully imported: The user type is imported successfully.
- Imported with warnings:
  
  One or more entities is invalid, but the user type is imported.
- Not imported: The user type is missing critical data and has not been imported.

During the import process, a progress window displays the following information:

- A number in the Import column means that the number of imported items differs from the number of validated items.
- A green check mark means that the number of validated items is identical to the number of imported items.

The User type import details window displays the details of all successfully imported user types, user types imported with warnings, and user types that were not imported.
Manage Users

You must first configure several user-type settings, so that a user type can create and manage other users.

1. On the General tab, do the following:
   a. In Can create users of the following user types, select all the user types from which users can be created.
   b. In Access settings, ensure that the Allow access via Manage option is enabled.

2. On the Screen configuration tab, do the following:
   a. Ensure that the Main menu items context includes the Users screen with the read-write visibility.
   b. Ensure that the Company Configuration context includes the User Types screens with the read-write visibility.

Manage Your Own User Type

Any user can change his or her user type.

You can change your user type when you configure the My Display context layout so that it contains the User Type field with read-write visibility. However, the available options include only the user types defined in the Can create users of the following user types field of the current user type, and your own user type must be among the user types selected in the field. Otherwise, the User Type field appears as read-only, even when its visibility has been defined as read-write. The following figure shows the My Display screen that lets you change the user type:

⚠️ **CAUTION:** Be very careful when changing your own user type. Your new user type might have different visibility and access settings that may make reverting to the previous user type impossible.
User Groups and User Permissions

User Groups and User Permissions are part of the tools used to manage Oracle Field Service Cloud Collaboration Cloud Service functionality settings.

User Groups are used to create roles, structure, and assign permissions. The user group list displays name and membership information, group description, and status. The User Permissions section provides a list of users that have access to Oracle Field Service Cloud Collaboration Cloud Service. For more information about User Groups and User Permissions, see the Oracle Field Service Cloud Collaboration Cloud Service User Guide.

Work Schedules

Create and Delete Work Schedules

Work schedules are templates made up of a combination of shifts (working time) and non-working times. When grouped as a work schedule, these shifts can be applied all at once to a bucket or to an individual resource.

1. Click Configuration.
2. In the General section, click Work Schedules.
   The Work Schedules screen appears.
3. Click Add work schedule.
   The Add work schedule window appears.
4. Enter a name and a unique label for the new work schedule.
   While the name must be representative of the work schedule time frame, there is no functional correlation between the name and the shifts that will be contained within the schedule.
5. Select the Active check box if you want the work schedule to be visible for assignment.
6. Click OK to save the work schedule.
7. To delete a work schedule, select the check box and click Delete.

Note: You cannot delete a work schedule if it is currently assigned to a resource. You must remove it from the resource or bucket first, and then delete it from the list.

Add Shifts to a Work Schedule

After you have created a work schedule, you can add the shifts and non-working times that will be included in the overall period of time.

1. Click Configuration.
2. In the General section, click Work Schedules.
   The Work Schedules screen appears.
3. Click Items to the right of the work schedule that you want to add a shift to.
   The shift list for the selected work schedule appears.
4. Click Add Shift.
   The Add shift window appears.
5. Click the Shift drop-down menu to view the available shifts.
6. Select a **Start date** and **End date** for the period of time that this shift should be associated with the work schedule. Leaving the End date field empty implies that the shift will be a part of the work schedule indefinitely.

7. Add any comments for clarification or detail.

8. Select one of the following options in the **Repeats** drop-down menu:
   - Daily – Allows for inclusion of the shift such as every other day or every 3rd day. This option requires a value in the field labeled every _____ day(s).
   - Everyday – The shift applies to everyday without exception.
   - Weekly – Allows for shifts that are used on a regular weekly pattern. Select the days that apply to this particular shift using the check boxes for the individual days. Indicate the frequency of this pattern weekly by adding a value to the every ____ weeks(s) field.
   - Yearly – Select a date range for the shift that will recur every year.

9. Click **OK** to save the shift to the work schedule.

10. Repeat the steps for each additional shift that you want to apply to this work schedule.

### Add Non-Working Time to a Work Schedule

In addition to shifts, you may apply non-working time to certain work schedules. This could accommodate work schedules that include non-standard work time such as four-day workweeks or even holidays that occur on the same day every year. Keep in mind that many of the non-working reasons (illness, bereavement, etc.) tend to be used more frequently on a one-off basis for individual resources as days off occur.

1. Click **Configuration**.

2. In the **General** section, click **Work Schedules**.
   The **Work Schedules** screen appears.

3. Click **Items** to the right of the work schedule that you want to add non—working time to.
   The selected work schedule appears.

4. Click **Add non-working time**.
   The **Add non-working time** window appears.

5. Complete the following fields:
   The following table describes the fields available on the **Add non-working time** screen:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift Type</td>
<td>Select from <strong>Regular</strong> or <strong>On Call</strong> depending on which shift type you want the non-working reason to be associated with.</td>
</tr>
<tr>
<td>Reason</td>
<td>Select the applicable reason from the drop-down menu. This list is populated from entries in <strong>Company Settings</strong>. <strong>Non-Working Reasons</strong>.</td>
</tr>
<tr>
<td>Start Date</td>
<td>End Date</td>
</tr>
<tr>
<td>Comments</td>
<td>Enter any comments about the non-working reason. If <strong>Other</strong> is selected as a reason, then the <strong>Comments</strong> field becomes mandatory.</td>
</tr>
<tr>
<td>Repeats</td>
<td>Select the appropriate option from the drop-down menu. Options are:</td>
</tr>
<tr>
<td>Daily – Allows for inclusion of the shift such as every other day or every 3rd day. This option requires a value in the field labeled every _____ day(s).</td>
<td></td>
</tr>
<tr>
<td>Everyday – The shift applies to everyday without exception.</td>
<td></td>
</tr>
<tr>
<td>Weekly – Allows for shifts that are used on a regular weekly pattern. Select the days that apply to this particular shift using the check boxes for the individual days. Indicate the frequency of this pattern weekly by adding a value to the every ____ weeks(s) field.</td>
<td></td>
</tr>
</tbody>
</table>
Configure Oracle Field Service Cloud

Field | Description
--- | ---
Yearly | Select a date range for the shift that will recur every year.

Date Selections | Enter the date selections based upon the previous selection. Dates are inclusive.

6. Click **OK**.
The new non-working reason is added to the work schedule.

Work Skills

Work skill is the job-specific skills necessary to perform an activity. These act as a defining criteria to match activities with the resources.

The **Work Skills** feature lets you to capture the task attributes to assign the work. Work skills identifies the following attributes:

- The expertise of a resource
- The expertise required to perform an activity

You must create the work skills and then assign them to the resources and work skill conditions.

Create a Work Skill

Work skills are client-specific sets of skills or competencies required of their resources to perform their assigned activities.

1. Click **Configuration**.
2. In the **General** section, click **Work Skills**.
   The **Work Skills** screen appears.
3. Click **Add new**.
   The **Add work skill** window appears.
4. Complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for the work skill in at least one of the language fields (for example, New Install, Video, Outage, etc.). This is the wording that will appear to users within the application.</td>
</tr>
<tr>
<td>Label</td>
<td>Enter a unique string for this work skill. This is how the work skill will be identified within the database.</td>
</tr>
</tbody>
</table>
   | Sharing of the skill in the team | Select from the drop-down menu: Maximal — Team gets the maximal work skill level of all the team members (default).
   | | Minimal — Team gets the minimal work skill level of all the team members.
   | | No Sharing — This work skill, if assigned to a team member, it does not affect skills of the team.
   | | Summary — Team gets the total sum of work skill levels of all the team members. The work skill sharing parameters will define if a specific activity can be assigned to a team-holder but not higher than 100. |
Configure Oracle Field Service Cloud

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Select the check box to activate. If active, the work skill and its conditions are used by the routing engine. If inactive, the skill and its conditions still exist but are not used by the routing module.</td>
</tr>
</tbody>
</table>

Work Skill Sharing Example

Team gets the total sum of work skill levels of all the team members. The work skill sharing parameters will define if a specific activity can be assigned to a team-holder but not higher than 100. In this example, we will consider how sharing influences work skill allocation in the group. Keep in mind that if a resource is assigned a group of work skills (G) and some work skills explicitly (WS), in case of intersection the explicitly assigned work skills will prevail. Resource that is not assigned any work skills is considered to obtain all the work skills with 100 qualification.

<table>
<thead>
<tr>
<th>Work Skills</th>
<th>Team Holder</th>
<th>Team Member 1</th>
<th>Team Member 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>WS0 - Maximal</td>
<td>WS0 (100)</td>
<td>G: [WS0 (1), WS1 (1), WS2 (1), WS3 (1), WS4 (1)]</td>
<td>WS4 (10)</td>
</tr>
<tr>
<td>WS1 - Maximal</td>
<td>WS3 (100)</td>
<td></td>
<td>G: [WS0 (20), WS2 (20)]</td>
</tr>
<tr>
<td>WS2 – No Sharing</td>
<td>G: [WS3 (10), WS4 (10)]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WS3 - Minimal</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Effective work skills of the team-holder:

- WS0(100) - Maximal(100, 1, 30)
- WS1(1) - Maximal(0, 1, 0)
- WS2(0) – No Sharing (0, 1, 30), team-holder doesn’t have this skill
- WS3(0) - Minimal(100, 1, 0)
- WS4(21) – Summary (10, 1, 10)

Delete, Activate, or Deactivate a Work Skill

You cannot delete a work skill that is currently assigned to at least one resource. You can set the active/de-active status at any time.

1. Click **Configuration, Work Skills**.
   The **Work Skills** screen appears.
2. Select the check box next to the work skill that you want to delete, activate, or deactivate.
3. Click **Delete, Activate**, or **Deactivate**.
4. Click **OK**.

Temporary Work Skills

Determine the skills required to perform an activity and the skills of the technicians. Based on these technician skills activities are assigned to perform.

This feature allows you to set up a date range during which a skill is considered actual. These settings are part of the work skill settings of a resource and define the period during which the resource is considered having a certain skill of a certain level. This feature is helpful when some skills require periodic certification, some equipment is available for limited time only and if a planned maintenance is scheduled which requires special skills.
If no work skills have been explicitly assigned to a resource, the resource is assumed to permanently have all work skills configured in the system with the maximum ratio. If any work skills have been assigned, the resource has only those work skills with the specified ratios.

**Related Topics**
- Video: Assign temporary work skills

**Define a Temporary Work Skill**
Set up the assignment period for each work skill or work skill group assigned to a resource. When a work skill or work skill group is selected for a resource, its start and end dates can be defined in the calendar.

1. Open **Settings > Resource Info > Work Skills**
2. Click the add (plus) button.

   The **Add Work Skills** window opens, as shown in the following figure:

3. Select the appropriate work skills from the list.
4. (Optional) Assign the work skill ratio.
   If the ratio is not defined, the resource is considered to have the maximum work skill ratio of 100.
5. Select the **From** and **To** dates of the skill assignment period from the Calendar.
   
   By default, the start date is always set to the current date making the work skill applicable immediately. If the start date is changed to a past date, it will still be replaced with the today’s date, as the application does not support changes to past data. The end date can be left blank to mark the skill assigned permanently
6. Click **Save**.

The work skill is assigned to the resource separated with semi colons. The name of each work skill is followed by its ratio and assignment dates in parentheses. The work skills are displayed according to the following rules:

- Work skills terminated in the past are not displayed
- Assignment dates are shown in the ‘from… to…’ format. When the start date is in the past, from date is not shown. When end date is not set, to date is not displayed.
If a work skill level is set to 100, the level is not displayed.

Inactive work skills are shown in gray font.

**Note:** If the resource is not assigned with the work skills, the resource is assumed to permanently have all the work skills configured in the system with the maximum work skill ratio.

**Related Topics**
- Video: Assign temporary work skills

**Edit Work Skills**

Update the work skills of a resource along with the assignment periods and work skill ratios. You can also delete the work skills of a resource.

1. Open **Settings > Resource Info > Work Skills**
2. Click edit button.

The **Edit Work Skills** window opens, as shown in the following figure:

3. Update the changes and click **Save**.

The work skills are updated based on the following rules:

- Overlapping records with same work skill and same ratios are automatically merged into one. The start date of the merged record is the **To** date of the first record, and the end date of the merged record is the **From** date of the latest record.

- Records with same work skills and different ratios will not be merged. Two different records are created. However, if their assignment periods overlap, the input is rejected with the message, Overlapping of intervals for the same skills is not allowed. The assignment periods have to be adjusted so that they no longer overlap. The following figure shows the **Work skills** screen, where you have tried to add the same work skill with overlapping intervals, and the corresponding error message:
If a work skill is deleted, it is marked terminated on the previous day.

If a work skill is updated, the old work skill is marked terminated on the previous and the new work skill record starts from the current date.

Work Skill Conditions

To ensure that a resource has the ability to perform subsequently assigned activities, a correlation must be made between incoming activity skill requirements and the skills specified for each resource. The Work skill functionality is what that correlation is based on. Work skills are set up first, and then are assigned to resource records, with the appropriate levels of qualification set for each.

Incoming activities are also assigned Work Skills, which are then matched up with resources with corresponding skills during routing. For the application to know which Work Skills to assign to the activities, however, another correlation must be made. This correlation is referred to as Work Skill Conditions – criteria that is based on certain field values of activities. Work Skill Conditions are what the application uses to define which Work Skills should be assigned to activities. Each Work Skill has at least one condition that refers to a specific field and value in the incoming activity record. An example of this could be where an install Work Skill’s condition is to look for the field/value of “WO_TYPE = 1” (“1” being code for an install). If this condition were found within the activity record, then the application assigns that Work Skill to the activity.

- The application assigns as many work skills to an activity record as there are conditions found.
- If multiple works skills are assigned to an activity, then the same list of skills must be associated with a resource record in order for that resource to be considered for that job.
- If required and preferred skill levels are used to define Work Skills and conditions, then routing matches activities to available resources with equal or higher qualifications of the skills as it determines who should be assigned which activities.

Create a Work Skill Condition

A work skill condition correlates incoming activity skill requirements with the skills possessed by resources. Work skill conditions are used to determine which activities are assigned to which resources.

You must add work skills before adding work skill conditions.

1. Click Configuration.
2. In the General section, click Work Skills.
3. Click Work skill conditions.
   - The Work skill conditions screen appears.
4. Click Add new.
The **Add work skill condition** dialog appears.

5. Complete the following fields:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work skill name</td>
<td>The work skill for which you want to add a condition. These work skills are created in the Add work skill dialog.</td>
</tr>
<tr>
<td>Required level</td>
<td>The minimum qualification level of the skill a resource must have, to be considered for the activity. Only resources that have the required level or better skills are selected for the activity.</td>
</tr>
<tr>
<td>Preferable level</td>
<td>If more than one resource meets or exceeds the required level, then the one(s) with the level that is closest in number to the “preferable level” is selected for the activity.</td>
</tr>
<tr>
<td>Add new condition</td>
<td>A new condition for the work skill. Three new fields appear. Select the field for which you want to add the condition and select the condition. For example, suppose you want the work skill Install to be assigned to a technician who has a minimum skill level of 75, for work order types IN. Select the Work skill name as Install, enter 75 for Required level, click Add new condition and then select W/O Type, In, and IN.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

The work skill condition is saved. When a new activity is added, these work skill conditions are used to determine which work skills are assigned to the activity.

### Work Skill Groups

#### Create a Work Skill Group

You can bundle selected work skills into work skill groups; this creates greater ease and flexibility for assigning skills to resources. You can continue to assign individual work skills along with work skill groups, creating a more accurate resource work skill record. Work skill groups must also be defined to be used for capacity categories, if different work skills must consume quota from a single capacity category.

1. Click **Configuration**.
2. In the **General** section, click **Work Skills**.
3. Click **Work skill groups**.

The **Work skill groups** screen appears.

4. Click **Add new**.

The **Add work skill group** window appears.

5. Complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the work skill group name. If you have set multiple languages for the application, input boxes appear for the different languages.</td>
</tr>
<tr>
<td>Label</td>
<td>Enter a unique identifier for this work skill group.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to make this work skill group active.</td>
</tr>
<tr>
<td>Can be assigned to a resource</td>
<td>Select the check box if you want the work skill group to be able to be assigned to a resource record. If a group is assigned to a resource, then that the resource obtains all the work skills defined for the group.</td>
</tr>
</tbody>
</table>
6.  Click **Save**.

   The **Work skill groups** screen appears.

7.  Click the pencil icon in the **Work Skills** cell to add work skills and their qualification level.

   The **Edit work skill** window appears.

8.  Click to select the work skill and activate the Qualification Level field.

9.  Click **Save** when done.

10. To modify a work skill group, click the **Name** cell.

    The **Edit work skill group: [Work skill group name]** window appears, which is similar to the **Add work skill group** window.

### Delete a Work Skill Group

You can bundle selected work skills into work skill groups; this creates greater ease and flexibility for assigning skills to resources. You can continue to assign individual work skills along with work skill groups, creating a more accurate resource work skill record. Work skill groups must also be defined to be used for capacity categories, if different work skills need to consume quota from a single capacity category.

1.  Click **Configuration**.

2.  In the **General** section, click **Work Skills**.

3.  Click **Work skill groups**.

   The **Work skill groups** screen appears.

4.  Select the check box next to the work skill group that you want to delete.

5.  Click **Delete**.

6.  Click **OK**.

### Work Zones

A work zone is the defined geographical area within which a resource can perform activities. Work zones are defined within the work zone dictionary, and are then assigned to resource records.

A temporary work zone is a work zone that is not a resource’s typical work zone, but that is assigned to the resource for a specific period of time. Temporary work zones override a resource’s regularly assigned work zones. A work zone key consists of a field (or combination of fields) and length-specific values, that when identified within an activity record, determines which work zone gets associated with that activity. You can view, add, and modify work zones from the **Work Zone** screen.

Routing assigns activities to resources taking into account the work zones of those resources and assigning only those activities that are within his or her work zone.

### Add a Work Zone

Work Zone is unique to each company and reflects how geographic regions are divided for more effective and efficient routing.
Ensure that you have added the required travel areas.

1. Click **Configuration**.
2. In the **General** section, click **Work Zones**.
   - The **Work Zones** screen appears.
3. Click **Add new**.
   - The **Add Work Zone** window appears.
4. Fill up the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Zone Name</td>
<td>A meaningful name to describe the group of Work Zone key values that make up the Work Zone.</td>
</tr>
<tr>
<td>Work Zone Label</td>
<td>A unique identifier for the Work Zone.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the Work Zone—active or inactive.</td>
</tr>
<tr>
<td>Delimiter</td>
<td>Choose whether commas separate locations in the Work Zone Keys list or each location appears on a new line.</td>
</tr>
<tr>
<td>Travel Area</td>
<td>A higher level bundling of zones used by the application’s statistics engine.</td>
</tr>
<tr>
<td>Work Zone Keys</td>
<td>Values within and formatted as defined by the overall Work Zone field key, that will positively associate an incoming activity with a particular Work Zone.</td>
</tr>
<tr>
<td>Actions</td>
<td>Click <strong>Modify</strong> to edit the Work Zone.</td>
</tr>
<tr>
<td>Work Zone Shapes</td>
<td>Work Zone shapes are used as visual representations of Work Zones on the map and, as a tool for yet more subtle definition of Work Zones. For example, if the company chooses to define its Work Zones by city names or postal codes the Work Zones may be rather large. At the same time, several shapes can be attached to the Work Zone dividing it into geographically smaller areas. This way, one team can work in one shape and another team—in another shape while still working in the same Work Zone. Work Zone shapes are displayed in Core Manage and Mobility. If used, enter the shape identifier. The property serving as the shape identifier is defined during the shape configuration via the Metadata API. For example, if ZIP code is used as shape identifier, enter one or more ZIP codes associated with Work Zone shapes.</td>
</tr>
</tbody>
</table>

5. Click **Add**.
   - The Work Zone is saved.

⚠️ **Note:** The Work Zone identifiers must be unique. If the identifier has already been used for another Work Zone, the input is rejected with the error message: Key (identifier) conflicts with key (identifier) of Work Zone (work_zone_name).

**View Work Zone**

Work Zone is unique to each company and reflects how geographic regions are divided for more effective and efficient routing. The keys that define zones can be anything with geographic relation—a zip code, address portion, network items (nodes, sub-nodes...), map grids, or even geo-coding.

1. Click **Configuration**.
2. In the **General** section, click **Work Zones**.
   - The **Work Zones** screen appears and displays the following fields:
### Field Service Cloud

**Administering Oracle Field Service Cloud**

**Chapter 1**

### Configure Oracle Field Service Cloud

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>System-generated number used to identify a unique Work Zone.</td>
</tr>
<tr>
<td>Status</td>
<td>The Work Zone can be active and available for routing or inactive and not available for routing. Green tick mark indicates active and red cross indicates inactive.</td>
</tr>
<tr>
<td>Work Zone Name</td>
<td>A meaningful name to describe the group of Work Zone key values that make up the Work Zone.</td>
</tr>
<tr>
<td>Work Zone Keys</td>
<td>The exact values that can be found within the primary key (field) that are used to associate the activity record with a Work Zone.</td>
</tr>
<tr>
<td>Actions</td>
<td>Click <strong>Modify</strong> to edit the Work Zone.</td>
</tr>
<tr>
<td>Shapes</td>
<td>Link appears if one or more shapes have been added to at least one Work Zone. Clicking <strong>Shape</strong> opens the map showing the shapes associated with the selected Work Zone. For adjacent shapes the map shows one common area formed by the combined shapes.</td>
</tr>
</tbody>
</table>

3. Click **View** to filter the Work Zones.

## Modify a Work Zone

After you create a Work Zone, you cannot delete it, but you can activate or deactivate it. You can also modify the work zone by changing the name, or by adding or removing locations from it.

1. Click **Configuration**.
2. In the **General** section, click **Work Zones**.
   
   The **Work Zones** screen appears.
3. Click **Modify** for the Work Zone that you want to modify.
   
   The **Edit Work Zone** window appears.
4. Change as required and click **Update**.
   
   Current activities are recalculated per the modifications. Any future activities will be routed according to the newly modified Work Zones. For precautionary reasons, any Work Zone changes must be performed outside of the application’s peak usage time.

> **Note:** Changing the status of a Work Zone to **Inactive** stops routing from using the Work Zone or any of its locations.

## Modify a Work Zone Key

A work zone key helps you identify a work zone with a short name. The work zones that you create are automatically assigned with the key or convention that you define in the **Work Zone Key** dialog. By default, City is the work zone key in the application.

1. Click **Configuration**.
2. In the **General** section, click **Work Zones**.
3. Click **Modify** next to Work Zone Key in the header area.
   
   The **Work Zone Key** dialog appears.
4. To retain City as the key and just change the length of the key, change the number in the **Length** field. In the next field, select whether you want the entire key as case insensitive, or just the first letter.
5. Click **OK**.
   
   The existing work zone keys are modified to conform to the new configuration.
6. To add a new field as the key, click the plus icon in the **Work Zone Key** dialog. The list of fields available in the application is displayed in alphabetical order.

7. Select a field of your choice and click **Add**. The newly added field is displayed in the **Work Zone Key** dialog.

8. Add the length of the key in the **Length** field. In the next field, select whether you want the entire key as case insensitive, or just the first letter.

9. Click **OK**. The modifications are applied to the existing work zone keys.

**Export and Import Work Zones**

You can export and import Work Zones to move the information between two instances. You can export and import Work Zones either through API or through the user interface. The Export and Import buttons available on the **Work Zones** screen.

1. Click **Configuration > Work Zones**.
2. Click **Export**. An XML file is generated with the following information:
   o XML format and product version
   o Information about Work Zone keys
     - field
     - property (can be present only if ‘field’ equals ‘property’)
     - function (‘case insensitive’ or ‘first word case insensitive’)
     - length
     - order
   o Information about Work Zones:
     - Work Zone name
     - travel area
     - status (active or inactive)
     - Work Zone shapes
     - Work Zone keys (order and formula are taken into account)
3. To import Work Zones, click **Import**. You can import only the Work Zones that are exported from this application.
4. Click **Browse** and select the file that you want to import and then click **Import**. The Work Zones are imported based on the following rules:
   o Work Zone keys and shape IDs for imported Work Zones must be unique. If either of them is not unique, the Work Zone is not imported.
   o If a Work Zone is present in the company configuration and is absent in the imported XML file, the Work Zone is deactivated.
   o If a Work Zone is present in both, company configuration and imported XML file, it is updated if valid.
   o If a Work Zone is absent in the company configuration and is present in the imported XML file, it is created if valid.

The Work Zones are imported and the summary of results is displayed. The results show the number of successfully imported Work Zones and number of Work Zones which failed to import.

**Related Topics**

- Example of Work Zone Export XML Structure
Example of Work Zone Export XML Structure

When you export Work Zones, an XML file is generated. This topic provides a sample structure.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<workZones formatVersion="1" productVersion="16.8.0">
  <workZoneRules>
    <rule field="ccity" collation="case insensitive" length="4" order="0" />
  </workZoneRules>
  <items>
    <item status="active" travelArea="sunrise_enterprise" workZoneLabel="ALTAMONTE SPRINGS" workZoneName="ALTAMONTE SPRINGS">
      <keys>
        <key>alta</key>
      </keys>
      <shapes>
        <shape>cass</shape>
        <shape>gene</shape>
      </shapes>
    </item>
    <item status="active" travelArea="sunrise_enterprise" workZoneLabel="TEX" workZoneName="TEXAS">
      <keys>
        <key>andr</key>
        <key>colo</key>
        <key>kerm</key>
        <key>lubb</key>
        <key>midl</key>
        <key>odes</key>
      </keys>
      <shapes>
        <shape>wint</shape>
        <shape>port</shape>
      </shapes>
    </item>
  </items>
</workZones>
```
2 Integrate with Oracle Knowledge Cloud

About the Integration

Customer field personnel, such as dispatchers and technicians, can enable integration between Oracle Service Cloud, Oracle Knowledge Advanced Cloud, and Oracle Field Service Cloud in order to access the Oracle Knowledge Advanced Cloud knowledge base content within their Oracle Field Service Cloud application.

Quick answers to customer questions or other information on activity-related topics can then be found without having to leave the Oracle Field Service Cloud application.

Prerequisites

Complete the following prerequisites:

- The administrator or web developer must first complete the steps found in: Administration Steps to Configure Oracle Service Cloud Customer Portal for Oracle Knowledge Advanced Integration with Oracle Field Service Cloud. For more information, see the Knowledge Base article Configuring Oracle Service Cloud Customer Portal for Oracle Knowledge Advanced Integration with Oracle Field Service Cloud.
- You must have an implementation of Oracle Service Cloud and Oracle Knowledge Advanced Cloud configured within Oracle Service Cloud, and Oracle Field Service Cloud installed and configured.
- You must own a license to use Oracle Knowledge Service Cloud in order to integrate Oracle Knowledge Service Cloud with Oracle Field Service Cloud.

Related Topics

- Access Oracle Knowledge Service Cloud in Core Manage Cloud Service
- Access Oracle Knowledge Service Cloud in Mobility Cloud Service
- Configure Access Settings
- Enable Access

Configure Access Settings

Before using Oracle Knowledge Service Cloud, you must configure several basic settings in Oracle Field Service Core Manage Cloud Service.

To complete the setup process, you need a user name and password. Contact your Oracle Support representative for assistance.

1. In Oracle Field Service Core Manage Cloud Service, go to Configuration > User Types.
2. Select a user type, and then select the Screen configuration tab.
3. Select Company Configuration from the list of contexts.
4. In the Actions pane, select Oracle Knowledge. If Oracle Knowledge does not appear in the list of actions, click Click to add to find and add it.
5. On the Add action screen, add a new Oracle Knowledge read/write visibility.
6. Click Close.
7. Click Configuration to return to the Configuration screen. The Oracle Knowledge icon now displays in the Subsystems and Integrations section.
8. Click the Oracle Knowledge icon. The Oracle Knowledge configuration screen displays, as shown in the following figure:

![Oracle Knowledge Configuration Screen](image)

The screen contains two sections:

- **Knowledge access**— complete the following fields:
  - URL: The URL to access the knowledge base.
  - User Name: User name is a concatenation of your Oracle Field Service Cloud user name and the string &p_li_passwd followed by the value of PTA_SECRET_KEY. For example, 'john.smith&p_li_passwd=ThisIsASecret'.
  - Password: Your Oracle Field Service Cloud password.

- **Knowledge fields mapping**— provides the possibility to configure the parameters of the context search and filtering, based on activity properties.

![Knowledge Fields Mapping](image)

- **Note**: By default, the fields in this section are not used, and configuring these properties is optional. If you do not make any selections, no context search will be executed. You can, however, specify your search criteria manually on the Oracle Knowledge page.

9. Select the desired search, category, and product properties from the drop-down lists.
10. Click Save.

The search engine uses the value of the selected search activity property as an initial search query to scour the Oracle knowledge base. The results of the search are then filtered by the selected category and product activity properties. Subsequently, the Oracle Knowledge page will show those information articles relevant to the parameters of the current activity when opened.
Access Oracle Knowledge Service Cloud in Mobility Cloud Service

You access Oracle Knowledge Service Cloud in Oracle Field Service Mobility Cloud Service by clicking the **Knowledge** tab on the **Activity details** screen, as shown in the following figure:

When you click the **Knowledge** tab, the Oracle Knowledge Service Cloud screen displays the knowledge articles relevant to the activity from which you accessed them.

These articles are a result of the context search that is based on the activity-related search parameter and filters configured on the **Oracle Knowledge** configuration screen. The search field located on the top of the page displays the search query that was used for the current search, based on the configuration settings. You can enter a new query or change the filter parameters to refine the search.

If no prior search configuration has taken place, the screen displays an empty search field without any search results.
Access Oracle Knowledge Service Cloud in Core Manage Cloud Service

You access Oracle Knowledge Service Cloud in Oracle Field Service Core Manage Cloud Service by clicking the **Knowledge** tab on the **Activity details** screen, as shown in the following figure:

When you click the **Knowledge** tab, the Oracle Knowledge Service Cloud screen displays the knowledge articles relevant to the activity from which you accessed them.

These articles are a result of the context search that is based on the activity-related search parameters and filters configured on the **Oracle Knowledge** configuration screen. The search field located on the top of the screen displays the search query that was used for the current search, based on the configuration settings. You can enter a new query or change the filter parameters to refine the search.

If no prior search configuration has taken place, the screen displays an empty search field without any search results.
Enable Access

After you configure Oracle Knowledge Service Cloud in Oracle Field Service Core Manage Cloud Service, you can enable access to the feature in Oracle Field Service Core Manage Cloud Service and Oracle Field Service Mobility Cloud Service by creating a Knowledge tab on the Activity details screen.

1. In Oracle Field Service Core Manage Cloud Service, go to Configuration > User Types.
2. Select a user type, and then select the Screen configuration tab.
3. Do one (or both) of the following:
   a. Go to Step 4 for Oracle Field Service Core Manage Cloud Service.
   b. Go to Step 5 for Oracle Field Service Mobility Cloud Service.
4. Do the following to add the Knowledge tab to Oracle Field Service Core Manage Cloud Service:
   a. In the Manage section, click Add activity/Activity details.
   b. In the Layout structure pane, first click Activity status, and then click Group.
   c. On the Add to group window that displays, enter a name for the tab.
   d. Select Predefined Tab as the type, and then select Knowledge as the tab type.
   e. Click Submit.
   f. On the new activity screen that displays, add a new read-write visibility and click Save.
      Your changes are saved and all current activities are automatically recalculated.
5. Do the following to add the Knowledge tab to Oracle Field Service Mobility Cloud Service:
   a. In the Mobility section, click Edit/view activity.
   b. Find (or search for) Knowledge/activity_knowledge in the Actions section and drag-and-drop it to the desired location in the set of tabs on the right.
   c. Ensure that the visibility setting is read-write, and click Save.

Related Topics

• About the Integration
• Access Oracle Knowledge Service Cloud in Core Manage Cloud Service
• Access Oracle Knowledge Service Cloud in Mobility Cloud Service
• Configure Access Settings
3 Integration Channels

Daily Extract

Daily Extract is used to report on the main Oracle Field Service Cloud entities, such as activities, inventory, and messages, for storage and further analysis. Extracted data is stored in the Daily Extract Database as a package of XML files. You can create or update a Daily Extract configuration by importing the configuration from an external source.

Configure Daily Extract

The set of files to be extracted by Daily Extract can be configured manually at the implementation stage. At a later stage they can also be modified when necessary. In addition, you can also configure custom Daily Extract file sets in the Manage Application screen. Access to the Daily Extract configuration functionality is controlled by adding a read/write visibility to the User Type that requires access to the Daily Extract report.

Daily Extraction Files

Daily extract files are the result of data processing by the application and contain the details such as activities, inventory, and messages. Only data structures described in this document can be received as part of the Daily extract. To get access to other data elements of the application, different interfaces should be used (e.g. Resource Management API). The extracted files are intended for reporting and historical analysis of the events in the application.

Extraction Period

Daily extract files are typically generated once a day and contain all data the processing of which has been finished since the previous extraction. If the company does not support overnight shifts, the extraction period covers time since the previous extraction and till the end of the previous day. If the company supports overnight shifts, the daily extract data for the previous day are available for extraction after the overnight expiration, that is, at 00:00 AM + overnight. If the data is extracted before that time, the resulting files contain data of two days before.

A company can operate in several time zones, however, the Daily Extract functionality extracts data according to the time zone defined for the company in the Business Rules. Only the following files are extracted in GMT:

- General Message Details
- Message Text Details
- PAS Answer Details
- Gpstracks Details

Upon the first extraction all available data is collected. The maximum Daily Extract archive file size supported is:

- For archive with .xml files - 5 GB
- For archive with property files - 5 GB
Create Daily Extract Files

Daily extract files are the result of data processing by the application and contain the details such as activities, inventory, and messages. Only data structures described in this document can be received as part of the Daily extract. To get access to other data elements of the application, different interfaces should be used (e.g. Resource Management API). The extracted files are intended for reporting and historical analysis of the events in the application. You can configure the files to be extracted by the Daily Extract report manually at the time of implementing the application. The daily extract files are always created in XML format.

1. Log in to Oracle Field Service Cloud Manage interface.
2. Select the Navigation button.
3. Click Configuration.
4. In the Outbound Integration section, click Daily Extract.
   The Daily Extract screen appears. The screen displays the list of files for extraction organized as a grid. For each file name the list shows the entity to which the extraction file is related (the Entity column) and the fields exported in the file (the Exported field column).
5. Click Add new.
   The Add configuration file window appears.
6. Enter the Table Name.
   The table name must be in the {COMPANY_NAME}-company identifier format. The place holder {COMPANY_NAME} is mandatory. If you specify an incorrect format, the file is not created.
7. Select the fields that you want to export from the Entity drop-down menu.
8. Click Submit.
   The new file configuration is saved. When you edit the configuration, you can only edit the file name and not the entity.

Choose Daily Extract Fields to Export

A new daily extract file is created empty and for the export to work, you must specify the fields to be exported. In addition, you must specify a minimum of two fields for the export to work.

1. Click Configuration.
2. In the Outbound Integration section, click Daily Extract.
   The Daily Extract screen appears.
3. Click the stack menu to the right and click Fields to add fields to the entity.
4. Click the plus icon and select the required field that you want to add to the entity.
5. Select a field to view its properties. Change the Name if required.
   You can arrange the list of properties by dragging and dropping. You cannot change property names for the GPS Track Fields, Type List Fields and Property File Fields entities. If a custom property is deleted from the application, you must also delete it from the field list of any daily extract files; otherwise the extraction returns an error.
6. Click Ok.
Extraction Files and Extraction Data Sets

Data on details of different entities processed during the extraction period or available by the end of extraction period can be collected and extracted in the files (in this document during the extraction period means that if at any time during the extraction period the entity was available in the system it will be extracted, and by the end of extraction period means that if an entity was created at some time during the extraction period and was deleted before the end of extraction period, it will not be extracted).

This data can be divided into data sets, that is, groups of details related to one and the same entity in the system. In some cases data related to one entity is divided in several different data sets.

Note: Data from several data sets cannot be extracted in one file but data from one data set can be divided to be extracted in any number of files. For example, the file created for the Activity Fields entity cannot also include data for the Resource Fields entity. At the same time, one file can refer to several database tables according to the exported field’s configuration. For example, an Activity Fields file may include data from the queue table, when configured so.

The following data sets are available for export. The actual list of data sets to be exported can be configured according to your company preferences.

- Activity Fields – Data on all fields/properties assigned to activities that were to be performed or were performed.
- Activity Link Fields – Details of all links between activities defined in the application.
- Activity Work Skill Fields – Details of work skills per activity.
- GPS Details – Details of all GPS data gathered.
- Inventory Fields – Data on all fields/properties assigned to all inventory items available in the system.
- Message Details – Data on all messages generated during the extraction period divided into two data sets:
  - Message Fields – Details on the messages excluding the actual text of the message.
  - Message Text Fields – The text of each specific message.
- PAS Answers Fields – Details of the customer’s answers to questions asked in the Post Appointment Survey that are present in the system with status Delivered.
- PAS Questions Fields – Details of questions for Post Appointment Surveys.
- Property Fields – Details of all fields and custom properties available in the system.
- Property File Fields – Contents of file properties (images, etc.) available in the system.
- Property Lookup Fields – Sets of values that can be used to identify a field or custom property for all fields and custom properties available in the system.
- Queue Fields – Data on all fields/properties assigned to routes that were to be executed during the extraction period, including all fields and properties assigned to resources, to which a route is directly assigned.
- Resource Fields – Details of the properties of all resources available in the system (including inactive resources) and their position in the Resource Tree.
- Resource Location Fields – Details of locations defined for each resource in the system.
- Resource Property Fields – Details of all properties defined for each resource in the system.
- Resource Work Skill Fields – Details of work skills per resource.
- Service Request Fields – Details of service requests created in the system.
• Time Slots Fields – Details of time slots defined in the system.
• Type List Fields – Sets of values used to identify the type of entity by its ID for all types available in the system.
• User List Fields – Details of all users existing in the system.
• User-Resource Relation Fields – Details of the resources visible to each user as defined in the system.

 Noticed: Daily Extract processes property labels regardless of whether any special symbols or capital letters are used.

Configure a DBaaS Integration

Use the Outbound Integration icon to create a channel for DBaaS to transfer data in near real time to a DBaaS instance. The data is transferred to the DBaaS instance when the events corresponding to the entities are triggered in Oracle Field Service Cloud. Oracle Rest Data Service (ORDS) is used to standardize the data flow between Oracle Field Service Cloud and DBaaS.

1. Click Configuration.
   The configuration page displays.
2. Click Outbound Integration.
   The Outbound Integration Channels page displays.
3. Click Add Channel to configure a new channel.
   The Add Channel page displays.
4. Select Database as a Service Access from the Channel Type drop-down list and fill up the following fields:
   a. Name: Enter a name for the channel.
   b. Host: Enter the host name for ORDS. It can be an IP address or a domain name, and must start with https.
   c. Schema Alias: Enter the schema alias configured for the target schema, which is used for generating the ORDS end point. The value is same as the parameter p_object_alias in ORDS.enable_object. For PDBs, add the PDB name (<PDB_Name>/object_alias > ) <host_name>/ords/<schemaAlias> For example, PDB1/pdbadmin (For PDB).
   d. User Name: Name of the user used for basic authentication. Make sure that the user has two roles, "SQL Loader" and "oracle.dbtools.autorest.any.schema".
   e. Password: Enter the password of the user used for basic authentication.
   f. Confirm Password: Re-enter the password.
   The screen now looks like the following figure:
A new DBaaS channel is created.
5. Click the DBaaS channel and click Add New to create an entity.
6. Specify the required details in the following fields:
   a. Entity: Select a list of Oracle Field Service Cloud fields that you want to view in the DBaaS instance.
   b. Table Name: Enter the table name that you want to create in the DBaaS instance.
   c. Data Transfer: Select one of the following options:
      - Once Daily: Data is transferred to the DBaaS instance once in a day as per the daily extraction period configured in the system.
      - Real-time: Data transfer from Oracle Field Service Cloud to DBaaS occurs in near real time.
7. Click Submit.
   The entity is added to the channel with the specified details.

Modify an Existing DBaaS Integration

DBaaS connectivity is now available only through Oracle Rest Data Service (ORDS). If you are configuring a new integration, you will be configuring the connectivity through ORDS. However, if you have an existing DBaaS integration, the application displays a note in the DBaaS connection widget and on the Modify Channel page to change the configuration settings. This topic describes how to modify your existing integration to implement ORDS connection details.

1. Click Configuration.
   The configuration page displays.
2. Click Outbound Integration.
   The Outbound Integration Channels page displays.
3. Click the stack icon for the DBaaS channel that you want to modify and click **Modify**.
   The **Modify Channel** page displays, with a note at the Connection Method field, as shown in the following figure:

![Modify Channel Page]

4. Edit the following fields:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Type</td>
<td>The type of the channel you are modifying. The application populates this field and it cannot be edited.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the DBaaS connection.</td>
</tr>
<tr>
<td>Connection Method</td>
<td>The connection method with which you want to connect to the database. Select Oracle Rest Data Services.</td>
</tr>
<tr>
<td>Host</td>
<td>The host name for ORDS, which can be an IP address or a domain name. The host name must start with https.</td>
</tr>
<tr>
<td>Schema Alias</td>
<td>The schema alias configured for the target schema, which is used for generating the ORDS end point. The value is same as the parameter p_object_alias in ORDS.enable_object. For PDBs, add the PDB name (&lt;PDB_Name&gt;/&lt;object_alias&gt;) &lt;host_name&gt;/ords/&lt;schemaAlias&gt;. For example, PDB1/pdbadmin (For PDB).</td>
</tr>
</tbody>
</table>
### Field Name | Description
--- | ---
User Name | The name of the user used for basic authentication. Make sure that user has two roles, "SQL Loader" and "oracle.dbtools.autorest.any.schema".
Password | Password of the user mentioned earlier.
Confirm Password | Retype the password.

5. Click **OK**.

The channel details are modified to use ORDS.
4 Administer Oracle Field Service Cloud

The Administrator Role

The Administrator plays an essential role in the application. The Administrator user type is assigned to an individual or group of individuals who oversee the regular maintenance and updating of users, resources, calendars, and the Resource Tree.

Administrator is responsible for a combination of functions that can include:

- Managing users—Adding new users and inactivating users.
- Assigning user types to users. Resetting passwords.
- Managing the Resource Tree.
- Managing the Resource Calendars, Shifts, Teamwork.
- Working with work zones, work skills, work conditions, and work skills groups.

The Administrator user type is unique to each company and includes any combination of the responsibilities mentioned earlier, depending upon the visibilities assigned to the user type. As a general rule, the user administrator:

- Has read/write access to the Web interface.
- Can manage user and resource related information.
- Can manage own account (password).

Note: This document covers all aspects of an administrator’s role. Based on your company’s configuration and modules purchased, some of the functionality described in this document may not apply.

As an administrator, one of your key responsibilities is to manage user information. There are two primary types of users:

- Users who use the manage aspect, for example, dispatchers and field managers.
- Field service resources who use the mobility aspect, for example, field service personnel.

In either case, a user is someone who requires access to some part of the application’s interface.

Managing Users

You can set up users and maintain their accounts through the Users screen that opens from the Resource Settings drop-down menu. Much of the information that you enter will be standard, based on your company’s login and password policies, but some will be unique to the user and to the role they will play in your configuration. The options included in this section of the Guide include one-time activities as well as those that are updated periodically to conform to changes in the user’s role as well as company policy. For example, if users persist in attempting to log in with an incorrect password, they will be locked out of their accounts. This section describes how to unlock the account and reset the password.
Access User Details

User information is accessed through the **Resource Settings** menu.

1. Select the appropriate Resource level in the Resource Tree, for which you want to view the users. If you want to view all users, select the highest level in the Resource Tree.
2. Click **Resource Settings > Users**.

   By default, all the users that belong to the selected bucket, and their children are displayed. The **Users** screen displays the following columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check box</td>
<td>Select the check box to activate links when you want to unlock, activate, deactivate, or set user type for users.</td>
</tr>
<tr>
<td>User Name</td>
<td>The user’s actual name.</td>
</tr>
<tr>
<td>Login</td>
<td>The name used to log in to the application.</td>
</tr>
<tr>
<td>Resource</td>
<td>Resource record synched to the user account.</td>
</tr>
<tr>
<td>Status</td>
<td>Whether the user is active or inactive. A green tick mark indicates active and a red cross mark indicates inactive.</td>
</tr>
<tr>
<td>Locked</td>
<td>Indicates the login state of the user:</td>
</tr>
<tr>
<td></td>
<td>- Green indicates that the user is active and has logged in successfully.</td>
</tr>
<tr>
<td></td>
<td>- Yellow indicates that the user has entered a wrong password, but the account is not yet blocked.</td>
</tr>
<tr>
<td></td>
<td>- Red indicates either the user is inactive, or the account is blocked.</td>
</tr>
<tr>
<td>Language</td>
<td>Language assigned to user.</td>
</tr>
<tr>
<td>User type</td>
<td>The user type assigned to the user.</td>
</tr>
<tr>
<td>Last Login</td>
<td>Date/time stamp when the user last logged in to the application.</td>
</tr>
<tr>
<td>Main Resource</td>
<td>The resource that this user will use for telemetry and collaboration. This will, typically, be the same as the resource.</td>
</tr>
<tr>
<td>Resource type</td>
<td>The resource type of the user, for example, Technician.</td>
</tr>
<tr>
<td>User classification</td>
<td>The classification assigned to the user—Contingent for contingent workforce, or Regular for a regular user.</td>
</tr>
<tr>
<td>Collaboration Group</td>
<td>The collaboration group that the user is part of.</td>
</tr>
<tr>
<td>Operator of Helpdesk</td>
<td>Whether the user is an operator of a helpdesk.</td>
</tr>
</tbody>
</table>

3. Click **View** to add criteria for filtering the user list.

Activate, Deactivate, or Delete a User

You can control whether a user has access to the application by activating or deactivating them. Active users can log in and use the application. Deactivated users can be re-activated when needed. Deleted users are no longer available in the resource tree.

1. In the resource tree, select the user that you want to change the status for.
2. Click **Resource Settings > Users**.
   
The **User** screen displays.

3. Select the check box next to the user that you want to change the status for.

4. Click the **Activate**, **Deactivate**, or **Delete** link located above the list of users.

5. Click **OK**.

### Unlock a User Account

When a user has unsuccessfully logged in too many times, the account will be locked.

The following color codes are used to indicate locked and unlocked users:
- When a user is active and logged in successfully, the account displays a green check mark in the **Locked** column of the user account screen.
- When a user has unsuccessfully logged in a few times but has not yet locked the account, a yellow X displays in the **Locked** column of the user account screen.
- When a user has unsuccessfully logged in too many times, the account will be locked. A red X displays in the **Locked** column of the user account screen.

If the user forgot their password, you might also have to change their password.

1. In the **resource tree**, select the name for the user whose account is locked.

2. Click **Resource Settings** and then select **Users** in the drop-down menu.
   
The **User** screen displays.

3. Check the box next to the user whose account you want to unlock.

4. Click the **Unlock** link above the list of users.

5. Click **OK**.

### Add a User

All system users must have user accounts.

The part of the **resource tree** that you choose when you create a user determines what the user can or cannot see when they log in. For example:

- If you are adding a dispatcher who manages a **bucket** and the resources under the bucket, select the bucket to place the dispatcher under so that the user can see only bucket and resources under that bucket.

- If you are creating a manager who may see entire enterprise, select the parent level of the resource tree to add the manager under.

- If you are adding a technician resource, select just the technician in the resource tree so that the user will see only his or her individual routes.

To add a user:

1. From the resource tree, select the bucket or group to which you want to add the new user.

2. Click **Resource Settings** and select **Users** from the drop-down menu item.
   
The **User** table displays in the work area.

3. Click **Add new**.
The **Add new user** window displays add window.

4. Complete the fields on the form.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Type</td>
<td>Choose a user type for this user. The user type determines what the user can access within the application, the layout and screen configuration.</td>
</tr>
<tr>
<td>Self-Assignment</td>
<td>Select this check box to enable this resource to add new activities to his or her individual route.</td>
</tr>
<tr>
<td>Resource</td>
<td>Select the organization unit or bucket that the resource is in. The option you select here determines which resources, groups, and buckets the resource can view. This field is automatically populated with the group, or bucket that you selected in the first step, but you can add or change the list of viewable resources, groups, and buckets here. You must assign a user who has self-assignment permission directly to a bucket. Users who can assign activities to themselves cannot be in groups.</td>
</tr>
<tr>
<td>Main resource</td>
<td>Click the pencil icon and search for the required resource. This setting establishes the connection between the user and the resource ID, and is used in Telemetry and Collaboration.</td>
</tr>
<tr>
<td>Login</td>
<td>Enter a user name for this user.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user’s first and last name.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter an initial login password for the user.</td>
</tr>
<tr>
<td>Confirm password</td>
<td>Re-enter the user’s initial login password.</td>
</tr>
<tr>
<td>Status</td>
<td>Select <strong>active</strong> or <strong>inactive</strong>. Only active users can use the application.</td>
</tr>
<tr>
<td>Force password change at next login</td>
<td>Select this option to require the user to create a new password when he or she logs in for the first time.</td>
</tr>
<tr>
<td>Language</td>
<td>Select the language that the user sees in the interface.</td>
</tr>
<tr>
<td>Phone Number</td>
<td>Enter the user’s telephone number.</td>
</tr>
<tr>
<td>Time format</td>
<td>Choose the time format that the user will see and use in the interface. This can be either <strong>12-hour</strong> or <strong>24-hour</strong>.</td>
</tr>
<tr>
<td>Date format</td>
<td>Choose the date format that the user will see and use in the interface. This can be either <strong>month-day-year</strong> or <strong>day-month-year</strong>. The date format controls the display of dates in numeric format.</td>
</tr>
<tr>
<td>Long date format</td>
<td>Choose how to display the long date to the user. A long date is a date that includes words. For example, Wednesday, February 20, 2013.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Choose a time zone for the user.</td>
</tr>
<tr>
<td>Design Theme</td>
<td>Choose a UI theme for this user.</td>
</tr>
<tr>
<td>Default export format</td>
<td>Choose the default data export format for this user. Options are CSV, XML and XLS.</td>
</tr>
</tbody>
</table>

5. Click **OK**.

If this user is also a resource, you must create a corresponding resource.
Reset a User’s Password

As a user administrator, one of the most common jobs you do is reset passwords. If a user is locked out, it is most often because the user exceeded the maximum number of password attempts. Sometimes in addition to unlocking a user’s account, you may also have to change their password.

1. Select the appropriate Resource level in the Resource Tree, for which you want to view the users. If you want to view all users, select the highest level in the Resource Tree.
2. Click **Settings > Users**.
   By default, all the users that belong to the selected bucket, and their children are displayed.
3. Search for the user whose password must be reset and click **Change Password** in the **Action** column.
4. Type in the new password in both the **New Password** field and the **Confirm Password** field.
5. Click **OK** to save the changes.

The Resource Tree

The *resource tree* provides a hierarchical view of your organization’s resources, typically sorted by geographical region. It displays on the left side of the screen.

You can click the **toggle button** to show or hide the resource tree. When you select a *resource* from the resource tree, the resource’s activities display in the work area on the right. Click the plus sign (+) next to an entity in the resource tree to expand and view the entities under that group or bucket. Click the minus (-) sign to collapse that view.

The resource types and the overview of the roles performed by each item in the resource tree are:

- **Field resource**: This resource can perform work, has work skills, work zones associated, and has a related user that is an actual person performing work or a crew or people.
- **Vehicle**: This resource can have work skills, inventory, and geolocation tracking enabled. When assigned to a team it may add the required work skills and inventory to be used by the team.
- **Tool**: This resource represents specific tools such as 30-feet ladder and excavator. This resource can have work skills, inventory, and geolocation tracking enabled. When assigned to a team it may add the required work skills and inventory to be used by the team.
- **Bucket**: This resource is used to accumulate work that is not yet distributed to field resources. Only the application can assign activities to this resource. This resource is used for Quota Management.
- **Organization unit**: This resource aggregates field resources, vehicles, and tools in the tree-like hierarchy to simplify management and reporting. This resource is used for Quota Management.

Add an Organization Unit or a Bucket

You can use organization units to sort and organize the other items in the resource tree. You can use buckets to hold the activities that are not assigned to field resources.
Difference between resource, user, and child resource: A resource can be a field resource (a human being), a vehicle, or a tool. All resources are elements of the resource tree. A user is a field resource or any other user that has access to Oracle Field Service Cloud. A child resource is a resource that is added to a bucket or an organization unit element of the resource tree. In the hierarchy of the resource tree, the bucket or the organization unit appears at a higher level than the child resource. A child resource can be a field resource (a human being), a vehicle, or a tool.

Organization units are typically used to group resources by location. Organization units cannot be route owners and activities cannot be assigned to them. Buckets can have activities, and they are assigned only by Routing Cloud Service. To add an organization unit or a bucket:

1. In the resource tree, select the organization unit or bucket to which you want to add the new organization unit or bucket.
2. Click Resource Settings.
3. Select Resource Info from the drop-down menu.
4. Click Add Child Resource.

The New resource info screen displays.

5. Complete the fields.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the resource name the way you want it to appear in the resource tree.</td>
</tr>
<tr>
<td>External ID</td>
<td>Enter the ID number from an external system, such as the employee ID number. These IDs are optional. If you use them, each resource must have a unique ID.</td>
</tr>
<tr>
<td>Status</td>
<td>Select active or inactive. Active resources can use the application. Inactive resources cannot use the system.</td>
</tr>
<tr>
<td>Email address</td>
<td>Enter the resource's email address.</td>
</tr>
<tr>
<td>Phone</td>
<td>Enter the resource's telephone number.</td>
</tr>
<tr>
<td>Time format</td>
<td>Choose the time format that the resource will see and use in the interface. This can be either 12-hour or 24-hour.</td>
</tr>
<tr>
<td>Date format</td>
<td>Choose the date format that the resource will see and use in the interface. This can be either month-day-year or day-month-year. The date format controls the display of dates in numeric format.</td>
</tr>
</tbody>
</table>
6. Click **OK**. The new organization unit or bucket appears in the Resource Tree.

### Designate Buckets for Capacity or Quota Management

After adding a bucket, you must select whether you want to use it for Capacity Management or Quota Management. The selection is done on the Resource Information screen.

1. Click the bucket name in the Resource Tree.
2. Select the **Use as Capacity Area** check box.
   
   The **Routing profile**, **Capacity categories**, and the **Time slots** fields appear.

### Add Capacity Categories and Time Slots

If you designate a bucket as a capacity bucket used for quota calculation, then the screen displays the capacity categories and time slots fields. The selections you make here determine how the Quota section appears. Configuring capacity categories and time slots on a bucket-by-bucket basis is helpful when different regions and types of resources within these buckets require different skills and time slots.

1. Click the bucket name in the Resource Tree.
2. Select the **Use as Capacity Area** check box.
   
   The **Routing profile**, **Capacity categories**, and the **Time slots** fields appear.

3. Select the **Time Slots** that will be used for Quota Management in this bucket. Click the pencil icon next to the **Time Slots** field.
   
   The **Edit Time Slots** box appears.

4. Select the time slots that will be used for quota management for this bucket then click **Save**.
5. Select the **Capacity Categories** that will be used for Quota Management in this bucket. Click the pencil icon next to the **Capacity Categories** field.
   
   The **Edit Capacity Categories** box appears.

6. Select the capacity categories that will be used for quota management for this bucket. Click **Save**.
7. Select the level at which quota is defined in this bucket (i.e., day, time slot, capacity category).
   
   This determines the visibility of the **Day**, **Time slot**, and **Capacity category** tables in the **Quota** view.

8. Select the levels on which quota can be closed in this bucket.
   
   Note that quota can also be closed by work zone.

9. Select the levels for which maximum capacity should be estimated.
Maximum capacity is the maximum number of minutes for activities booking. The application checks that the total duration of booked activities plus the total duration of other activities does not exceed maximum capacity.

10. Click OK to save the bucket information.

Add a Resource

When a user is also a resource, you must create both a user account and a resource.

By default, the data in the Status, language, time zone, time format, and date format fields are copied to the Add User for New Resource dialog when the resource type, Field Resource, Tool, or Vehicle is selected.

Difference between resource, user, and child resource: A resource can be a field resource (a human being), a vehicle, or a tool. All resources are elements of the resource tree. A user is a field resource or any other user that has access to Oracle Field Service Cloud. A child resource is a resource that is added to a bucket or an organization unit element of the resource tree. In the hierarchy of the resource tree, the bucket or the organization unit appears at a higher level than the child resource. A child resource can be a field resource (a human being), a vehicle, or a tool.

To add a resource:

1. In the resource tree, click the organization unit or bucket to which you want to add this resource.
2. Click Resource Settings and then select Resource Info from the drop-down menu.
   The Resource Info screen displays.
3. Click Add Child Resource.
   The New Resource info window displays.
4. Fill in the fields:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the resource name the way you want it to appear in the resource tree.</td>
</tr>
<tr>
<td>External ID</td>
<td>Enter the ID number from an external system, such as the employee ID number. These IDs are optional. If you use them, each resource must have a unique ID.</td>
</tr>
<tr>
<td>Phone</td>
<td>Enter the resource’s telephone number.</td>
</tr>
<tr>
<td>Email address</td>
<td>Enter the resource’s email address.</td>
</tr>
<tr>
<td>Status</td>
<td>Select active or inactive. Active resources can use the application. Inactive resources cannot use the system.</td>
</tr>
<tr>
<td>Resource Type</td>
<td>Select a resource type. Resource types are configured by your organization. Typical resource types are Bucket, Group, Technician, and Tool. For the resource types Technician and Tool, the Add User for New Resource dialog displays.</td>
</tr>
<tr>
<td>Organization</td>
<td>The organization to which the resource belongs. If you are adding a bucket or an organization unit, select the organization or organization unit that the bucket or group belongs to. You cannot select the organization for a technician; it is derived from the parent bucket or group.</td>
</tr>
<tr>
<td>Time format</td>
<td>Choose the time format that the resource will see and use in the interface. This can be either 12-hour or 24-hour.</td>
</tr>
<tr>
<td>Date format</td>
<td>Choose the date format that the resource will see and use in the interface. This can be either month-day-year or day-month-year. The date format controls the display of dates in numeric format.</td>
</tr>
</tbody>
</table>
### Initial ratio for activity duration

Indicates the percentage by which the company-wide estimations will be multiplied to get the estimated duration at the resource level for new activities. This ratio will be applicable only for those activities that are relatively new to the resource and there is no significant past data.

The field is displayed only if the following conditions are met:
- The Personalize the estimation of activity duration field is selected in the Add/Edit Resource Type screen.
- The field is added for your user type from the Configuration, User Types, Screen Configuration tab.

The following conditions apply to this field:
- You can edit this field only if the resource has not completed any activity. Once activities are reported, the ratio gets modified based on the reported durations.
- For existing resources for which this field was not set during resource creation, this field is read-only with an initial value of 100%.
- The value of this field is modified regularly based on the durations reported for relatively new types of activities. The updated value displays as read-only.

### Working days left for reported data to start impacting company level duration estimation

This field displays the number of days left until the resource starts affecting the company averages, and it is based on the settings on resources type. This is a countdown value and it decreases by one everyday. The resource starts affecting the company average only when the value of this field reaches 0 (zero). This field can be edited till the value reaches 0 (zero), after that the field is not displayed. This field is displayed only if the Use durations reported to enhance company-wide estimations field is selected in the Add resource type screen.

**Related Topics**

- Associate a Resource with a User Account

## Rules for Removing Inactive Resources

Resources that have an inactive status for more than 12 months are automatically removed from the application to improve performance and remove clutter from the resource tree.

The following rules are applied to remove the resource:

1. **Resource Type Role = ‘Field Resource’, ‘Vehicle’ or ‘Tool’ will be deleted and removed if:**
   - resource has inactive status
   - resource was last updated more than 12 months ago
   - resource does not have activities in future days (non-scheduled activities, teamwork, and so on)
   - resource is not used in visibility conditions in User types configuration (via 'pid' or 'external_id')
   - resource is not used in blocking conditions of Message steps (via 'external_id')
   - resource is not used in conditions of Filters (via 'external_id')
   - resource does not have related user whom ‘uid’ is used in visibility conditions in User types configuration

2. **Resource Type Role = ‘Bucket’ or ‘Organizational Unit’ will be deleted and removed if:**
   - resource has inactive status
Associate a Resource with a User Account

Adding a resource to the Resource Tree does not automatically give login access to the user. To activate their routes and provide status for their work, these new users must log in like any other user. This procedure describes how to associate a new resource with its corresponding user account.

If you are adding a child resource of type Technician (or something similar configured by your organization), the fields listed in step 3 are displayed on the New resource info dialog itself. In that case, you can skip steps 1 and 2.

1. Select the appropriate Resource level in the Resource Tree that contains the user that you want to modify.
2. Click Resource Settings > Users.
3. Complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Type</td>
<td>Select the user type associated with this resource. The user type is group of rules and visibilities that can be applied to a user or group of users.</td>
</tr>
</tbody>
</table>
**Oracle Field Service Cloud**

**Administering Oracle Field Service Cloud**

**Chapter 4**

**Administer Oracle Field Service Cloud**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>This is the name that appears when the user logs in.</td>
</tr>
<tr>
<td>User Name</td>
<td>Name used for login (company standard should be defined).</td>
</tr>
<tr>
<td>Password</td>
<td>Type a new password that meets your company’s standards.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>Enter the same password as above to confirm the correct password.</td>
</tr>
<tr>
<td>Force password change at next login</td>
<td>Select this check box to force the new user to change his/her password.</td>
</tr>
<tr>
<td>Language</td>
<td>Select the user’s preferred language from the drop-down menu of choices.</td>
</tr>
<tr>
<td>Long date format</td>
<td>Select the way in which you wish to display the long date to the user.</td>
</tr>
</tbody>
</table>

4. Click **OK**.

The resource is added, synchronized with a user record, and displayed on the Resource Tree within its parent location.

After you have added a new resource, you must add the work skills, work zones, and Calendar.

**Configure Activity and Resource Hints**

Activity hint is a context menu that is displayed when you click an activity on the List, Time, or Map view. Similarly, resource hint is displayed when you click a resource in the resource tree. These menus can include static text such as activity type or capacity category and action links for actions such as adding or starting an activity. The menu can also include links to open forms and plug-ins.

1. Click **Configure > User Types**.
2. Select the type of user for which you want to configure the hint and click **Screen configuration**.
3. Expand **Application screens**.
4. To add an activity hint, locate **Activity hint** in the **Dispatch Console** tree and click it. To add a resource hint, locate **Resource hint** in the **Main menu** tree and click it.
   
   The **Context layout structure** opens for the selected hint. This screen displays two sections—**Layout structure** and **Actions**.
5. Click **Click to Add** in the **Layout structure** section and select the required items.
   
   The items in the **Layout structure** are static text items.
6. Click **Click to Add** in the **Actions** section.
   
   The **Add action** screen appears and displays the following options:
   
   o Standard action screen: Lets you add standard actions such as Activate route, Add child resource, and so on.
   
   o Plugins: Lets you add plug-ins. The plug-ins that you have added on the Forms & Plugins screen are listed here.
   
   o Custom forms: Lets you add custom forms. The Forms that you have added on the Forms & Plugins screen are listed here.

7. Select one of the three options and then select the required item in the **Available** list.
8. Click **OK**.

   The properties of the newly added item are displayed.
9. Click **Add new visibility**.

   Read-only is selected by default on the **[item] visibility** screen.
10. Click **Conditions** and add any conditions based on which you want to display the link.
11. Click **Save**.

The new item or link is added to the hint. The item will be displayed when the user refreshes the application, or logs in to it the next time. To add a hint in Oracle Field Service Core Manage Cloud Service, expand **Legacy Manage** in Step 3 and follow the remaining steps.

### Configure Time and List Views

You can configure the columns that display on the Time and List views to suit your business requirements.

1. Click **Configure > User Types**.
2. Select the type of user for which you want to configure the views and click **Screen configuration**.
3. Expand **Application screens**.
4. Click **List view columns** in the **Dispatch Console** tree.
   - The **Context layout structure** opens and displays the default items available on the screen. You can more static text or action items to it.
5. Click **Click to Add** in the **Layout structure** section and select the required items.
   - The items in the **Layout structure** are static text items.
6. Click **Click to Add** in the **Actions** section.
   - The **Add action** screen appears and displays the following options:
     - Standard action screen: Lets you add standard actions such as Activate route, Add child resource, and so on.
     - Plugins: Lets you add plug-ins. The plug-ins that you have added on the Forms & Plugins screen are listed here.
     - Custom forms: Lets you add custom forms. The Forms that you have added on the Forms & Plugins screen are listed here.
7. Select one of the three options and then select the required item in the **Available** list.
8. Click **OK**.
   - The properties of the newly added item are displayed.
9. Click **Add new visibility**.
   - Read-only is selected by default on the **[item] visibility** screen.
10. Click **Conditions** and add any conditions based on which you want to display the link.
11. Click **Save**.
   - The new item or link is added to the hint. The item will be displayed when the user refreshes the application, or logs in to it the next time. To add a hint in Oracle Field Service Core Manage Cloud Service, expand **Legacy Manage** in Step 3 and follow the remaining steps.
5 Resources

Resource Entities

The ongoing management of resources typically involves managing one or more entities described in this topic.

Calendars, Work Schedules, and Shifts – This involves creating calendars that illustrate when a resource is available for work and when he/she is off duty. Between calendars, work schedules, non-working time, internal activities, holidays, and shifts, there is a great deal of flexibility available in the application. Some parameters can be set in advance for planning, and others are considered more day-to-day adjustments.

Work Skills – This refers to the correlation between what is required to complete incoming activities, and which resources have the capabilities to accomplish them.

Work Zones – This refers to the area within which a resource is able or allowed to travel to complete activities.

Time Zones

When you configure the application, it is possible to set different time zones for a user and for a resource. These time zones are used in different contexts on different screens. This topic gives an overview of how time zones are displayed throughout Oracle Field Service Cloud.

Today's date

The time zone of the currently logged in user is used when determining the today’s date. For example, if it is 1:00 PM, Jun 10 in a UTC+00:00 time zone and you log in as a user who is in UTC+12:00 time zone, then after logging in you will see that the current date is set to Jun 11. This is because, in the user's time zone it is already 01:00 AM, Jun 11. Today’s date is used as the initial date on the following screens in Oracle Field Service Core Manage Cloud Service: Activities, Daily, Offline synchronization, Dashboard, and Print route. For example, on the "Activities" screen, it is the date for which the activities will be shown after you log in to the application. You can change the date on these screens to see the information for another date. Nevertheless, when you click the date field, the calendar widget shows you today’s date in light blue color. The following figure shows the calendar with today’s date highlighted:
The same behavior is present in Oracle Field Service Mobility Cloud Service. When a field resource logs in, today's date is marked with light red color on the date selection panel in the header, as shown in the following figure:

When a field manager looks at the **Calendars** screen in Oracle Field Service Mobility Cloud Service, then today’s date is marked in blue, as shown in the following figure:
The same date is used in Oracle Field Service Core Manage Cloud Service when searching for activities "starting today".

Current date of the resource

The current date of the resource is always determined in the time zone of the resource. You can activate the route and start an activity only on the current date of the resource time zone.

Changing past activities

Every instance has a specific time when all the data that is related to the previous day is frozen and can't be changed any more. This time is configured on the Business Rules screen in the Overnight work section, shown in the following figure:

For example, you have configured that the working time is 5 hours since midnight in the Eastern time zone. This means that at 5:00 AM in the Eastern time zone all data for the previous day becomes frozen.

⚠️ Important: If you configure an instance to use in several time zones, you must set the time zone on the Business Rules screen to the most "western" time zone. If the work is performed several hours after midnight in this most "western" time zone, then you must also specify the number of hours after midnight.
Time view in Oracle Field Service Core Manage Cloud Service

The screen **Activities > Time** can display aggregated information for the hierarchy of resources. The information is presented in the same time zone to look consistent on the timeline. The time zone is determined as the time zone of the resource selected in the resource tree on the left of the screen. The current time which is shown as a red vertical line is also in the time zone of the selected resource, shown in the following figure:

![Time view in Oracle Field Service Core Manage Cloud Service](image)

**Note:** The only exceptions are the resource hint, activity hint, and activity label. Information on the resource hint is displayed in the time zone of the resource this hint belongs to. Information on the activity hint and activity label is displayed according to the rules described in the Activity related information section later in the topic.

**Manage** screen in Oracle Field Service Mobility Cloud Service

The **Manage** screen in Oracle Field Service Mobility Cloud Service shows the information similar to the **Activities > Time** screen. The difference is that there is no resource selected in Oracle Field Service Mobility Cloud Service. The information is shown for the list of resources identified as a group, and the group is configured by a user. Since it is not possible to identify which resource time zone should be used as the primary time zone, the time zone of the currently logged in user is used instead.

**Note:**

- The only exceptions are the resource hint, activity hint, and activity label. Information on the resource hint is displayed in the time zone of the resource this hint belongs to. Information on the activity hint and activity label is displayed according to the rules described in the Activity related information section later in the topic.
- When a user opens the non-scheduled or non-ordered activities on the right of the screen, the activity identifier shows information according to the rules described in the Activity related information section later in the topic.

Organizations with multiple time zones

If your organization operates in multiple time zones, it is important that you configure both, the field resource and activity time zones correctly. Configuring these time zones is even more important if they are different. A field resource sees all the data in their own time zone, but when the activity (customer) is in a different time zone, both times are shown as appropriate. The
activity time zone is used for notifications and can be used in APIs (for example, for sending messages). Typically, the time zone of a physical location is used for notifications, but you may use your preferred time zone, such as your headquarters time zone or any other in which you prefer to get notifications.

Resource related information

Information that is related to a resource and the resource’s route is entered in the resource time zone. It includes:

- Route Status (queue_status) which includes the time when route was activated
- Reactivated (reactivated)
- Resource working hours (calendar)
- Resource on-call hours (oncall_calendar)

Time view shows this information differently in Oracle Field Service Core Manage Cloud Service and Oracle Field Service Mobility Cloud Service. See the earlier sections for more details.

Activity related information

Time related information on an activity is displayed and entered in the time zone of the resource for which the activity is assigned. This information includes:

- Start (ETA)
- End (end_time)
- Start - End (eta_end_time)
- Delivery window (delivery_window)
- Activity Time of Booking (atime_of_booking)
- Activity Time of Assignment (atime_of_assignment)

The only exceptions are:

- Time slot or service window (depending on what is used for the particular activity type)
- SLA window

These properties are either in the resource time zone or in the customer time zone. It depends on the SLA and Service window use customer time zone field set on the activity type. Time view shows this information differently in Oracle Field Service Core Manage Cloud Service and Oracle Field Service Mobility Cloud Service. See the earlier sections for more details.

User related information

All user related information is shown in the time zone of the user. It includes:

- When the user was registered
- When the user was updated
- When the user logged in last time
- When the user changed his password
- Date and time till when the user is blocked

Field Collaboration

Each message in Field Collaboration includes the time when it was sent. This time is shown in the time zone of the currently logged in user.
Change a Resource’s Organization

You can change the Organization for bucket and Organization unit resources. Resource types such as field resources, tools, and vehicles inherit their parent’s Organization.

1. Select the resource in the resource tree.
2. Click Resource Settings > Resource Info.
3. Locate the Organization field and select the desired Organization.
4. Click OK.

The resource is displayed under the selected Organization in the resource tree.

Calendars, Work Schedules, and Shifts

Whether they are set at the organization unit, bucket or resource level, overall calendar options are made up of combinations of work schedules, shifts, working, and non-working time. Ultimately they represent a holistic view of who is available or not available for work at any given time on any given day.

Here are a few rules regarding the hierarchy of calendars in general, and their levels of precedence:

- Work schedules, shifts, and working time applied to a bucket or an organization unit will, by default, also apply to all resources that fall under that bucket or organization unit.
- Calendars created or adjusted at a lower level will override the calendar at a higher level. In other words, what is set up at a resource level overrides that which the resource may have inherited from its parent entity. However, the work schedule defined at the child level doesn’t override the non-working time defined at the parent level.
- A calendar at the individual resource level will apply only to that resource and will override all other calendars.

To better understand calendars and their potential components, we must define the different options. The components of a calendar are:

- Work Schedules - Work schedules contain multiple shifts and non-working times and are the mechanisms for grouping these items so that they can be applied to a single resource or an entire organization unit or a bucket. Work schedules represent the highest level of calendar options.
- Shifts - Shifts are used to define the different working times as defined by a given organization. They can be created once and used by a variety of work schedules, simplifying the assignment of schedules. In addition to work schedules, shifts can also be assigned directly to organization units, buckets or resources.
- Working Time – The time frame in which a resource is scheduled to work that does not comply with one of a company’s standard shift definitions.
- Non-working Time - Non-working time is used to identify known absences such as bereavement, illness, holidays and vacations.

Earlier portions of this guide covered the creation of work schedules, shifts and non-working time; therefore this section will concentrate on assigning those calendar options to entities on the Resource Tree (organization units, buckets, resources). While the process is the same for each – depending on the selection made from the Resource Tree – the implications differ. This ties back in with the explanation of the calendar hierarchy.

When associating calendar options with higher-level entities (organization units, buckets), their child resources assume the same options. However, if options are set at the resource level, they take precedence over their inherited settings. For the
purpose of this guide, the steps for building calendars at the resource level will be covered. The steps will be the same for organization units and buckets – simply select them from the Resource Tree instead of individual resources.

## Add a Work Schedule or a Shift

You can assign a `workSchedule` or a shift to a `resource, bucket` or `group`. You can also define the on-call schedule of a resource using the Calendar view.

1. Click the hamburger icon and click **Calendars**.
   
   The calendar appears for the resources in your group or bucket.

2. For the resource for which you want to modify the calendar, click the shift for the required date.
   
   The modify calendar dialog appears for the selected resource and date.

3. To change the work schedule or shift for the resource, update the following fields:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule</td>
<td>This list includes work schedules and shifts. Select the work schedule or shift that you want to apply to the resource.</td>
</tr>
<tr>
<td>End date</td>
<td>The date on which the new work schedule or shift ends. If you want to apply it for an indefinite time, click <strong>No date specified</strong>.</td>
</tr>
</tbody>
</table>

4. To add the details of on-call for the resource, click **On-Call** and update the following fields:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-Call Schedule</td>
<td>The field that specifies that the resource is on-call. Select On-Call. An On-Call shift visually shows what resources are available to be contacted outside of a regular working shift. On-Call calendars are not used in routing optimization or capacity calculations.</td>
</tr>
<tr>
<td>Repeat for</td>
<td>The number of days for which the resource will be on-call, starting from the day that you have selected in the calendar earlier. The dates for which the selected schedule applies appear at the bottom.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

## Add a Shift to a Resource's Calendar

Shifts are standard patterns of working time. They determine when a resource is available for work. Shifts applied at the resource level override the shifts applied at a higher level in the resource tree.

1. Select a resource from the resource tree.

2. Click **Resource Settings > Resource Calendars**.
   
   The **Resource Calendars** screen displays.

3. Click the gear icon and select **Add shift** from the drop-down menu.
   
   The **Add Shift** window displays.

4. Complete the fields.
## Add Working Time to a Calendar

Working time differs from shifts in that it represents start and stop times that may differ from the pre-defined shifts. You might use working time when a resource works a different number of hours than he or she normally does or when the resource works at a different time of the day than the other resources.

1. Click the hamburger icon and click **Calendars**. The calendar appears for the resources in your group or bucket.
2. For the resource for which you want to modify the calendar, click the shift for the required date. The modify calendar dialog appears for the selected resource and date.
3. Fill up the following fields:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule</td>
<td>Select <strong>Custom Working Time</strong> from the drop-down list.</td>
</tr>
<tr>
<td>Notes:</td>
<td>You can create only one on-call shift per day. If you create a second on-call shift, the first one is deleted.</td>
</tr>
<tr>
<td>Time From</td>
<td>Enter the time when the resource’s work is to begin.</td>
</tr>
<tr>
<td>Time</td>
<td>Enter the time when the resource’s day ends.</td>
</tr>
<tr>
<td>Points</td>
<td>If you are using points to cap activity assignments, you can enter them here. These points work the same way as points associated with a shift.</td>
</tr>
<tr>
<td>Repeat for</td>
<td>Number of days starting from the day selected on the calendar to which the new working time applies. The start and end dates of the new schedule are displayed below the field.</td>
</tr>
</tbody>
</table>

The following figure shows the dialog where you add the custom working time:
4. Click **Submit**.
   The new schedule is displayed on the calendar.

Add Non-Working Time to a Calendar

Use *non-working time* to identify times when a resource, an organization unit, or a bucket is not available for work.

1. Click the hamburger icon and then click **Calendars**.
   The Calendar view appears for the group or bucket assigned to you.
2. Select the bucket, group, or resource for which you want to change the calendar.
3. Click the date for which you want to add the non-working time.
4. To add non-working time for the resource, click **On-Call** and update the following fields:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-Call Schedule</td>
<td>The field that specifies that the resource is not working. Select Non-Working Time.</td>
</tr>
<tr>
<td>Reason</td>
<td>The reason for which the resource is not working.</td>
</tr>
<tr>
<td>Repeat for</td>
<td>The number of days for which the resource will not be working, starting from the day that you have selected in the calendar earlier. The dates for which the non-working time applies appear at the bottom.</td>
</tr>
</tbody>
</table>

5. Click **OK**.
   If the non-working time can be applied, the resource is marked as a non-working resource for the selected date range. If the non-working time can’t be applied, a warning message appears. If you click OK, the non-working time is applied, but a warning message appears on the resource tree for that resource on that day. Non-working time can’t be applied if the technician has anything other than repeating, shift, or mass type of activities assigned on this route. The activities on the resource’s route, other than mass and repeating activities, are rerouted or assigned to the bucket, if the following conditions are met:
   - The routing plan has the Enable reoptimization check box selected.
   - The resource meets the routing plan filter conditions.
Delete Items from a Calendar

When you want to remove a work schedule, shift, working time, non-working time or override from a resource’s calendar, you can delete it.

**Note:** Once you delete an item from a resource calendar, the resource re-acquires any like items that are set at a higher level. For example, if you delete a work schedule from a calendar, the resource reacquires the work schedule of it’s bucket or group.

1. Select a resource from the resource tree.
2. Click Resource Settings > Resource Calendars.

   The Resource Calendars screen displays.
3. Click the check box next to the item that you want to delete and then click Delete.
4. Click OK.

Use Filters in Daily View

The Daily View helps dispatchers or managers manage resource calendars efficiently. It provides a weekly calendar snapshot for the selected resource, bucket or group.

You can view a separate calendar by day for each resource or you can view a calendar for an entire organization unit or a bucket. Use the check boxes on the View drop-down to display additional information in the Daily calendar view, as shown in the following figure:

Options available in the View drop-down list:

- **Apply hierarchically:** Shows all data within the hierarchy.
• **Shifts**: The *shift* in which the resource is working.
• **On-call**: Filters out resources available for on-call activities, if used.
• **Points**: Displays the points available during that shift, if used.
• **Routes**: Displays two numbers underneath each day of the resource’s calendar. The first number indicates the number of pending activities for the day and the second number indicates the total number of activities for the day.
• **Zones**: This shows the *Work Zone* that a resource is able to work in for the given day.
• **Inactive Resource**: This is used if you are viewing a group or bucket. When checked, it displays resources that have the week off for vacation, leave of absence, etc.
• **Work Skills**: Displays the work skills of technicians.

### Travel Time Prediction

Oracle Field Service Cloud uses time-based prediction for travel time. This topic describes how travel time is calculated in the application.

Travel time between two activities is calculated as a combination of:

- Statistical “Learned” estimation
- "Straight-Line" estimation

**Note**: You can specify durations for specific activities and technicians through APIs. For more information, see the REST API for Oracle Field Service Cloud guide.

#### Statistical “Learned” estimation

Statistical Learned estimation is based on the historical travel times between two locations. These locations are represented by geographical areas, termed as Travel Keys. A Travel Key is typically a portion of or the entire Post Code or ZIP Code. When a resource records travel between two locations, the values are added to the statistics to produce a learned estimate of the travel between that set of Travel Keys. To produce and use a Statistical Learned Estimate for the travel time between two activities, both activities must contain a value that is part of the Travel Key and the Travel Keys must have enough historical travel data.

**Note**:
- The travel time between two Travel Keys will be adjusted over time as more data is collected.
- Generally travel time for an activity is considered to be the time between the end of the previous activity and the start of the current activity. If there is idle time after the end of the previous activity (before the start of predicted travel to the current activity), then the recorded travel time is not considered for the statistics.

#### Straight Line estimation

Straight Line estimation uses the time taken to travel the distance when a straight line is drawn between two locations. To calculate this travel time, the application must have the latitude and longitude of both the locations. The formula to calculate the total travel time is:

\[ \text{Total Time} = \text{Straight Line Time} + \text{Arrival (or Parking) Time} \]

Where:
Straight Line Time = Distance / Speed

Here, speed and arrival (or parking) time are constants that are configured at the company level.

Travel time estimation

Oracle Field Service Cloud uses a parameter called Coordinated Travel Weight (CTW) to combine the two methods of estimations described earlier. CTW is a company-level value and is calculated using the Coordinate calculation weight parameter. Coordinate calculation weight is configured at the company level, in the Statistics screen. The formula is:

\[
\text{Travel Time} = \text{Statistical} \times (1-\text{CTW}) + \text{Straight Line} \times \text{CTW}
\]

For example, if you set CTW to 0.5, the travel time is the average of the two.

Exceptions:

- If the CTW value is 0.0, only the Statistical Learned estimation is used. If no Travel Key is available, the Default Travel time is used.
- If the CTW value is 1.0, only the Straight Line estimation is used. If coordinates are not available for both activities, the Default Travel time is used.
- If neither Statistical Learned estimation nor Straight Line estimation is available, the Default Travel time is used. The Default Travel time is a single configuration at the company level.

Additional adjustments

After routing is performed, the application may adjust Travel Time further for activities that are pending and ordered on a route. This adjustment may occur when one of the following situations occurs:

1. Application is unable to find a Statistical "Learned" record that matches a Travel Key
   a. When only the coordinate method is used.
   b. When the "default" value is used.
2. The statistical value is produced as a result of the expansion algorithm.
   a. The expansion algorithm expands travel estimations using the pathfinder algorithm. For travel key pairs that do not have real travel data collected, the expansion tries to find a path using existing pairs (paths) and stores travel time as a sum of these travels. For example, if there is no statistical data for travel between keys 1 and 2, but there is for travel between keys 1 and 3, and between keys 3 and 2, travel time 1-2 is calculated as a sum of travels 1-3 and 3-2.
   b. This is not applicable for new customers where the statistics are not yet available.

When either of the above occurs, the application attempts to adjust travel time using two methods:

- Generate "actual travel" data: The application submits the origin and destination addresses to the Oracle Spatial and Graph Route Server, if the accuracy level of each activity = "address". The application calculates the travel time between the activities, adds the results to the temporary statistics, and recalculates the travel time on the route using the updated statistics.
- Generate "street/post code level" estimate travel between post codes
  o This method requires post or zip code to be configured as the travel key.
  o The application submits the origin and destination post or zip codes to the Oracle Spatial and Graph Route Server and the application calculates the travel time between them. The returned information is used to improve the quality of the temporary statistics.
Temporary statistical travel data is calculated and used until real data is accumulated. This is accumulated as resources record travel between two locations based on the status of the activity. As soon as actual resources learned statistics are obtained, the temporary record is deleted. The Daily Extract - Appt data set contains the ‘travel_estimation_method’ field, which identifies what travel method was used for the travel time estimation. This field is only available in the Daily Extract file. The following values can be present:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - travel is not calculated</td>
<td>Travel is not calculated. This is not calculated because the Activity Type feature = “Calculate travel” is not selected.</td>
</tr>
<tr>
<td>1 - company default</td>
<td>Travel estimation uses the company default found in “Configuration - Statistics”</td>
</tr>
<tr>
<td>2 - statistics only</td>
<td>Travel estimation uses only the Statistical Learned estimation. This could be a result of an activity not being geocoded or the Coordinated Calculation Weight parameter set to 0.</td>
</tr>
<tr>
<td>3 - expansion statistics only</td>
<td>Travel estimation is based on the expansion statistics. See 2A above for a definition.</td>
</tr>
<tr>
<td>4 - initial statistics only</td>
<td>Travel estimation is based on the statistics that were generated as part of the implementation. This is applicable only for some customers who were provisioned prior to November 2014.</td>
</tr>
<tr>
<td>5 - coordinates only</td>
<td>Travel estimation only uses the Straight Line estimation. This could be a result of an activity not having a physical address or the Coordinated Calculation Weight parameter set to 0.</td>
</tr>
<tr>
<td>6 - statistics + coordinates</td>
<td>Travel estimation is based on a combination of the Statistical Learned estimation and Straight Line estimation using the ‘Coordinate calculation weight’ setting.</td>
</tr>
<tr>
<td>7 - expansion statistics + coordinates</td>
<td>Travel estimation is based on a combination of expansion statistics and the Straight Line estimation using the ‘Coordinate calculation weight’ setting.</td>
</tr>
<tr>
<td>8 - initial statistics + coordinates</td>
<td>Travel estimation is based on the statistics that were generated as part of the implementation and the Straight Line estimation using the ‘Coordinate calculation weight’ setting. This is applicable only for some customers who were provisioned prior to November 2014.</td>
</tr>
<tr>
<td>9 - “manual” adjustment</td>
<td>Travel estimation is based on the value that was updated using an API. This value can be set via Core API (update activity). For this goal, “manual” should be passed as a value of the “setTravelTime/source” field.</td>
</tr>
<tr>
<td>10 - “street level” adjustment</td>
<td>Not available – reserved for future use.</td>
</tr>
<tr>
<td>11 - “externally estimated value provided via API” adjustment</td>
<td>Travel estimation is based on the value that was updated using an API. This value can be set via Core API (update activity). For this goal, “manual” should be passed as a value of the “setTravelTime/source” field.</td>
</tr>
<tr>
<td>12 - same location</td>
<td>Travel was not calculated because the location is the same based on address or geocode. (Travel = 0)</td>
</tr>
<tr>
<td>13 - statistics (not-ordered, bucket, not-scheduled)</td>
<td>Travel estimation only used the Statistical Learned estimation. In this case the origin location of the travel is still unknown and the application estimates an average traveling time value. A presence of these estimations is important for capacity management.</td>
</tr>
<tr>
<td>14 - company default value (not-ordered, bucket, not-scheduled)</td>
<td>Travel estimation used the company default found in “Configuration - Statistics”. In this case the origin location of the travel is still unknown.</td>
</tr>
</tbody>
</table>
Add the Find Nearby Inventory Action to Part Details Screen

Field Resources can find out the availability of an item with any of the nearby technicians now. You must first configure the context layout of the Part details screen to display the Find Nearby Inventory action on the Parts details screen.

To add the Find Nearby Inventory action to the Parts details screen:

1. Click **Configuration**.
2. Click **User Types**.
3. Open the **Screen configuration** tab.
4. In the Application screens section, click **Parts details**.
   The Parts details context layout screen appears.
5. Under Action, click the **Click to Add** link.
6. Select the **Standard action screen** option.
7. Select the **Nearby Resources with Parts** check box and then click OK.
8. Click **Add new visibility**.
    Read-only is selected by default.
9. Click **Save**.

The Find Nearby Inventory action link is now available on the Parts details screen.

Add a Plug-in to the Parts Details Screen

You may have created a plug-in that lets Field Resources order a part from the warehouse or from a vendor. To display a link to the plug-in on the Parts Details screen, you must configure the context layout of the Parts details screen.

Prerequisite: The plug-in is added on the Forms & Plugins screen and configured.

To add a plug-in to the Part details screen:

1. Click **Configuration**.
2. Click **User Types**.
3. Open the **Screen configuration** tab.
4. In the Application screens section, click **Parts details**.
   The Parts details context layout screen appears.
5. Under Action, click the **Click to Add** link.
6. Select the **Plugins** option.
7. Select the check box for the plug-in to be displayed and then click OK.
8. Click **Add new visibility** for the newly selected plug-in.
    Read-only is selected by default.
9. Click **Save**.

The plug-in is now available on the Parts details screen.
Resource Work Skills

To ensure that a resource has the ability to perform the assigned activities, you must correlate the incoming activity skill requirements with the skills specified for each resource.

The Work Skill functionality is what that correlation is based on. Work Skills are set up first, and then are assigned to resource records, with the appropriate levels of qualification set for each. Incoming activities are also assigned Work Skills based on certain conditions being met, and are then matched up with resources with corresponding skills during routing. The setup and management of work skills and work skill conditions are covered within the Company Settings portion of this guide.

In this section, we’ll cover a common administrative task – assigning work skills to resources to help ensure that the right resource is being assigned the right work by routing.

Work Skill Group Considerations

Work skill groups are bundles of work skills that can be assigned to resources, similar to individual work skills. The difference, however, is that work skill groups may already contain predetermined qualification levels of certain skills, whereas when assigning works skills one at a time, you can define unique qualification levels for the resource.

If there is an overlap in qualification levels between what is defined within work skill groups and individual work skills, then the resource is considered to have whichever is the highest. Work skill groups are assigned in the same manner that work skills are (less selecting qualification levels), so this section only describes the process of assigning work skills. Editing existing work skills for resources is another common task, and it is also accomplished in the same manner as initially assigning skills.

Assign Work Skills to a Resource

Work skills are the competencies that each resource is qualified to perform. You can assign work skills to resources through the Resource Info screen.

1. In the resource tree, click on the group or bucket that you want to add the new resource to.
2. Click Settings > Resource Info from the drop-down menu.
   The Resource Info screen displays.
3. Click the plus icon in the Work skills field.
   The Add work skills window opens.
4. Assign a preference level for each work skill using a scale of 1 to 100.
   A higher number means that the resource has a higher chance of being allocated the task. If a resource performs this task only occasionally, enter a lower number.
5. Click Save.
   The resource is now assigned the skills and will be considered for work only if their qualification level meets or exceeds the level in the activity record. The following guidelines are applicable:
   o If no individual skills are defined for a resource, then the application interprets that the resource is qualified to perform all of the skills at the highest qualification level. This is the default setting.
   o When qualification levels are set for at least one work skill, then the resource is considered to have only that specific skill. The resource is not considered for work requiring any of the other skills.
A higher ratio number increases the likelihood that this resource will be assigned activities with this work skill. If the ratios are conflicting, the application uses the higher ratio. If the work skill group ratio conflicts with the individual work skill ratio, the application uses the individual work skill ratio.

### Resource Work Zones

Work zones provide two major capabilities—the first is to define the areas within which a resource is allowed to work (or is restricted from working outside of), and the second is to support the ability to cap or stop activities from being booked at certain times on a zone-by-zone basis (capacity management).

Work zones can be assigned to resources through any level within the Resource Tree (group, bucket or resource). An exception is temporary work zones – they can only be set at an individual resource level. If work zones are set at a group or bucket level, then their child entities (resources) inherit the same settings. If work zones are set at the resource level, then those settings override any higher-level settings. Given those rules, ensure that before assigning work zones, you have selected the correct entity from the Resource Tree. The process of assigning work zones is the same for all levels. This document includes the steps for assigning work zones to individual resources.

### Add Work Zones to a Resource

Work zones define the regional areas in which technicians are permitted to work. When you add a work zone to a resource, any work zone shape or custom map layer that is added to the work zone is displayed on the map. Work zone shapes and custom map layers help you visualize your work area better.

1. Select the resource from the **Resource Tree**.
2. Click **Resource Settings** and then select **Resource Work Zones** from the drop-down menu.
   
   The **Resource Work Zones** screen displays for the selected resource.

3. Click **Add new**.
   
   The **Add Resource Work Zone for <resource name>** window appears.

4. Complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work zone</td>
<td>Select the work zone from the drop-down menu.</td>
</tr>
<tr>
<td>Display additional zones in</td>
<td>Select the box to view all the active work zones. For the group or bucket that this resource is in.</td>
</tr>
<tr>
<td>the drop-down list</td>
<td></td>
</tr>
<tr>
<td>Ratio</td>
<td>Type a value between 1 and 100. A higher number increases the likelihood that this resource will be assigned activities in this work zone. If this is a work zone the resource works in daily, or if it is a preferred zone for the resource, enter a higher number. If this resource only works in this work zone occasionally or only by exception, enter a lower number. You can assign multiple work zones with different ratios to one resource.</td>
</tr>
<tr>
<td>Schedule Section</td>
<td></td>
</tr>
<tr>
<td>Temporary</td>
<td>Select this check box to create a temporary work zone for a specified period of time.</td>
</tr>
<tr>
<td>Date Start</td>
<td>Enter the date that this work zone assignment starts.</td>
</tr>
<tr>
<td>Date End</td>
<td>[Optional] If this is a temporary assignment, enter the date that this work zone assignment ends.</td>
</tr>
</tbody>
</table>
### Resources

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recurrence</td>
<td>Set the schedule for the work zone if the resource is alternating between work zone assignments. Resources can cover different work zones on different days of the week. Use this feature to change a resource’s work area on certain days of the week. Select the frequency of recurrence and the days on which to recur.</td>
</tr>
</tbody>
</table>

5. Click **Add**.

The work zone is added to the resource. If any work zone shapes are added to this work zone, they are displayed on the map.

### Remove Work Zones from a Resource

At some point you may need to delete work zones from a resource’s record; deleting a work zone has a major impact on the activities.

1. Select the resource from which you want to delete a work zone.
2. Click **Settings > Resource Work Zones**.
3. Select the work zones you want to delete from this resource.
4. Click **Delete**.
5. Click **OK**.

Any activities associated with these work zones will no longer get routed to this resource. Deleting a work zone from a resource does not delete it from the application. It will still be available to be assigned to other resources as needed.

### Assign a Temporary Work Zone

You can assign a temporary work zone to a resource, for the resource to perform a work outside the usual work zone. To accomplish this, you add a temporary work zone to a resource’s record. Temporary work zones override all regular work zones of the resource for the defined period of time.

1. Select the appropriate resource from the Resource Tree.
2. Click **Settings > Resource Work Zones**.
3. Click **Add new**.
   
   The **Add resource work zone for [resource name]** window appears.

4. Select the **Work Zone** that you want to assign temporarily to the resource.
5. Select the **Temporary** check box.
6. Adjust the **Date Start** and **Date End** dates.
   
   **Date End** is mandatory for temporary work zones.

7. Click **Add**.

   The work zone is added.

There is no need to remove temporary work zones once the date has passed. They will expire on the end date and the normal work zones will take precedence. The following rules apply to temporary work zones:

- The **End Date** is mandatory.
• Temporary work zones can be assigned to resources only. They are not available for buckets or groups.
• Only the **Everyday** recurrence is available for a temporary work zone.
6 Internal Activities

View Internal Activity Types

Internal activities are non-customer facing activities that a resource performs as part of daily duties. External activities are activities where resources are required to travel to perform some type of service.

For many resources, their first activity might be a warehouse visit. Around mid-way through the shift, there will be a lunch activity. The last activity might also be a warehouse activity, completing their end-of-day tasks. This is an example of how an internal activity is part of a resource’s daily duties.

1. Click Configuration.
2. In the Resources, Activities, Inventories section, click Activity Types.
   The Activity Types screen appears. The internal activities are listed under the heading Internal. The colors indicate the colors used on the Time, List and Map view.
3. Scroll down to see the activities types of various groups.

Add a Mass Activity

When you create an activity for one resource that you would like to use for other resources, you can create a mass activity. For example, if all the technicians are required to attend a training, you add a mass activity.

1. Add an activity to a resource as you normally would.
2. Complete the Activity Notes, Position in Route, Duration, SLA Start, SLA End, and Time Slot fields.
3. Click Mass activity.
   The Mass activity check box is displayed only for the activity types for which it is configured.
4. Click Add new.
   The resource tree displays.
5. Select the resources that you want to be part of this activity.
6. Click OK.
   The activity is assigned to all the selected resources.

Add Repeating Activities to a Resource’s Route

You can add activities to a resource’s route that will repeat for a specified period of time. Examples of repeating activities include meetings and lunch breaks.

1. From the Resource Tree, select the resource to which you want to assign the activity.
2. Click the gear icon and select Add activity.
   The Add activity [resource name] screen appears.
3. Complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Type</td>
<td>Select the internal activity type. Some common options include: Lunch Break, Assisting, Office Activity, Warehouse Activity, Weather and Vehicle Maintenance. This list is populated with activities designated specifically as allowed for repeating.</td>
</tr>
<tr>
<td>Activity Notes</td>
<td>Any notes or comments about the activity.</td>
</tr>
<tr>
<td>Position in Route</td>
<td>If Not Ordered is chosen, then the activity is displayed as a scheduled/not ordered activity in the lower portion of the Time view interface. This is true whether a subsequent time slot is indicated or not. If Ordered is chosen and a time slot is indicated, then the activity is displayed on the resource’s route within the time slot specified. If Ordered is chosen and no time slot is indicated, then the activity is displayed as pending at the beginning of the resource’s route.</td>
</tr>
<tr>
<td>Duration</td>
<td>The amount of time that the activity lasts.</td>
</tr>
<tr>
<td>SLA Start</td>
<td>The date and time at which the SLA starts for this activity.</td>
</tr>
<tr>
<td>SLA End</td>
<td>The date and time at which the SLA ends for this activity.</td>
</tr>
<tr>
<td>Time Slot</td>
<td>Select the period of time within which this activity can be started. Time slots for internal activities are defined within the Activity Type settings. Time slots can also be created to support internal activities, similar to how they work for scheduling external activities.</td>
</tr>
<tr>
<td>Repeating Activity</td>
<td>Select the frequency at which the activity occurs and complete the corresponding fields.</td>
</tr>
</tbody>
</table>

4. Click **OK**.
   The activity is added to the resource’s route.

### Activity Alerts

You see alert messages when you move activities. These messages guide you through the process. The following alerts are available:

- **Overtime Alert:** This alert notifies you that the estimated completion time of the activity extends beyond the end of a resource’s working day.

- **Soft Skill Mismatch Alert:** This alert displays when you move an activity to a resource that does not have the preferable qualification level of an activity skill.

- **Work skill Mismatch Alert:** This alert displays when you move an activity to a resource that does not have the required and preferred qualification level of an activity skill. Depending on your settings, the Work Skill Mismatch Alert either prevents you from moving the activity, or gives you the option to move it or to cancel the move.

- **Do Not Move Alert:** This alert displays when you try to move an activity type that is not allowed to move between resources. Activity types are configured in the **Add activity type** page.
# 7 Reports

## View Scheduled Reports

The **Schedule Report** option enables you to view a list of reports that have been set up to run on a specified schedule.

Initial report scheduling is handled by your system administrator.

To view scheduled reports:

1. Select the **Navigation** button.
2. Select **Schedule Report** from the navigation pane.

A list of the reports that have been scheduled to run on a recurring basis by the system administrator appears.

This figure displays the Schedule Reports page showing the list of all scheduled reports.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>The unique identifier for this report.</td>
</tr>
<tr>
<td>Report name</td>
<td>The name of the report.</td>
</tr>
<tr>
<td>Start Date</td>
<td>The start date of the reporting period.</td>
</tr>
<tr>
<td>End Date</td>
<td>The end date of the reporting period.</td>
</tr>
<tr>
<td>Report Type</td>
<td>The format of report to be sent or saved (CSV, HTML, XML, PDF).</td>
</tr>
<tr>
<td>Time</td>
<td>The time that the report was run.</td>
</tr>
<tr>
<td>Recurrence</td>
<td>How often this report is run. You cannot run or modify any recurring reports.</td>
</tr>
<tr>
<td>Action</td>
<td>To view the details of the settings for an individual report. <strong>(View)</strong></td>
</tr>
</tbody>
</table>
Create a Scheduled Report

The Schedule Reports option allows you to view a list of recurring reports. The initial set-up to schedule a recurring report is handled by the system administrator.

1. Click Reports > Schedule Reports.
   The list of reports that are scheduled by the system administrator to run on a recurring basis appears.

2. Click Add new.
   The Add schedule window appears.

3. Complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Name</td>
<td>Select the name of the report from the drop-down menu of choices.</td>
</tr>
<tr>
<td>Report Type</td>
<td>Select the report output type from the drop-down menu. Choices are: .csv, .html, .pdf, .xml</td>
</tr>
<tr>
<td>Save to File</td>
<td>Select to indicate if you want to you save the report to a file.</td>
</tr>
<tr>
<td>Email Address</td>
<td>Email address of the person receiving the file.</td>
</tr>
<tr>
<td>Name or ID</td>
<td>External ID of the resource or bucket used for this report.</td>
</tr>
<tr>
<td>Start Date</td>
<td>The date on which the report run begins.</td>
</tr>
<tr>
<td>End Date</td>
<td>The date on which the report run ends.</td>
</tr>
<tr>
<td>Time From</td>
<td>The time at which the report generates.</td>
</tr>
<tr>
<td>Recurrence</td>
<td>How often the report generates. Specify whether the report runs everyday, daily, or weekly:</td>
</tr>
<tr>
<td></td>
<td>◦ Weekly allows you to select specific days of the week.</td>
</tr>
<tr>
<td></td>
<td>◦ Monthly allows you to select the day of the month.</td>
</tr>
<tr>
<td>Report Parameters</td>
<td>Based on the report you selected from the drop-down menu, this section resets with the parameters for that report. Enter the value in the Value field.</td>
</tr>
</tbody>
</table>

4. Click Add.
   The new scheduled report appears in the Schedule Report list.

View the Messages Report

The Messages report details the results of messages sent out through the Notification Engine. This report shows only those messages that use set property delivery channel (method) if they were generated in less than one hour. The only exception from this rule: Messages with failed status. Such messages are important for troubleshooting therefore they do not have the one-hour expiration time.

To view the Messages report:
1. Select the subject of your report from the resource tree.
This could be a bucket or organization, such as XYZ contractors, or one or more resources.

2. Click the Navigation button.
4. Click View to display the filtering options for this report.
5. Select your options.

   a. **From/To Date**: Use the calendar icons to select the desired dates.
   
   b. **Trigger**: Select a trigger from the drop-down menu. The trigger is the action taken within Oracle Field Service Cloud that triggers the message. For example, if you would like to run a report showing all messages triggered when an order is canceled, select **Cancel**.
   
   c. **Find**: Use this field to search for a certain term, word, or character (such as the name of a resource) within the results.
   
   d. **Rows**: Enter the number of rows you want to see at one time. The default value is 20.

The Messages report details the results of messages sent out through the Notification Engine.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method</td>
<td>How the message was sent. For example, internal process or external system.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the message at the time the report was run.</td>
</tr>
<tr>
<td>Description</td>
<td>Additional information about the message status.</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>Other information</td>
</tr>
<tr>
<td>Scenario (Step)</td>
<td>The scenario or step referenced in the message.</td>
</tr>
<tr>
<td>Trigger</td>
<td>The event or reason why the message was sent.</td>
</tr>
<tr>
<td>Call Day</td>
<td>The day the call was placed.</td>
</tr>
<tr>
<td>Day Created</td>
<td>The date and time that the message could be seen in the system.</td>
</tr>
</tbody>
</table>
# Revision History

This document will continue to evolve as existing sections change and new information is added.

<table>
<thead>
<tr>
<th>Date</th>
<th>What’s Changed</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>February 2019</td>
<td>The following topics are added:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Custom Forms</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• How a Form is Configured</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Provide Access to the Forms &amp; Plugins Screen</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create a Form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Configure the Form Elements</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Where Can Forms Be Used</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Add the Form to a Screen</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Call a Form from a Button or a Link</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View Form Submission Results</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Lifecycle of a Form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Export and Import Forms</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Configure Activity and Resource Hints</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Configure Time and List View Screens</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Add the Plug-in to a Screen</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• How plug-ins are configured</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Configure a Plug-in</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The following topics are updated:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Default Values and Validation Rules</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Upload a Plug-In</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Modify, Download, or Delete an Archive</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Pre-Calculated Travel Statistics</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Add a Login Policy</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Understanding Activity Type Details</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create an Application</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The following topics are deleted:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Action Management Window</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View Action Management</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Base and Custom Actions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create a Custom Action</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create an Action Link</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Use in an Action Link</td>
<td></td>
</tr>
<tr>
<td>Date</td>
<td>What’s Changed</td>
<td>Notes</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| November 2018 | The following topics are added:  
  - Create an Integer Property  
  - Configure a DbaaS Integration  
  - Modify an Existing DbaaS Integration  
The following topics are updated:  
  - Add a Login Policy  
  - Understanding User Type Settings  
  - Configure Default Values and Validation Rules  
  - Access User Details |       |
| August 2018  | The following topics are updated:  
  - Add a Resource Type for the Field Resource Role  
  - Configure Display Settings  
  - Integrating using REST APIs  
  - View Statistics Parameters  
  - How Activity Duration is Calculated  
  - Predicting Travel Time  
  - Understanding User Type Settings  
  - Screen Configuration Settings  
  - Configure the Main Menu  
The following topics are added:  
  - Example: Travel Allowance Calculation  
  - Add a resource type for contingent worker |       |
| May 2018    | The following topics are updated:  
  - Add a Map Layer  
  - How Geocoding Works  
  - Set Up Company Language  
  - Create a File Property  
  - Add a Resource Type for the Field Resource Role  
The following topics are added:  
  - Inactive Resources  
  - Working with Time Zones |       |
| February 2018 | The following topics are updated:  
  - Configure Business Rules  
  - Add a map layer (Formerly Add a custom map layer)  
  - Create an action link  
  - Create a string property |       |
<table>
<thead>
<tr>
<th>Date</th>
<th>What’s Changed</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Create an enumeration property</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create a file property</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Understanding activity type details</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Add a login policy</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create a filter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Access user details</td>
<td></td>
</tr>
<tr>
<td>December 2017</td>
<td>The following topics are added:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Display work zone layer on the map</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Delete a map layer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Pre-calculated travel statistics</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Configure the main menu in Mobility</td>
<td></td>
</tr>
<tr>
<td>August 2017</td>
<td>The following topics are updated:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Configure Business Rules</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Add a custom map layer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create a file property</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The following topics are added:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• How geocoding works</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Update shape properties</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Assign permissions to custom map layers</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Default values and validation rules</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Configure default values and validation rules</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Language expressions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Type conversion</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Processing rules</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Syntax</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Functions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• now function format</td>
<td></td>
</tr>
<tr>
<td>June 2017</td>
<td>Minor changes for clarity and consistency</td>
<td></td>
</tr>
<tr>
<td>May 2017</td>
<td>The following topics are updated:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Properties</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create a string property</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create an enumeration property</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create a file property</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Unlock a user account</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Importing user types</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Understanding user-type settings</td>
<td></td>
</tr>
</tbody>
</table>
### Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>What’s Changed</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>April 2017</td>
<td>• Screen-configuration settings</td>
<td>Removed the following topics:</td>
</tr>
<tr>
<td></td>
<td>• Add an organization unit or a bucket (formerly Add a group)</td>
<td>• The plug-in framework</td>
</tr>
<tr>
<td></td>
<td>• Add a resource type for the organization unit role</td>
<td>• SSL certificate creation and Nginx configuration</td>
</tr>
<tr>
<td></td>
<td>• Calendars, work schedules, and shifts</td>
<td>• Guidelines to create a plug-in API</td>
</tr>
<tr>
<td></td>
<td>• Configure Business Rules</td>
<td>• Basic HTTP authentication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• HMAC authentication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Code examples</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Plug-in API specification</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Available methods</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• JSON schema for message data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• JSON example</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Using the plug-in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create a sample plug-in for Mobility Cloud Service</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Error handling</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Error codes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Possible transitions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Property value length limits</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Upgrading from previous versions</td>
</tr>
<tr>
<td></td>
<td>These topics are available in the new</td>
<td>guide: Mobile Plug-in Framework</td>
</tr>
<tr>
<td>March 2017</td>
<td>Minor changes for clarity and consistency</td>
<td></td>
</tr>
<tr>
<td>February 2017</td>
<td>Added the following topics:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Export and import Work Zones</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Work Zone export XML structure</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• About Organizations</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Manage Organizations</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Change a resource’s Organization</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Integrate with other applications</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• How external identity providers can call REST APIs</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create an Application</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Configuring activity booking</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create a layout for booking an activity</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Activity type constraints</td>
<td></td>
</tr>
</tbody>
</table>
### Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>What’s Changed</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Support of time slots</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Calculate travel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Calculate activity duration using stats</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Support of work zones</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Support of work skills</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Schedule Booked Activity context</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Manage languages using the Languages button</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Edit Property Descriptions for Multiple User Types</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Visual Form Editor</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Configure a form using special elements, actions, and fields</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Updated the following topics:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configure Business Rules</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Add a resource</td>
<td></td>
</tr>
<tr>
<td></td>
<td>About Glossary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Modify a Glossary Entry using Placeholders and Glossary Editor</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Export and Import Glossary Items</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Create a Message Scenario</td>
<td></td>
</tr>
<tr>
<td>January 2017</td>
<td>Minor changes for clarity and consistency</td>
<td></td>
</tr>
<tr>
<td>November 2016</td>
<td>Minor changes for clarity and consistency</td>
<td></td>
</tr>
<tr>
<td>October 2016</td>
<td>Minor changes for clarity and consistency</td>
<td></td>
</tr>
<tr>
<td>September 2016</td>
<td>Updated the following chapters:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Understand browser support</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configuring Oracle Field Service Cloud</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Working with resources</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reports</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Updated figures and edited some of the topics for better clarity. Added the details of using Oracle Business Intelligence Cloud Service with daily extract reports.</td>
<td></td>
</tr>
<tr>
<td>August 2016</td>
<td>Configuring Oracle Field Service Cloud chapter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Added or updated information about natural learning and job duration, native language support, and IDCS option for SAML authentication.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Added the following topics in the Configure Business Rules section:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Define Bundling keys for a Visit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Define Bundling keys for a Visit: Example</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Define Search fields for the Core Manage Application</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Define Search fields for the Mobility Application</td>
<td></td>
</tr>
</tbody>
</table>
### Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>What’s Changed</th>
</tr>
</thead>
</table>
| April 2016 | Added or updated the following topics in the Properties section:  
• Properties  
• Create a String Property: Example  
• Create a Enumeration property: Example  
• Create a File Property: Example  
• Add the String Property to the Screen configuration  

Added the following topics in the Message Scenario section:  
• Create a Message Scenario  
• Define the Settings for a Scenario Step using the Settings tab  
• Define the Message Content using the Patterns tab  
• Handle Conditions using the Next Steps tab  
• Block Message Steps Using the Conditions tab  
• Add Launch Conditions for Message Scenarios  
• Send Notification Messages using Channels  

Added or updated the following topics in the Resource Types section:  
• Resource types  
• Add a resource type for the Field Resource Role  
• Add a Resource Type for the Bucket Role  
• Add a Resource Type for the Organization Unit role  

Updated the following topics:  
• Configure Display settings  
• Add a resource  
• Add a bucket to the resource tree  
• Add a group to the resource tree  

About user types  
Merged the User Types guide with this guide.  
Added details about creating, deleting, importing, exporting, and migrating user types.  
Minor changes for clarity and consistency